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What’s new

June 10, 2021

What’s new in 2104

This release includes the following enhancement and addresses an issue to improve the user experi-
ence:

Enhancement to recording file creation and storage

Previously, recordingfiles were created and visible in the recording storage folder for all sessions when
they were launched. The files were then deleted if policies were set not to record the launched ses-
sions. As of this release, recording files are created only for recorded sessions.

Fixed issues

January 9, 2022
Compared with: Session Recording 2103

Session Recording 2104 adds the following fixes:

+ Recording viewing policies might not be visible if you manually modify the web.config
file before upgrading Session Recording 7.15. The web.config file is saved under \Cit-
rix\SessionRecording\Server. [SRT-5740]

Known issues

February 28,2024

The following issues have been identified in this release:

« If you are using Citrix Web App Firewall (WAF) signatures to mitigate in part the CVE-2021-44228
vulnerability, Session Recording might not work as expected. To resolve the issue, exclude the
IP addresses of your Session Recording servers from the mitigate_cve_2021_44228 policy on
the NetScaler side. [CVADHELP-24365]
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« Adomain user with local administrator privileges on the machine where the Session Recording
Policy Console is installed can add both local users and domain users to which the action of a
policy rule applies. However, a local user with local administrator privileges can add only local
users but not domain users. [SRT-5769]

« The web player might not work properly if you upgrade it from Version 2009 or earlier. To work
around the issue, clear your browser cache. [SRT-5624]

+ Rules of Session Recording custom policies might be lost after you update Session Recording
from the version included in the XenApp and XenDesktop 7.6 LTSR to the latest version. As a
workaround, before updating Session Recording to the latest version, update the software to
the version included in the latest CU of the XenApp and XenDesktop 7.15 LTSR and then update
it to the latest release. [SRT-4546]

« When Machine Creation Services (MCS) or Provisioning Services (PVS) creates multiple VDAs
with the configured masterimage and Microsoft Message Queuing (MSMQ) installed, those VDAs
can have the same QMId under certain conditions. This case might cause various issues, for ex-
ample:

- Sessions might not be recorded even if the recording agreement is accepted.
- The Session Recording Server might not be able to receive session logoff signals and there-
fore, sessions might always be in a live state.

For information about a workaround, see Install, upgrade, and uninstall. [#528678]

Third party notices

October 20, 2021
Session Recording Version 2104 (PDF Download)

This release of Session Recording can include third party software licensed under the terms defined
in this document.

System requirements

February 27,2023

The Session Recording components include the Session Recording Administration components, the
Session Recording Agent, and the Session Recording Player. You can install the Session Recording
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Administration components (Session Recording Database, Session Recording Server, and Session
Recording Policy Console) on a single server or on different servers. The following section details the
requirements for each of the Session Recording components.

For more information about using this Current Release (CR) in a Long Term Service Release (LTSR)
environment and other FAQs, see Knowledge Center article.

Session Recording Database

Supported operating systems:

« Windows Server 2019
« Windows Server 2016
« Windows Server 2012 R2

Supported Microsoft SQL Server versions:

+ Microsoft SQL Server 2019 Enterprise, Express, and Standard editions

« Microsoft SQL Server 2017 Enterprise, Express, and Standard editions

+ Microsoft SQL Server 2016 SP2 Enterprise, Express, and Standard editions

« Microsoft SQL Server 2016 SP1 Enterprise, Express, and Standard editions

+ Microsoft SQL Server 2014 SP2 Enterprise, Express, and Standard editions

« Microsoft SQL Server 2012 SP3 Enterprise, Express, and Standard editions

» Microsoft SQL Server 2008 R2 SP3 Enterprise, Express, and Standard editions

Supported Azure SQL database services:

+ Azure SQL Managed Instance
« SQL Server on Azure Virtual Machines (VMs)
(Use supported versions of Microsoft SQL Server that are listed earlier.)

Supported AWS RDS database services:
« SQL Server

Requirement: .NET Framework 4.7.2

Session Recording Server

Supported operating systems:

« Windows Server 2019
« Windows Server 2016
« Windows Server 2012 R2
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Other requirements:

« Internet Information Services (IIS) 10, 8.5, 8.0, or 7.5

+ .NET Framework Version 4.7.2

+ If the Session Recording Server uses HTTPS as its communications protocol, add a valid certifi-
cate. Session Recording uses HTTPS by default, which Citrix recommends.

« Microsoft Message Queuing (MSMQ), with Active Directory integration disabled and MSMQ HTTP
support enabled.

+ For Administrator Logging: Latest version of Chrome, Firefox, or Internet Explorer 11

Session Recording Policy Console

Supported operating systems:

« Windows Server 2019
« Windows Server 2016
« Windows Server 2012 R2

Requirement: .NET Framework 4.7.2

Session Recording Agent

Install the Session Recording Agent on every Windows Virtual Delivery Agent (VDA) on which you want
to record sessions.

Supported operating systems:

« Windows Server 2019

« Windows Server 2016

« Windows Server 2012 R2

« Windows 10, minimum version 1607

+ Windows 10 Enterprise for Virtual Desktops

Requirements:

« Citrix Virtual Apps and Desktops 7 2103 with Premium license

« Citrix Virtual Apps and Desktops 7 1912 LTSR CU2 with Platinum license

+ XenApp and XenDesktop 7.15 LTSR CU7 with Platinum license

o .NET Framework 4.7.2

+ Microsoft Message Queuing (MSMQ), with Active Directory integration disabled and MSMQ HTTP
support enabled
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Session Recording Player

Supported operating systems:

« Windows Server 2019

« Windows Server 2016

« Windows Server 2012 R2

+ 64-bit Windows 10, minimum version 1607

Requirement: .NET Framework 4.7.2
Note:

On 32-bit Windows 10, you can install the Player only by using the SessionRecordingPlayer.msi
file. The msi file is located on the Citrix Virtual Apps and Desktops ISO under \layout\image-
full\x86\Session Recording.

For optimal results, install the Session Recording Player on a workstation with:

« Screen resolution of 1024 x 768

«+ Color depth of at least 32-bit

+ 2GB RAM minimum; more RAM and CPU/GPU resources can improve performance when playing
graphics-intensive recordings, especially when recordings contain many animations

The seek response time depends on the size of the recording and your machine’s hardware specifica-
tions.

Get started

June 10, 2021

Session Recording consists of five components:

+ Session Recording Agent. A component installed on each VDA for multi-session OS or single-
session OS to enable recording. It is responsible for recording session data.
» Session Recording Server. A server that hosts:

- The Broker. An IS 6.0+ hosted Web application that handles the search queries and file
download requests from the Session Recording Player, handles policy administration re-
quests from the Session Recording Policy Console, and evaluates recording policies for
each Citrix Virtual Apps and Desktops session.

- The Storage Manager. AWindows service that manages the recorded session files received
from each Session Recording-enabled computer running Citrix Virtual Apps and Desktops.
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- Administrator Logging. An optional subcomponent installed with the Session Recording
Server to log the administration activities. All the logging data is stored in a separate SQL
Server database named CitrixSessionRecordinglLogging by default. You can customize
the database name.

+ Session Recording Player. A user interface that users access from a workstation to play
recorded session files.

+ Session Recording Database. A component that manages the SQL Server database for stor-
ing recorded session data. When this component is installed, it creates a database named Cit-
rixSessionRecording by default. You can customize the database name.

+ Session Recording Policy Console. A console used to create policies to specify which sessions
are recorded.

This illustration shows the Session Recording components and their relationship with each other:

In the deployment example illustrated here, the Session Recording Agent, Session Recording Server,
Session Recording Database, Session Recording Policy Console, and Session Recording Player all re-
side behind a security firewall. The Session Recording Agent is installed on a VDA for multi-session
OS or single-session 0S. A second server hosts the Session Recording Policy Console, a third server
acts as the Session Recording Server, and a fourth server hosts the Session Recording Database. The
Session Recording Player is installed on a workstation. A client device outside the firewall communi-
cates with the VDA for multi-session OS on which the Session Recording Agent is installed. Inside the
firewall, the Session Recording Agent, Session Recording Policy Console, Session Recording Player,
and Session Recording Database all communicate with the Session Recording Server.
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Plan your deployment

June 10, 2021

Limitations and caveats

Session Recording does not support Desktop Composition Redirection (DCR) display mode. By de-
fault, Session Recording disables DCR in a session if the session is to be recorded by recording policy.
You can configure this behavior in Session Recording Agent properties.

If some URLs are configured in the browser content redirection policy that was introduced in Version
7.16 of the Windows VDA, graphics activities of browsing these URLs in the Internet Explorer browser
cannot be recorded.

Session Recording does not support the Framehawk display mode. Sessions in Framehawk display
mode cannot be recorded and played back correctly. Sessions recorded in Framehawk display mode
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might not contain the sessions’activities.

Session Recording cannot record the Lync webcam video when using the HDX RealTime Optimization
Pack.

Depending upon your environment, you can deploy the Session Recording components in different
scenarios.

A Session Recording deployment is not limited to a single site. Except the Session Recording Agent,
all components are independent of the server site. For example, you can configure multiple sites to
use a single Session Recording Server.

Alternatively, if you have a large site with many agents and plan to record many graphically intense
applications (for example, AutoCAD applications), or you have many sessions to record, a Session
Recording Server can experience a high performance demand. To alleviate performance issues, you
can install multiple Session Recording Servers and enable the load balancing feature to make the
Session Recording Servers work as a load balancing pool and to share the work load from different
VDAs.

Suggested server site deployment

Use this type of deployment for recording sessions for one or more Sites. The Session Recording Agent
isinstalled on each VDA in a Site. The Site resides in a data center behind a security firewall. The Ses-
sion Recording Administration components (Session Recording Database, Session Recording Server,
and Session Recording Policy Console) are installed on other servers and the Session Recording Player
is installed on a workstation, all behind the firewall but not in the data center.
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Important deployment notes

+ To enable Session Recording components to communicate with each other, install them in the
same domain or across trusted domains that have a transitive trust relationship. The system
cannot be installed on a workgroup or across domains that have an external trust relationship.

« Consideringitsintense graphical nature and memory usage when playing back large recordings,
Citrix does not recommend installing the Session Recording Player as a published application.

+ The Session Recording installation is configured for TLS/HTTPS communication. Ensure that
you install a certificate on the Session Recording Server and that the root certificate authority
(CA) is trusted on the Session Recording components.

« If you install the Session Recording Database on a standalone server running the Express Edi-
tion of SQL Server 2019, SQL Server 2017, SQL Server 2016, SQL Server 2014, SQL Server 2012,
or SQL Server 2008 R2, the server must have the TCP/IP protocol enabled and the SQL Server
Browser service running. These settings are disabled by default, but they must be enabled for
the Session Recording Server to communicate with the database. For information about en-
abling these settings, see the Microsoft articles Enable TCP/IP Network Protocol for SQL Server
and SQL Server Browser Service.

+ Consider the effects of session sharing when planning your Session Recording deployment. Ses-
sion sharing for published applications can conflict with Session Recording policy rules for pub-
lished applications. Session Recording matches the active policy with the first published appli-
cation that a user opens. After the user opens the first application, any subsequent applications
opened during the same session continue to follow the policy that is in force for the first applica-
tion. For example, if a policy states to record only Microsoft Outlook, the recording commences
when the user opens Outlook. If the user opens a published Microsoft Word second while Out-
lookis running, Word also is recorded. Conversely, if the active policy does not specify to record
Word, and the user launches Word before Outlook, Outlook is not recorded.

« Though you can install the Session Recording Server on a Delivery Controller, Citrix does not
recommend that you do so because of performance issues.

+ You can install the Session Recording Policy Console on a Delivery Controller.

+ You can install both the Session Recording Server and the Session Recording Policy Console on
the same system.

+ Ensure that the NetBIOS name of the Session Recording Server does not exceed the limit of 15
characters. Microsoft has a 15-character limit on the host name length.

« PowerShell 5.1 or later is required for custom event logging. Upgrade PowerShell if you install
the Session Recording Agent on Windows Server 2012 R2 that has PowerShell 4.0 installed. Fail-
ure to comply can cause failed API calls.
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Security recommendations

April 29,2022

Session Recording is deployed within a secure network and accessed by administrators, and as such,
is secure. Out-of-the-box deployment is simple and security features such as digital signing and en-
cryption can be configured optionally.

Communication between Session Recording components is achieved through Internet Information
Services (IIS) and Microsoft Message Queuing (MSMQ). 1IS provides the web services communication
link between Session Recording components. MSMQ provides a reliable data transport mechanism for
sending recorded session data from the Session Recording Agent to the Session Recording Server.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Consider these security recommendations when planning your deployment:

« Ensure that you properly isolate the different administrator roles in the corporate network, in
the Session Recording system, or on individual machines. By not doing so, security threats that
can impact the system functionality or abuse the system might occur. We recommend that you
assign different administrator roles to different persons or accounts. Do not allow general ses-
sion users to have administrator privileges to the VDA system.

- Citrix Virtual Apps and Desktops administrators do not grant VDA local administrator role
to any users of published apps or desktops. If the local administrator role is a requirement,
protect the Session Recording Agent components by using Windows mechanisms or third-
party solutions.

- Separately assign the Session Recording database administrator and Session Recording
policy administrator.

- We recommend that you do not assign VDA administrator privileges to general session
users, especially when using Remote PC Access.

- Session Recording Server local administration account must be strictly protected.

- Control access to machines where the Session Recording Player is installed. If a useris not
authorized for the Player role, do not grant that user local administrator role for any player
machine. Disable anonymous access.

- We recommend using a physical machine as a storage server for Session Recording.
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+ Session Recording records session graphics activities without regard to the sensitivity of the
data. Under certain circumstances, sensitive data (including but not limited to user credentials,
privacy information, and third-party screens) might be recorded unintentionally. Take the fol-
lowing measures to prevent risks:

- Disable core memory dump for VDAs unless for specific troubleshooting cases.
To disable core memory dump:
1. Right-click My Computer, and then select Properties.
2. Click the Advanced tab, and then under Startup and Recovery, click Settings.
3. Under Write Debugging Information, select (none).
See the Microsoft article at https://support.microsoft.com/en-us/kb/307973.

- Session owners notify attendees that online meetings and remote assistance software
might be recorded if a desktop session is being recorded.

- Ensure that logon credentials or security information does not appear in all local and Web
applications published or used inside the corporation. Otherwise, they are recorded by
Session Recording.

- Close any application that might expose sensitive information before switching to a re-
mote ICA session.

- We recommend only automatic authentication methods (for example, single sign-on,
smartcard) for accessing published desktops or Software as a Service (SaaS) applications.

+ Session Recording relies on certain hardware and hardware infrastructure (for example, corpo-
rate network devices, operation system) to function properly and to meet security needs. Take
measures at the infrastructure levels to prevent damage or abuse to those infrastructures and
make the Session Recording function secure and reliable.

- Properly protect and keep network infrastructure supporting Session Recording available.
- We recommend using a third-party security solution or Windows mechanism to protect
Session Recording components. Session Recording components include:

* On the Session Recording Server
- Processes: SsRecStoragemanager.exe and SsRecAnalyticsService.exe
- Services: CitrixSsRecStorageManager and CitrixSsRecAnalyticsService
- Allfiles in Session Recording Server installation folder
- Registryvalues within HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server

* On the Session Recording Agent

- Process: SsRecAgent.exe

- Service: CitrixSmAudAgent

- Allfiles in Session Recording Agent installation folder

- Registry values within HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent

« Set the access control list (ACL) for Message Queuing (MSMQ) on the Session Recording Server

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 14


https://support.microsoft.com/en-us/kb/307973

Session Recording 2104

to restrict VDA or VDI machines that can send MSMQ data to the Session Recording Server and

prevent unauthorized machines from sending data to the Session Recording Server.

1. Install server feature Directory Service Integration on each Session Recording Server and
VDA or VDI machine where Session Recording is enabled. Then restart the Message Queu-

ing service.

2. From the Windows Start menu on each Session Recording Server, open Administrative

Tools > Computer Management.

3. Open Services and Applications > Message Queuing > Private Queues.

4. Click the private queue citrixsmauddata to open the Properties page and select the Se-

curity tab.
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5. Add the computers or security groups of the VDAs that send MSMQ data to this server and

grant them the Send Message permission.
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+ Properly protect the event log for the Session Record Server and Session Recording Agents. We
recommend using a Windows or third-party remote logging solution to protect the event log or
redirect the event log to the remote server.

+ Ensure that servers running the Session Recording components are physically secure. If possi-
ble, lock these computers in a secure room to which only authorized personnel can gain direct
access.

« Isolate servers running the Session Recording components on a separate subnet or domain.

+ Protect the recorded session data from users accessing other servers by installing a firewall be-
tween the Session Recording Server and other servers.

+ Keep the Session Recording Administration Server and SQL database up-to-date with the latest
security updates from Microsoft.

+ Restrict non-administrators from logging on to the administration machine.
« Strictly limit who is authorized to make recording policy changes and view recorded sessions.

« Install digital certificates, use the Session Recording file signing feature, and set up TLS commu-
nicationsin lIS.

« Setup MSMQtouse HTTPS asitstransport. The way is to set the MSMQ protocol listed in Session
Recording Agent Properties to HTTPS. For more information, see Troubleshoot MSMQ.
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e UseTLS1.10rTLS 1.2 (recommended) and disable SSLv2, SSLv3, TLS 1.0 on the Session Record-
ing Server and Session Recording Database.

+ Disable RC4 cipher suites for TLS on the Session Recording Server and Session Recording Data-
base:

1. Using the Microsoft Group Policy Editor, navigate to Computer Configuration > Adminis-
trative Templates > Network > SSL Configuration Settings.

2. Set the SSL Cipher Suite Order policy to Enabled. By default, this policy is set to Not
Configured.

3. Remove any RC4 cipher suites.

+ Use playback protection. Playback protection is a Session Recording feature that encrypts
recorded files before they are downloaded to the Session Recording Player. By default, this
option is enabled and is in Session Recording Server Properties.

+ Follow NSIT guidance for cryptographic key lengths and cryptographic algorithms.
« Configure TLS 1.2 support for Session Recording.

We recommend using TLS 1.2 as the communication protocol to ensure the end-to-end security
of the Session Recording components.

To configure TLS 1.2 support of Session Recording:

1. Logon to the machine hosting the Session Recording Server. Install the proper SQL Server
client component and driver, and set strong cryptography for .NET Framework (version 4
or later).

a) Install the Microsoft ODBC Driver 11 (or a later version) for SQL Server.
b) Apply the latest hotfix rollup of .NET Framework.
¢) Install ADO.NET - SqlClient based on your version of .NET Framework. For
more information, see https://support.microsoft.com/en-us/kb/3135244,
d) Add aDWORD value SchUseStrongCrypto=1under HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
and HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\.NetFramework\v4.0.30319.
e) Restart the machine.

2. Logon to the machine hosting the Session Recording Policy Console. Apply the latest hot-
fix rollup of .NET Framework, and set strong cryptography for .NET Framework (version 4
or later). The method for setting strong cryptography is the same as substeps 1-4 and 1-
5. You can omit these steps if you choose to install the Session Recording Policy Console
on the same computer as the Session Recording Server.

To configure the TLS 1.2 support for SQL Server with versions earlier than 2016, see https://support.
microsoft.com/en-us/kb/3135244. To use TLS 1.2, configure HTTPS as the communication protocol
for the Session Recording components.
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Scalability considerations

January 5, 2023

Session Recordingis a highly scalable system that handles thousands or tens of thousands of sessions.
Installing and running Session Recording requires few extra resources beyond what is necessary to
run Citrix Virtual Apps and Desktops. However, if you plan to use Session Recording to record many
sessions or if the sessions you plan to record can result in large session files (for example, graphically
intense applications), consider the performance of your system when planning your Session Record-
ing deployment.

This article explains how Session Recording achieves high scalability and how you can get the most
out of your recording system at a lowest cost.

Why Session Recording scales well

There are two major reasons that Session Recording scales well compared with competitive prod-
ucts:

+ Small file size

A recorded session file made with Session Recording is highly compact. It is many orders of
magnitude smaller than an equivalent video recording made with solutions that screen-scrape.
The network bandwidth, disk space, and disk IOPS required to transport and store each Session
Recording file is typically at least 10 times less than an equivalent video file.

The small size of recorded session files means faster and smoother rendering of video frames.
Recordings are also lossless and have no pixelation that is common in most compact video for-
mats. Text in recordings is easy to read during playback as it is in the original sessions. To
maintain small file sizes, Session Recording does not record key frames within the files. Ses-
sion Recording can drop H.264 packages while recording sessions that have videos running and
thus reduce the recording file sizes. To use this functionality, set HKEY_LOCAL_MACHINE
\SOFTWARE\Citrix\SmartAuditor\Agent\DropH264Enabled to 1 on the Session
Recording Agent and set the value of Use video codec for compression to For actively chang-
ing regions.
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g Create Policy

AL »
Edit Setting
Policy0 Use video codec for compression
| Ovenview | settings | Assignedto | -
| ———— S e Value: | For actively changing regions ¥
» Use video codec for compression
User setting - ICA\Graphics Use default value: Use when preferred
For actively changing regions (Default: Use when preferred)
¥ Applies to the following VDA versions -

Virtual Delivery Agent: 7.6 Server OS, 7.6 Desktop OS, 7.7 Server OS, 7.7 Desktop OS, 7.8 Server
OS, 7.8 Desktop OS, 7.9 Server OS, 7.9 Desktop OS, 7.11 Server OS, 7.11 Desktop OS, 7.12 Server
0S, 7.12 Desktop OS, 7.13 Server OS, 7.13 Desktop OS, 7.14 Server OS, 7.14 Desktop 0S, 7.15
Server OS, 7.15 Desktop OS, 7.16 Server OS, 7.16 Desktop OS, 7.17 Server OS, 7.17 Desktop OS,
7.18 Server OS, 7.18 Desktop OS, 1808 Server OS, 1808 Desktop OS, 1811 Server 0S, 1811
Desktop OS, 1903 Server OS, 1903 Desktop OS, 1906 Server OS, 1906 Desktop OS, 1909 Multi-
session OS, 1909 Single-session OS, 1912 Multi-session OS, 1912 Single-session 0S

¥ Description
This setting is available only on VDA versions XenApp and XenDesktop 7.6 Feature Pack 3 and
later.

Allows use of a video codec to compress graphics when video decoding is available on the
endpoint. When 'For the entire screen’ is chosen the video codec will be applied as the default
codec for all content (some small images and text will be optimized and sent losslessly). When
'For actively changing regions’ is selected the video codec will be used for areas where there is
constant change on the screen, other data will use still image compression and bitmap caching.
When video decoding is not available on the endpoint, or when you specify 'Do not use’, a
combination of still image compression and bitmap caching is used. When ‘Use when preferred' is
selected, the system chooses, based on various factors. The results may vary between versions as
the selection method is enhanced.

Select Do not use’ to optimize for server CPU load and for cases that do not have a lot of server-
rendered video or other graphically intense applications.

Select "For the entire screen’ to optimize for cases with heavy use of server-rendered video and
3D graphics, especially in low bandwidth.

+ Low processing required to generate files

A recorded session file contains the ICA protocol data for a session that is extracted virtually in
its native format. The file captures the ICA protocol data stream that is used to communicate
with Citrix Workspace app. There is no need to run expensive transcoding or encoding software
components to change the format of data in real time. The low amount of processing is also
important for VDA scalability and ensures the end-user experience is maintained when many
sessions are recorded from the same VDA.

Moreover, only those ICA virtual channels that can be played back are recorded, which results
in a further optimization. For example, the printer and client drive mapping channels are not
recorded because they can generate high volumes of data without any benefit in video play-
back.

Estimate data input and processing rates

The Session Recording Server is the central collection point for recorded session files. Each machine
that is running a multi-session OS VDA with Session Recording enabled sends recorded session data
to the Session Recording Server. Session Recording can handle high volumes of data and can tolerate
bursts and faults, but there are physical limits on how much data any one server can handle.

Consider how much data you send to each Session Recording Server and how quickly the servers can
process and store this data. The rate at which your system can store incoming data must be higher
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than the data input rate.

To estimate your data input rate, multiply the number of sessions recorded by the average size of each
recorded session and divide by the time for which you are recording sessions. For example, you might
record 5,000 Microsoft Outlook sessions of 20 MB each over an 8-hour work day. In this case, the data
input rate is approximately 3.5 Mbps. (5,000 sessions times 20 MB divided by 8 hours, divided by 3,600
seconds per hour.) A typical Session Recording Server connected to a 100 Mbps LAN with sufficient
disk space to store the recorded data can process data at around 5.0 Mbps based on the physical limits
imposed by disk and network IOPS. This rate is the processing rate. In the example, the processing
rate (5.0 Mbps) is higher than the input rate (3.5 Mbps), so recording the 5,000 Outlook sessions is
feasible.

The amount of data per session varies greatly depending on what is being recorded, while other fac-
tors such as the screen resolution, color depth, and graphics mode also have impacts. A session run-
ning a CAD package where graphics activity is constantly high likely generates a much larger record-
ing than a session in which the end user sends and receives emails in Microsoft Outlook. Therefore,
recording the same number of CAD sessions can generate a high input rate and require the use of more
Session Recording Servers.

Bursts and faults

The previous example assumes a simple uniform throughput of data but does not explain how the
system deals with short periods of higher activity, known as bursts. A burst might occur when all
users log on at the same time in the morning, known as the 9 o’clock rush, or when they receive the
same email in their Outlook inbox at once. The 5.0 Mbps processing rate of the Session Recording
Server is highly inadequate at dealing with this sudden demand.

The Session Recording Agent running on each VDA uses Microsoft Message Queuing (MSMQ) to send
recorded data to the Storage Manager running on the central Session Recording Server. The data is
sent in a store-and-forward manner similar to how an email is delivered between the sender, mail
server, and receiver. If the Session Recording Server or the network cannot handle the high rate of
data in a burst, the recorded session data is temporarily stored until the backlog of data messages
is cleared. The data message might be temporarily stored in the outgoing queue on the VDA if the
network is congested, or stored on the Session Recording Server’s receiving queue if the data has
traversed the network but the Storage Manager is still busy processing other messages.

MSMQ also serves as a fault tolerance mechanism. If the Session Recording Server goes down or the
link is broken, recorded data is held in the outgoing queue on each VDA. When the fault is rectified,
all queued data is sent together. The use of MSMQ also allows you to take a Session Recording Server
offline for upgrade or maintenance without interrupting the recording of existing sessions and losing
data.
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The main limitation of MSMQ is that disk space for the temporary storage of data messages is finite.
This limitation limits how long a burst, fault, or maintenance event can last before data is eventually
lost. The overall system can continue after data loss, but in this situation, individual recordings have
chunks of data missing. A file with missing data is still playable but only up to the point where data
was first lost. Note the following:

« Adding more disk space to each server, especially the Session Recording Server, and making it
available to MSMQ can increase the tolerance to bursts and faults.

« Itisimportant to configure the Message Life setting for each Session Recording Agent to an ap-
propriate level (on the Connections tab in Session Recording Agent Properties). The default
value of 7,200 seconds (two hours) means that each recorded data message has two hours to
reach the Storage Manager before it is discarded and recording files are damaged. With more
disk space available (or fewer sessions to record), you can choose to increase this value. The
maximum value is 365 days.

The other limitation with MSMQ is that when data backlogs, there is extra disk IOPS in the queue to
read and write data messages. Under normal conditions, the Storage Manager receives and processes
data from the network directly without the data message ever being written to disk. Storing the data
involves a single write operation to disk that appends the recorded session file. When data is back-
logged, the disk IOPS is tripled: each message must be written to disk, read from disk, and written
to file. As the Storage Manager is heavily IOPS bound, the processing rate of the Session Recording
Server drops until the backlog of messages is cleared. To mitigate the effects of this extra IOPS, adopt
the following recommendations:

+ Ensure that the disk on which MSMQ stores messages is different from the recording file storage
folders. Even though IOPS bus traffic is tripled, the drop in the true processing rate is never as

severe.

+ Have planned outages at off-peak times only. Depending on budget constraints, follow recog-
nized approaches to building high availability servers. The approaches include the use of UPS,
dual NICs, redundant switches, and hot swappable memory and disks.

Design for spare capacity

The data rate of recorded session data is unlikely to be uniform, bursts and faults might occur, and
the clearing of message backlogs is expensive in IOPS. For this reason, design each Session Recording
Server with plenty of spare capacity. Adding more servers or improving the specification of existing
servers, as described in later sections, always gains you extra capacity. The general rule of thumb is to
run each Session Recording server at a maximum of 50% of its total capacity. In the earlier example, if
the server can process 5.0 Mbps, target the system to run only at 2.5 Mbps. Instead of recording 5,000
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Outlook sessions that generate 3.5 Mbps on one Session Recording Server, reduce to 3,500 sessions
that generate only about 2.5 Mbps.

Backlogs and live playback

Live playbackiswhen a reviewer opens a session recording for playback while the session is still active.
During live playback, the Session Recording Agent responsible for the session switches to a streaming
mode for that session, and recording data is sentimmediately to the Storage Manager without internal
buffering. Because the recording file is constantly updated, the Player can continue to be fed with
the latest data from the live session. However, data sent from the Agent to the Storage Manager is
through MSMQ, so the queuing rules described earlier apply. A problem can occur in this scenario.
When MSMQ is backlogged, the new recorded data available for live playback is queued like all other
data messages. The reviewer can still play the file, but viewing the latest live recorded data is delayed.
If live playback is an important feature for reviewers, ensure a low probability of backlog by designing
spare capacity and fault tolerance into your deployment.

Citrix Virtual Apps and Desktops scalability

Session Recording never reduces session performance and never stops sessions in response to
recorded data backlogs. Maintaining the end-user experience and single-server scalability is para-
mount in the design of the Session Recording system. If the recording system becomes irreversibly
overloaded, recorded session data is discarded. Extensive scalability testing by Citrix reveals that
the impact of recording ICA sessions on the performance and scalability of Citrix Virtual Apps and
Desktops servers is low. The size of the impact depends on the platform, the memory available, and
the graphical nature of the sessions being recorded. With the following configuration, you can expect
a single-server scalability impact of between 1% and 5%. In other words, if a server can host 100
users without Session Recording installed, it can host 95-99 users after installation:

+ 64-bit server with 8 GB RAM running a multi-session OS VDA

« All sessions running Office productivity applications, such as Outlook and Excel
« The use of applications is active and sustained

+ All sessions are recorded as configured by the Session Recording policies

If fewer sessions are recorded or session activity is less sustained and more sporadic, the impact is less.
In many cases, the scalability impact is negligible and user density per server remains the same. As
mentioned earlier, the low impact is due to the simple processing requirements of the Session Record-
ing components installed on each VDA. Recorded data is extracted from the ICA session stack and sent
as-is to the Session Recording Server through MSMQ. There is no expensive encoding of data.

There is a minor overhead of using Session Recording even when no sessions are recorded. Although
the impact is low, if you are sure that no sessions are recorded from a particular server, you can dis-
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able recording on that server. Removing Session Recording is one way. A less invasive approach is to
clear the Enable session recording for this VDA machine check box on the Session Recording tab
in Session Recording Agent Properties. If session recording is required in future, reselect this check
box.

Measuring throughput

There are various ways to measure the throughput of recorded session data from the sending VDA
to the receiving Session Recording Server. One of the simplest and most effective approaches is to
observe the size of files that are recorded, and the rate at which disk space on the Session Recording
Server is being consumed. The volume of data written to disk closely reflects the volume of network
traffic being generated. The Windows Performance Monitor tool (perfmon.exe) has arange of standard
system counters that can be observed in addition to some counters provided by Session Recording.
Counters can be used to measure throughput, and identify bottlenecks and system problems. The
following table outlines some of the most useful performance counters.

Performance Object Counter Name Description

Citrix Session Recording Agent  Active Recording Count Indicates the number of
sessions that are currently
being recorded on a particular

VDA.
Citrix Session Recording Agent  Bytes read from the Session The number of bytes read from
Recording Driver the kernel components

responsible for acquiring
session data. Useful for
determining how much data a
single VDA generates for all
sessions recorded on that

server.
Citrix Session Recording Active Recording Count Similar to the Citrix Session
Storage Manager Recording Agent counter

except for the Session
Recording Server. Indicates the
total number of sessions
currently being recorded for all
servers.
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Performance Object

Citrix Session Recording
Storage Manager

LogicalDisk

MSMQ Queue

MSMQ Queue

Counter Name

Message bytes/sec

Disk Write Bytes/sec

Bytes in Queue

Message in Queue

Description

The throughput of all recorded
sessions. Can be used to
determine the rate at which the
Storage Manager is processing
data. If MSMQ is backlogged
with messages, the Storage
Manager runs at full speed.
This value can be used to
indicate the maximum
processing rate of the Storage
Manager.

Can be used to measure disk
write-through performance.
This isimportant in achieving
high scalability for the Session
Recording Server. Performance
of individual drives can also be

observed.
This counter can be used to

determine the amount of data
backlogged in the
CitrixSmAudData message
queue. If this value increases
over time, the rate of recorded
data received from the network
is greater than the rate at which
the Storage Manager can
process data. This counter is
useful for observing the effect

of data bursts and faults.
Similar to the Bytes in Queue

counter but measures the
number of messages.
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Performance Object Counter Name Description

Network Interface Bytes Total/sec Can be measured on both sides
of the link to observe how
much data is generated when
sessions are recorded. When
measured on the Session
Recording Server, this counter
indicates the rate at which
incoming data is received.
Contrasts with the Citrix
Session Recording Storage
Manager/Message bytes/sec
counter that measures the
processing rate of data. If
network rate is greater than
this value, messages build in
the message queue.

Processor % Processor Time Worth monitoring even though
CPUis unlikely to be a
bottleneck.

Session Recording Server hardware

You can increase the capacity of your deployment by carefully selecting the hardware used for the Ses-
sion Recording Server. You have two choices: scaling up (by increasing the capacity of each server) or
scaling out (by adding more servers). In making either of the choices, your aimis toincrease scalability
at a lowest cost.

Scaling up

When examining a single Session Recording Server, consider the following best practices to ensure op-
timal performance for available budgets. The system depends on IOPS. This ensures a high through-
put of recorded data from the network onto the disk. So it is important to invest in appropriate net-
work and disk hardware. For a high-performance Session Recording Server, a dual CPU or dual core
CPU is recommended but little is gained from any higher specification. 64-bit processor architecture
is recommended but an x86 processor type is also suitable. 4 GB of RAM is recommended but again
there is little benefit from adding more.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 25



Session Recording 2104

Scaling out

Even with the best scaling up practices, there are limits to performance and scalability that can be
reached with a single Session Recording Server when recording many sessions. It might be necessary
to add extra servers to meet the load. You can install more Session Recording Servers on different
machines to have the Session Recording Servers work as a load balancing pool. In this type of deploy-
ment, the Session Recording Servers share the storage and the database. To distribute the load, point
the Session Recording Agents to the load balancer that is responsible for the workload distribution.

Network capacity

A 100 Mbps network link is suitable for connecting a Session Recording Server. A Gb Ethernet con-
nection might improve performance, but does not result in 10 times greater performance than a 100
Mbps link. In practice, the gain in throughput is significantly less.

Ensure that network switches used by Session Recording are not shared with third-party applications
that might compete for available network bandwidth. Ideally, network switches are dedicated for
use with the Session Recording Server. If network congestion proves to be the bottleneck, a network
upgrade is a relatively inexpensive way to increase the scalability of the system.

Storage

Investment in disk and storage hardware is the single most important factor in server scalability. The
faster that data can be written to disk, the higher the performance of the overall system. When select-
ing a storage solution, take more note of the write performance than the read performance.

Store data on a set of local disks controlled either as RAID by a local disk controller or as a SAN.
Note:

Storing data on a NAS, based on file-based protocols such as SMB and NFS, might have perfor-
mance and security implications. Use the latest version of the protocol in place to avoid security
implications and perform scale testing to ensure proper performance.

For a local drive setup, aim for a disk controller with built-in cache memory. Caching allows the con-
troller to use elevator sorting during write-back, which minimizes disk head movement and ensures
write operations are completed without waiting for the physical disk operation to complete. This can
improve write performance significantly at a minimal extra cost. Caching does however raise the prob-
lem of data loss after a power failure. To ensure the integrity of data and the file system, consider a
battery backup facility for the caching disk controller, which ensures that, if power is lost, the cache
is maintained and data is written to disk when power is eventually restored.
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Consider using a suitable RAID storage solution. There are many RAID levels available depending on

performance and redundancy requirements. The following table specifies each of the RAID levels and

how applicable each standard is to Session Recording.

RAID Level

RAID 0

RAID 1

Type

Striped set without
parity

Mirrored set without
parity

Minimum Number of
Disks

Description

Provides high
performance but no
redundancy. Loss of
any disk destroys the
array. This is a low cost
solution for storing
recorded session files
where the impact of
data loss is low. Easy
to scaleup
performance by
adding more disks.
No performance gain
over one disk, making
it a relatively
expensive solution.
Use this solution only
if a high level of
redundancy is
required.
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RAID Level

RAID 3

RAID 5

Type

Striped set with
dedicated parity

Striped set with
distributed parity

Minimum Number of
Disks

Description

Provides high write
performance with
redundancy
characteristics similar
to RAID 5. RAID 3is
recommended for
video production and
live streaming
applications. As
Session Recording is
this type of
application, RAID 3 is
most highly
recommended butitis
not common.
Provides high read
performance with
redundancy but at the
cost of slower write
performance. RAID 5 is
the most common for
general purpose
usages. But due to the
slow write
performance, RAID 5 is
not recommended for
Session Recording.
RAID 3 can be
deployed at a similar
cost but with
significantly better
write performance.
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Minimum Number of

RAID Level Type Disks Description
RAID 10 Mirrored set and 4 Provides performance
striped set characteristics of RAID

0 with redundancy
benefits of RAID 1. An
expensive solution
thatis not
recommended for
Session Recording.

RAID 0 and RAID 3 are the most recommended RAID levels. RAID 1 and RAID 5 are popular standards
but are not recommended for Session Recording. RAID 10 does provide some performance benefits
but is too expensive for the additional gain.

Decide on the type and specification of disk drives. IDE/ATA drives and external USB or Firewire drives
are not suitable for use in Session Recording. The main choice is between SATA and SCSI. SATA drives
provide reasonably high transfer rates at a reduced cost per MB compared with SCSI drives. However,
SCSl drives provide better performance and are more common in server deployments. Server RAID so-
lutions mostly support SCSI drives but some SATA RAID products are now available. When evaluating
the specifications of disk drive products, consider the rotational speed of disk and other performance
characteristics.

Because the recording of thousands of sessions per day can consume significant amounts of disk
space, you must choose between overall capacity and performance. From the earlier example, record-
ing 5,000 Outlook sessions over an 8-hour work day consumes about 100 GB of storage space. To store
10days’worth of recordings (that is, 50,000 recorded session files), you need 1,000 GB (1 TB). This pres-
sure on disk space can be eased by shortening the retention period before archiving or deleting old
recordings. If 1 TB of disk space is available, a seven-day retention period is reasonable, ensuring
disk space usage remains around 700 GB, with 300 GB remaining as a buffer for busy days. In Session
Recording, the archiving and deleting of files is supported with the ICLDB utility and has a minimum
retention period of two days. You can schedule a background task to run once a day at some off-peak
time. For more information about the ICLDB commands and archiving, see Manage your database
records.

The alternative to using local drive and controllers is to use a SAN storage solution based on block-
level disk access. To the Session Recording Server, the disk array appears as a local drive. SANs are
more expensive to set up, but as the disk array is shared, SANs do have the advantage of simplified
and centralized management. There are two main types of SAN: Fibre Channel and iSCSI. iSCSI is
essentially SCSI over TCP/IP and is gaining popularity over Fibre Channel since the introduction of Gb
Ethernet.
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Database scalability

The Session Recording Database requires Microsoft SQL Server 2019, Microsoft SQL Server 2017, Mi-
crosoft SQL Server 2016, Microsoft SQL Server 2014, Microsoft SQL Server 2012, or Microsoft SQL
Server 2008 R2. The volume of data sent to the database is small because the database stores only
metadata about the recorded sessions. The files of the recorded sessions themselves are written to
a separate disk. Typically, each recorded session requires only about 1 KB of space in the database,
unless the Session Recording Event APl is used to insert searchable events to the session.

The Express Editions of Microsoft SQL Server 2019, Microsoft SQL Server 2017, Microsoft SQL Server
2016, Microsoft SQL Server 2014, Microsoft SQL Server 2012, and Microsoft SQL Server 2008 R2 impose
a database size limitation of 10 GB. At 1 KB per recording session, the database can catalog about
4,000,000 sessions. Other editions of Microsoft SQL Server have no database size restrictions and are
limited only by available disk space. As the number of sessions in the database increases, perfor-
mance of the database and speed of searches diminishes only negligibly.

If you are not making customizations through the Session Recording Event API, each recorded session
generates four database transactions: two when recording starts, one when the user logs on to the
session being recorded, and one when recording ends. If you use the Session Recording Event API
to customize sessions, each searchable event recorded generates one transaction. Because even the
most basic database deployment can handle hundreds of transactions per second, the processing
load on the database is unlikely to be stressed. The impact is light enough that the Session Recording
Database can run on the same SQL Server as other databases, including the Citrix Virtual Apps and
Desktops data store database.

If your Session Recording deployment requires many millions of recorded sessions to be cataloged in
the database, follow Microsoft guidelines for SQL Server scalability.

Install, upgrade, and uninstall

May 19, 2022
This article contains the following sections:
« Installation checklist
« Use Citrix scripts to install the Windows roles and features prerequisites
« Install the Session Recording Administration components
- Install the Session Recording Database

- Install the Session Recording Server
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« Install the Session Recording Agent

« Install the Session Recording Player and the web player

+ Automate installation
« Upgrade Session Recording

« Uninstall Session Recording

Installation checklist

You install the Session Recording components by using the following files:

« Broker_PowerShellSnapIn_x64.msi

+ SessionRecordingAdministrationx64.msi

» SessionRecordingAgentx64.msi
+ SessionRecordingPlayer.msi

+ SessionRecordingWebPlayer.ms1i

Before you start the installation, complete this list:

Step

Install the prerequisites before starting the
installation. See System requirements and Use
Citrix scripts to install the Windows roles and
features prerequisites.

Select the machines on which you want to install
each Session Recording component. Ensure that
each computer meets the hardware and
software requirements for the component or
components to be installed on it.

Use your Citrix account credentials to access the
Citrix Virtual Apps and Desktops download page
and download the product file. Unzip the file.

To use the TLS protocol for communication
between the Session Recording components,
install the correct certificates in your
environment.
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] Step

Install any hotfixes required for the Session
Recording components. The hotfixes are
available from the Citrix Support.

Configure Director to create and activate the
Session Recording policies. For more
information, see Configure Director to use the
Session Recording Server.

Note:

« We recommend that you divide the published applications into separate Delivery Groups
based on your recording policies. Session sharing for published applications can conflict
with the active policy if the applications are in the same Delivery Group. Session Recording
matches the active policy with the first published application that a user opens. Starting
with the 7.18 release, you can use the dynamic session recording feature to start or stop
recording sessions at any time during the sessions. This feature can help to mitigate the
conflict issue with the active policy. For more information, see Dynamic session recording.

+ Ifyou are planning to use Machine Creation Services (MCS) or Provisioning Services, prepare
a unique QMId. Failure to comply can cause recording data losses.

+ SQL Server requires that TCP/IP is enabled, the SQL Server Browser service is running, and
Windows Authentication is used.

+ To use HTTPS, configure server certificates for TLS/HTTPS.

« Ensure that users under Local Users and Groups > Groups > Users have
write permission to the C: \windows\Temp folder.

Use Citrix scripts to install the Windows roles and features prerequisites

For Session Recording to work properly, use the following Citrix scripts to install the necessary Win-
dows roles and features prerequisites before
installing Session Recording:

« InstallPrereqsforSessionRecordingAdministration.psl

<#
.Synopsis
Installs Prereqs for Session Recording Administration
.Description
Supports Windows Server 2012 R2, Windows Server 2016, Windows
Server 2019.
Install below windows feature on this machine:
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-Application Development
-Security - Windows Authentication
-Management Tools - IIS 6 Management Compatibility
IIS 6 Metabase Compatibility
IIS 6 WMI Compatibility
IIS 6 Scripting Tools
ITIS 6 Management Console
-Microsoft Message Queuing (MSMQ), with Active Directory
integration disabled, and MSMQ HTTP support enabled.

#>
function AddFeatures($Sfeaturename)
{

try

{

$feature=Get-WindowsFeature | ? {
$_.DisplayName -eq S$featurename -or $_.Name -eq $featurename }

Add-WindowsFeature $feature

}
catch
{
Write-Host "Addition of Windows feature $featurename
failed"
Exit 1
}

Write-Host "Addition of Windows feature $featurename
succeeded"

$system= gwmi win32_operatingSystem | select name

if (-not (($system -Like 'xMicrosoft Windows Server 2012 R2x') -
or (Ssystem -Like 'xMicrosoft Windows Server 2016%') -or (
$system -Like '*Microsoft Windows Server 2019x%')))

{
Write-Host("This is not a supported server platform.
Installation aborted.")
Exit
+

# Start to install Windows feature
Import-Module ServerManager

AddFeatures('Web-Asp-Net45') #ASP.NET 4.5
AddFeatures('Web-Mgmt-Console') #IIS Management Console
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AddFeatures ('Web-Windows-Auth') # Windows Authentication
AddFeatures('Web-Metabase') #IIS 6 Metabase Compatibility
AddFeatures('Web-WMI') #IIS 6 WMI Compatibility
AddFeatures('Web-Lgcy-Scripting')#IIS 6 Scripting Tools
AddFeatures('Web-Lgcy-Mgmt-Console') #IIS 6 Management Console
AddFeatures ('MSMQ-HTTP-Support') #MSMQ HTTP Support
AddFeatures('web-websockets') #IIS Web Sockets
AddFeatures('NET-WCF-HTTP-Activation45') #http activate
<!--NeedCopy-->

+ InstallPrereqsforSessionRecordingAgent.psl

<#
.Synopsis
Installs Preregs for Session Recording Agent
.Description
Supports Windows Server 2012 R2, Windows Server 2016,
Windows Server 2019, Windows 7, Windows 8, Windows 8.1 and
Windows 10.
Install below windows feature on this machine:
-Microsoft Message Queuing (MSMQ), with Active Directory
integration disabled, and MSMQ HTTP support enabled.

#>
function AddFeatures($featurename)
{

try

{

$feature=Get-WindowsFeature | ? {
$_.DisplayName -eq S$featurename -or $_.Name -eq $featurename }

Add-WindowsFeature $feature

}
catch
{
Write-Host "Addition of Windows feature $featurename
failed"
Exit 1
}

Write-Host "Addition of Windows feature $featurename
succeeded"

# Start to install Windows feature
$system= gwmi win32_operatingSystem | select name

if (-not (($system -Like 'xMicrosoft Windows Server 2012 R2x') -
or (Ssystem -Like 'xMicrosoft Windows Server 2016%') -or (
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$system -Like '*Microsoft Windows Server 2019x%')-or ($system -
Like 'xMicrosoft Windows 7*')-or ($system -Like 'xMicrosoft
Windows 8x')-or ($system -Like 'xMicrosoft Windows 10x')))

{
Write-Host("This is not a supported platform. Installation
aborted.")
Exit
+

if ($system -Like 'xMicrosoft Windows Serverx')

{

Import-Module ServerManager

AddFeatures('MSMQ') #Message Queuing

AddFeatures ('MSMQ-HTTP-Support')#MSMQ HTTP Support
}

else

{

try
{

if($system -Like 'xMicrosoft Windows 7x'")

{

dism /online /enable-feature /featurename:IIS-
WebServerRole /featurename:IIS-WebServer /
featurename:IIS-IIS6ManagementCompatibility /
featurename:IIS-Metabase /featurename:IIS-
ManagementConsole /featurename:IIS-
ApplicationDevelopment /featurename:IIS-
NetFxExtensibility /featurename:IIS-
ISAPIExtensions /featurename:IIS-
CommonHttpFeatures /featurename:IIS-
DefaultDocument /featurename:IIS-DirectoryBrowsing
/featurename:IIS-HttpErrors /featurename:IIS-
HttpRedirect /featurename:IIS-StaticContent /
featurename:IIS-HealthAndDiagnostics /featurename:
IIS-RequestMonitor /featurename:IIS-Performance /
featurename:IIS-HttpCompressionStatic /featurename
:IIS-Security /featurename:IIS-RequestFiltering /
featurename:IIS-LogginglLibraries /featurename:IIS-
HttpTracing

dism /online /enable-feature /featurename:MSMQ-
Container

dism /online /enable-feature /featurename:MSMQ-Server

dism /online /enable-feature /featurename:MSMQ-HTTP

else
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{
dism /online /enable-feature /featurename:MSMQ-HTTP /
all
}
}
catch
{
Write-Host "Addition of Windows feature MSMQ HTTP Support
failed"
Exit 1
}

write-Host "Addition of Windows feature MSMQ HTTP Support
succeeded"

}

<!--NeedCopy—-->

To install the Windows roles and features prerequisites, complete the following steps:
1. On the machine where you plan to install the Session Recording Administration components:
a) Ensure that the execution policy is set to RemoteSigned or Unrestricted in PowerShell.

Set-ExecutionPolicy RemoteSigned
<!--NeedCopy-->

b) Start a command prompt as an administrator and run the powershell.exe -file
InstallPrereqsforSessionRecordingAdministration.pslcommand.
The script displays the features that are successfully added and then stops.

c) Afterthe scriptruns, ensure that the execution policy is set to a proper value based on your
company policy.

2. On the machine where you plan to install the Session Recording Agent component:
a) Ensure that the execution policy is set to RemoteSigned or Unrestricted in PowerShell.

Set-ExecutionPolicy RemoteSigned
<!--NeedCopy—-->

b) Start a command prompt as an administrator and run the powershell.exe -file
InstallPrereqgsforSessionRecordingAgent.pslcommand.
The script displays the features that are successfully added and then stops.

c) After the script runs, ensure that the execution policy is set to a proper value based on
company policy.
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Install the Session Recording Administration components

We recommend that you install the Session Recording Administration, Session Recording Agent, and
Session Recording Player components on separate servers.

The Session Recording Administration components include the Session Recording Database, Session
Recording Server, and Session Recording Policy Console. You can choose the component to install on
a server.

1. Install Broker_PowerShellSnapin_x64.msi.
Important:

To use the Session Recording Policy Console, you must have the Broker PowerShell Snap-
in (Broker_PowerShellSnapIn_x64.ms1) installed. Locate the snap-in on the Cit-
rix Virtual Apps and Desktops ISO (\ layout\image-full\x64\Citrix Desktop
Delivery Controller)and follow the instructions for installing it manually. Failure
to comply can cause an error.

2. Start the Windows command prompt as an administrator, and then run the msiexec /i
SessionRecordingAdministrationx64.msicommand or double-click the .msi file.

3. Ontheinstallation Ul, click Next and accept the license agreement.

4. Onthe Session Recording Administration Setup screen, select the Session Recording Admin-
istration components you want to install.
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ﬁ Citrix Session Recording Administration Setup — X

Session Recording Policy Consol Feature Description:
Session Recording Server Citrix. Session Recording Database

Session Recording Database

This feature will be installed on the local hard
drive.

This feature requires 12MB on your hard drive.

e >

Curmrert location:

C:\Program FilesCitrix* SessionFecording\Database™. Browse
OdcCot | | FResst | | <Back | Met> ] | Cancel

Note:

Installing all the Session Recording Administration components on a single serveris fine for
a proof of concept. However, for a large production environment, we recommend that you
install the Session Recording Policy Console on a separate server and the Session Record-
ing Server, Session Recording Administrator Logging, and Session Recording Database on
another separate server. The Session Recording Administrator Logging is an optional sub-
feature of the Session Recording Server. Select the Session Recording Server before you
can select the Session Recording Administrator Logging.

Install the Session Recording Database

Note:

+ The Session Recording Database is not an actual database. It is a component responsible
for creating and configuring the required databases in the Microsoft SQL Server instance
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during installation. Session Recording supports three solutions for database high availabil-
ity based on Microsoft SQL Server. For more information, see Database high availability.

+ You can deploy the Session Recording Database on Azure SQL Managed Instance, on SQL
Server on Azure Virtual Machines (VMs), and on AWS RDS. For more information, see Deploy
the Session Recording Database on Azure SQL Managed Instance or on AWS RDS and Deploy
the Session Recording Database on SQL Server on Azure VMs.

There are typically three types of deployments for the Session Recording Database and Microsoft SQL
Server:

+ Deployment 1: Install the Session Recording Server and Session Recording Database on the
same machine and the Microsoft SQL Server on a remote machine. (Recommended)

+ Deployment 2: Install the Session Recording Server, Session Recording Database, and Microsoft
SQL Server on the same machine.

+ Deployment 3: Install the Session Recording Server on a machine and install both the Session
Recording Database and Microsoft SQL Server on another machine. (Not recommended)

1. On the Database and Server Configuration page, specify the instance name and database
name of the Session Recording Database and the computer account of the Session Recording
Server. Click Next.

+ Instance name: If the database instance is not a named instance as you configured when
you set up the instance, you can use only the computer name of the SQL Server. If you
have named the instance, use computer-name\instance-name as the database instance
name. To determine the server instance name that you are using, run select @ @server-
name on the SQL Server. Thereturn value is the exact database instance name. If your SQL
server is configured to be listening on a custom port (other than the default port 1433), set
the custom listener port by appending a comma to the instance name. For example, type
DXSBC-SRD-1,2433 in the Instance name text box, where 2433, following the comma, de-
notes the custom listener port.

« Database name: Type a custom database name in the Database name text box or use the
default database name preset in the text box. Click Test connection to test the connectiv-
ity to the SQL Server instance and the validity of the database name.

Important:

A custom database name must contain only A-Z, a-z, 0-9, and underscores, and can-
not exceed 123 characters.

- You must have the securityadmin and dbcreator server role permissions of the data-
base. If you do not have the permissions, you can:
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* Ask the database administrator to assign the permissions for the installation. Af-
ter the installation completes, the securityadmin and dbcreator server role per-
missions are no longer necessary and can be safely removed.

* Or, during the msi installation, a dialog box prompts for the credentials of a data-
base administrator with the securityadmin and dbcreator server role permis-
sions. Type the correct credentials and then click OK to continue the installation.

The installation creates the Session Recording Database and adds the machine ac-
count of the Session Recording Server as db_owner.

« Session Recording Server computer account:

- Deployments 1 and 2: Type localhost in the Session Recording Server computer
account text box.

- Deployment 3: Type the name of the machine hosting the Session Recording Server
in the format of domain\computer-name. The Session Recording Server computer
account is the user account for accessing the Session Recording Database.

Note:

Attempts to install the Session Recording Administration components can fail with
error code 1603 when a domain name is set in the Session Recording Server
computer account text box. As a workaround, type localhost or NetBIOS domain
name\machine name in the Session Recording Server computer account text
box. To get the NetBIOS domain name, run $env:userdomain in PowerShell or
echo %UserDomain%in a command prompt on the machine where the Session
Recording Server is installed.

2. Follow the instructions to complete the installation.

Install the Session Recording Server

1. Select Session Recording Server and Session Recording Administrator Logging.

Note:

+ The Session Recording Administrator Logging is an optional subfeature of the Session
Recording Server. Select the Session Recording Server before you can select the Ses-
sion Recording Administrator Logging.

« Werecommend that you install the Session Recording Administrator Logging together
with the Session Recording Server at the same time. If you don’t want the Administra-
tor Logging feature to be enabled, you can disable it on a later page.

2. Onthe Database and Server Configuration page, specify the settings.
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+ Instance name: Type the name of your SQL Server in the Instance name text box. If
you are using a named instance, type computer-name\instance-name; otherwise, type
computer-name only. If your SQL server is configured to be listening on a custom port
(other than the default port 1433), set the custom listener port by appending a comma to
the instance name. For example, type DXSBC-SRD-1,2433 in the Instance name text box,
where 2433, following the comma, denotes the custom listener port.

« Database name: Type a custom database name in the Database name text box or use the
default database name CitrixSessionRecording that is preset in the text box.
You must have the securityadmin and dbcreator server role permissions of the database.
If you do not have the permissions, you can:

- Askthe database administrator to assign the permissions for the installation. After the
installation completes, the securityadmin and dbcreator server role permissions are
no longer necessary and can be safely removed.

- Or, during the msi installation, a dialog box prompts for the credentials of a database
administrator with the securityadmin and dbcreator server role permissions. Type
the correct credentials and then click OK to continue the installation.

+ After typing the correct instance name and database name, click Test connection to test
the connectivity to the Session Recording Database.

+ Type the Session Recording Server computer account, and then click Next.

3. Onthe Administration Logging Configuration page, specify configurations for the Administra-
tion Logging feature.

 Logging database is installed on the SQL Server instance: This text box is not editable.
The SQL Server instance name of the Administration Logging database is automatically
grabbed from the instance name that you typed on the Database and Server Configura-
tion page.

+ Logging database name: To install the Session Recording Administrator Logging feature,
type a custom database name for the Administrator Logging database in this text box or
use the default database name CitrixSessionRecordinglLogging that is preset in the text
box.

Note:
The Administrator Logging database name must be different from the Session Record-

ing Database name that is set in the Database name text box on the previous Data-
base and Server Configuration page.

+ Use default database name: Selecting this option uses the default logging database
name.
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+ Enable Logging service: By default, the Administration Logging feature is enabled. You
can disable it by clearing the check box.

+ Enable mandatory blocking: By default, mandatory blocking is enabled. The normal
features might be blocked if logging fails. You can disable mandatory blocking by clearing
the check box.

4. Click Next and proceed to complete the installation.

Note:

The Session Recording Server default installation uses HTTPS/TLS to secure communications. If
TLS is not configured in the default Internet Information Services (11S) site of the Session Record-
ing Server, use HTTP. To do so, cancel the selection of SSL in the IS Management Console by
navigating to the Session Recording Broker site, opening the SSL settings, and clearing the Re-
quire SSL check box.

Install the Session Recording Agent

Install the Session Recording Agent on the VDA or VDI machine on which you want to record ses-
sions.

1. Onthe Session Recording Agent Configuration page: If you have installed the Session Record-
ing Server in advance, type the computer name of the machine where you installed the Ses-
sion Recording Server and the protocol and port information for the connection to the Session
Recording Server. If you have not installed Session Recording yet, you can change such infor-
mation later in Session Recording Agent Properties.

2. Follow the instructions to complete the installation.

Note:

When Machine Creation Services (MCS) or Provisioning Services (PVS) creates multiple VDAs with
the configured master image and Microsoft Message Queuing (MSMQ) installed, those VDAs can

have the same QMId under certain conditions. This case might cause various issues, for example:

+ Sessions might not be recorded even if the recording agreement is accepted.
+ The Session Recording Server might not be able to receive session logoff signals and there-
fore, sessions might always be in Live status.

As a workaround, create a unique QMId for each VDA and it differs depending on the deployment
methods.

No extra actions are required if single-session OS VDAs with the Session Recording Agent in-
stalled are created with PVS 7.7 or later and MCS 7.9 or later in the static desktop mode that
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is, for example, configured to make all changes persistent with a separate Personal vDisk or the
local disk of your VDA.

For multi-session OS VDAs created with MCS or PVS and single-session OS VDAs that are config-
ured to discard all changes when a user logs off, use the GenRandomQMID.ps1 script to change
the QMId on system startup. Change the power management strategy to ensure that enough
VDAs are running before user logon attempts.

To use the GenRandomQMID.ps1 script, do the following:

1. Ensure that the execution policy is set to RemoteSigned or Unrestricted in PowerShell.

1 Set-ExecutionPolicy RemoteSigned

2. Create ascheduled task, set the trigger as on system startup, and run with the SYSTEM account
on the PVS or MCS master image machine.

3. Add the command as a startup task.

‘ 1 powershell .exe -file C:\\GenRandomQMID.psl

Summary of the GenRandomQMID.ps1 script:

1. Remove the current QMId from the registry.

2. Add SysPrep = 1 to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSMQ\
Parameters.

3. Stop related services, including CitrixSmAudAgent and MSMQ.

4. To generate a random QMId, start the services that stopped previously.

Example GENRANDOMQMID.PS1:

# Remove old QMId from registry and set SysPrep flag for MSMQ

N

3 Remove-Itemproperty -Path HKLM:Software\Microsoft\MSMQ\Parameters\
MachineCache -Name QMId -Force

(6]

Set-ItemProperty -Path HKLM:Software\Microsoft\MSMQ\Parameters —-Name "
SysPrep" -Type DWord -Value 1

# Get dependent services

O o ~N O

$depServices = Get-Service -name MSMQ -dependentservices | Select -
Property Name

11 # Restart MSMQ to get a new QMId
12

13 Restart-Service -force MSMQ

14

15 # Start dependent services

16
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if ($depServices -ne $null) {

foreach ($depService in $depServices) {

$startMode = Get-WmiObject win32_service -filter "NAME = '$(
$depService.Name)'" | Select -Property StartMode

if ($startMode.StartMode -eq "Auto") {

Start-Service $depService.Name

}

<!--NeedCopy-->

Install the Session Recording Player and the web player

Install the Session Recording Player on the Session Recording Server or on workstations in the domain.
Install the web player on the Session Recording Server only.

Double-click SessionRecordingPlayer.msi and SessionRecordingWebPlayer.ms1
and follow the instructions to complete the installation.

Automate installation

Session Recording supports silent installation with options. Write a script that uses silent installation
and run the relevant commands.

Automate installation of the Session Recording Administration components

Install the complete set of the Session Recording Administration components by using a single
command For example, either of the following commands installs the complete set of the Session
Recording Administration components and creates a log file to capture the installation information.

msiexec /i "c:\SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsReclLogging,StorageDatabase"
DATABASEINSTANCE="WNBIO-SRD-1" DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="C1itrixSessionRecordinglLogging" DATABASEUSER="
localhost" /g /1lxvx "yourinstallationlog"
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<!--NeedCopy-->

msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="CloudSQL" DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="CitrixSessionRecordinglLogging"
AZURESQLSERVICESUPPORT="1" AZUREUSERNAME="CloudSQLAdminName"
AZUREPASSWORD="CloudSQLAdminPassword" /q /1l*vx "c:\WithLogging.log"
<!--NeedCopy-->

Note:

The SessionRecordingAdministrationx64.msi file is located on the Citrix Virtual
Apps and Desktops ISO under \ layout\image-full\x64\Session Recording.

Where:

« ADDLOCAL provides the features for you to select. You can select more than one option. SsRec-
Server is the Session Recording Server. PolicyConsole is the Session Recording Policy Console.
SsRecLogging is the Administrator Logging feature. StorageDatabase is the Session Recording
Database. Session Recording Administrator Logging is an optional subfeature of the Session
Recording Server. Select the Session Recording Server before you can select Session Recording
Administrator Logging.

+ DATABASEINSTANCE is the instance name of the Session Recording database. For example, . \
SQLEXPRESS, computer—-name\SQLEXPRESS,computer-name or tcp:srt-sql-
support.public.ca7b16b60789.database.windows.net,3342 if you are using
Azure SQL Managed Instance.

+ DATABASENAME is the database name of the Session Recording Database.

+ LOGGINGDATABASENAME is the name of the Administrator Logging database.

+ AZURESQLSERVICESUPPORT determines whether cloud SQL is supported. To use cloud SQL,
setitto 1.

+ DATABASEUSER is the computer account of the Session Recording Server.

« AZUREUSERNAME is the cloud SQL admin name.

« AZUREPASSWORD is the cloud SQL admin password.

« /q specifies quiet mode.

+ [t*v specifies verbose logging.

« yourinstallationlog is the location of your installation log file.

Create a master image for deploying the Session Recording Server You might already have the
Session Recording Database and the Administration Logging database in place from an existing de-
ployment. For such scenarios, you can now forego database checks when you are installing the Ses-
sion Recording Administration components using SessionRecordingAdministrationx64.msi. You can
create a master image for deploying the Session Recording Server easily on many other machines.
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After deploying the Server on target machines using the master image, run a command on each ma-
chine to connect to the existing Session Recording Database and Administration Logging database.
This master image support facilitates deployment and minimizes the potential impact of human er-
ror. It applies only to fresh installations and consists of the following steps:

1. Starta command prompt and run a command similar to the following:

msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsReclLogging,StorageDatabase"
DATABASEINSTANCE="sqglnotexists" DATABASENAME="
CitrixSessionRecording2" LOGGINGDATABASENAME="
CitrixSessionRecordinglLogging2" DATABASEUSER="1localhost" /q /1%
vx "c:\WithLogging.log" IGNOREDBCHECK="True"

<!--NeedCopy—-->

This command installs the Session Recording Administration components without configuring
and testing connectivity to the Session Recording Database and the Administration Logging
database.

Set the IGNOREDBCHECK parameter to True and use random values for DATABASEINSTANCE,
DATABASENAME, and LOGGINGDATABASENAME.

2. Create a master image on the machine that you are operating.
3. Deploy the master image to other machines for deploying the Session Recording Server.
4. On each of the machines, run commands similar to the following:

.\SsRecUtils.exe -modifydbconnectionpara DATABASEINSTANCE
DATABASENAME LOGGINGDATABASENAME

iisreset /noforce
<!--NeedCopy-->

The commands connect the Session Recording Server installed earlier to an existing Session
Recording Database and Administration Logging database.

The SsRecUtils.exe file resides in \Citrix\SessionRecording\Server\bin\.
Set the DATABASEINSTANCE, DATABASENAME, and LOGGINGDATABASENAME parameters as
needed.

Retain databases when uninstalling the Session Recording Administration components With
KEEPDB set to True, the following command retains the Session Recording Database and the Admin-
istration Logging database when uninstalling the Session Recording Administration components:

msiexec /x "SessionRecordingAdministrationx64.msi" KEEPDB="True"
<!--NeedCopy-->
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Automate installation of the Session Recording Player and web player

For example, the following commands install the Session Recording Player and web player, respec-
tively.
msiexec /i "c:\SessionRecordingPlayer.msi" /q /lx\vx "

yourinstallationlog"
<!--NeedCopy-->

msiexec /i "c:\SessionRecordingWebPlayer.msi" /q /lxvx "
yourinstallationlog"
<!--NeedCopy-->

Note:

The SessionRecordingPlayer.ms1 fileis located on the Citrix Virtual Apps and Desktops
ISO under \'layout\image-full\x86\Session Recording.

The SessionRecordingWebPlayer.msi fileis located on the Citrix Virtual Apps and Desk-
tops ISO under \ layout\image-full\x64\Session Recording.

Where:

« /g specifies quiet mode.
« [l*v specifies verbose logging.
« yourinstallationlog is the location of your installation log file.

Automate installation of the Session Recording Agent For example, the following command in-
stalls the Session Recording Agent and creates a log file to capture the installation information.

For 64-bit systems:

msiexec /i SessionRecordingAgentx64.msi /q /lxvx yourinstallationlog
SESSTONRECORDINGSERVERNAME=yourservername

SESSIONRECORDINGBROKERPROTOCOL=yourbrokerprotocol
SESSIONRECORDINGBROKERPORT=yourbrokerport

<!--NeedCopy-->

Note:

The SessionRecordingAgentx64.msi file is located on the Citrix Virtual Apps and Desk-
tops ISO under \ layout\image-full\x64\Session Recording.

For 32-bit systems:

msiexec /i SessionRecordingAgent.msi /q /l*vx yourinstallationlog
SESSTONRECORDINGSERVERNAME=yourservername
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SESSIONRECORDINGBROKERPROTOCOL=yourbrokerprotocol
SESSTIONRECORDINGBROKERPORT=yourbrokerport
<!--NeedCopy-->

Note:

The SessionRecordingAgent.msi file is located on the Citrix Virtual Apps and Desktops
ISO under \'layout\image-full\x86\Session Recording.

Where:

+ yourservername is the NetBIOS name or FQDN of the machine hosting the Session Recording
Server. If not specified, this value defaults to localhost.

» yourbrokerprotocolis HTTP or HTTPS that the Session Recording Agent uses to communicate
with the Session Recording Broker. If not specified, this value defaults to HTTPS.

+ yourbrokerport is the port number that the Session Recording Agent uses to communicate
with the Session Recording Broker. If not specified, this value defaults to zero, which directs the
Session Recording Agent to use the default port number for your selected protocol: 80 for HTTP
or 443 for HTTPS.

« /q specifies quiet mode.

+ [t*v specifies verbose logging.

« yourinstallationlog is the location of your installation log file.

Upgrade Session Recording

You can upgrade certain deployments to later versions without having to first set up new machines or
sites. You can upgrade from the latest CU of Session Recording 7.15 LTSR, and from any later version,
to the latest release of Session Recording.

Note:

When you upgrade Session Recording Administration from 7.6 to 7.13 or later and choose Mod-
ify in Session Recording Administration to add the Administrator Logging service, the SQL Server
instance name does not appear on the Administrator Logging Configuration page. The follow-
ing error message appears when you click Next: Database connection test failed. Please enter
correct Database instance name. As a workaround, add the read permission for localhost users
to the following SmartAuditor Server registry folder: HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Server.

You cannot upgrade from a Technical Preview version.
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Requirements, preparation, and limitations

+ Use the Session Recording installer’s graphical or command line interface to upgrade the Ses-
sion Recording components on the machine where you installed the components.

+ Before any upgrade activity, back up the database named CitrixSessionRecording in the SQL
Server instance. In this way, you can restore it if any issues are discovered after the database
upgrade.

+ In addition to being a domain user, you must be a local administrator on the machines where
you are upgrading the Session Recording components.

« If the Session Recording Server and Session Recording Database are not installed on the same
server, you must have the database role permission to upgrade the Session Recording Database.
Otherwise, you can:

- Ask the database administrator to assign the securityadmin and dbcreator server role
permissions for the upgrade. After the upgrade completes, the securityadmin and dbcre-
ator server role permissions are no longer necessary and can be safely removed.

- Or, use the SessionRecordingAdministrationx64.msi file to upgrade. During
the msiupgrade, a dialog box prompts for the credentials of a database administrator who
has the securityadmin and dbcreator server role permissions. Type the correct creden-
tials and then click OK to continue the upgrade.

+ Ifyoudo not planto upgrade all the Session Recording Agents at the same time, Session Record-
ing Agent 7.6.0 (and later) is compatible with the latest (current) release of Session Recording
Server. However, some new features and bug fixes might not take effect.

« Any sessions started during the upgrade of Session Recording Server are not recorded.

+ The Graphics Adjustment option in Session Recording Agent Properties is enabled by default
after a fresh installation or upgrade to keep compatible with the Desktop Composition Redirec-
tion mode. You can disable this option manually after a fresh installation or upgrade.

« The Administrator Logging feature is not installed after you upgrade Session Recording from a
previous release where the feature is unavailable. To add the feature, modify the installation
after the upgrade.

« If there are live recording sessions when the upgrade process starts, there is little chance that
the recording can be complete.

+ Review the following upgrade sequence, so that you can plan and mitigate potential outages.

Upgrade sequence

1. When the Session Recording Database and Session Recording Server are installed on different
servers, stop the Session Recording Storage Manager service manually on the Session Recording
Server. Then upgrade the Session Recording Database first.
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2. Through the Internet Information Services (1IS) Manager, ensure that the Session Recording Bro-
ker is running. Upgrade the Session Recording Server. If the Session Recording Database and
Session Recording Server are installed on the same server, the Session Recording Database is
also upgraded.

3. The Session Recording service is back online automatically when the upgrade of the Session
Recording Server is completed.

4. Upgrade the Session Recording Agent (on the master image).

5. Upgrade the Session Recording Policy Console with or after the Session Recording Server.

6. Upgrade the Session Recording Player.

Deploy the Session Recording Database on cloud SQL database services

This section describes how to deploy the Session Recording Database on Azure SQL Managed Instance,
on AWS RDS, and on SQL Server on Azure VMs.

Deploy the Session Recording Database on Azure SQL Managed Instance or on AWS RDS
Tip:

You can also run a single command similar to the following to deploy the Session Recording Data-
base on Azure SQL Managed Instance or on AWS RDS. For more information, see the preceding
Automate installation section in this article.

msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsReclLogging,StorageDatabase"
DATABASEINSTANCE="CloudSQL" DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="CitrixSessionRecordinglLogging"
AZURESQLSERVICESUPPORT="1" AZUREUSERNAME="CloudSQLAdminName"
AZUREPASSWORD="CloudSQLAdminPassword" /q /1l*vx "c:\WithLogging.log"
<!--NeedCopy-->

1. CreateanAzure SQL Managed instance or create a SQL Server instance through the Amazon RDS
console.

2. (For Azure SQL only) Keep a record of the Server strings that appear in the properties panel.
The strings are the instance name of the Session Recording Database. For an example, see the
following screen capture.
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ADO.NET JDBC  ODBC  PHP

ADO.MET (SQL authentication) - private endpoint

Server=tcpisr-sglinstance.3141e4%e4d94.database.windows.net, 1433;Persist Security Info=False;User ID={your_username}Password=
{your_password}MultipleActiveResultSets=False;Encrypt=True; TrustServerCertificate=False;Connection Timeout=30;

ADO.MET (5L authentication) - public endpoint

Server=tcpisr-sqglinstance.public.3141e49e4d94.database.windows.net, 3342; Persist Security Info=False;User ID={your_username};Password=
{your_password}Multiple ActiveResultSets=False;Encrypt=True TrustServerCertificate =False;Connection Timeout=30;

3. (For AWS RDS only) Keep a record of the Endpoint and Port information. We use it as the in-

stance name of your database, in the format of <Endpoint, Port>.

'::'_1“_"‘"'_5 Services ¥
Amazon RDS X
Connectivity & security Monitoring Logs & events Configu
Dashboard
Databases
Query Editor Connectivity & security
Performance Insights
Snapshots Endpoint & port
Automated backups Endpoint
Reserved instances database-2.ccjfaeoogg0g.us-east-2.rds.amazonaws.com
Proxies
Port
Subnet groups 1433

Parameter groups

Option groups

Events

Event subscriptions

Recommendations

Certificate update

Security group rules (2)

Q

Security group

db2sg (sg-00fbd0fee602a731b)

db2sg (sg-00fbd0fee602a731hb)

4. Run SessionRecordingAdministrationx64.msi to install the Session Recording Database.
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Select the Enable cloud SQL check box and fill in the cloud SQL admin name and password.

Make other required configurations.

ﬁ Citrix Session Recording Administration Setup — >

Database and Server Configuration

cifrix

Specify the instance name and database name of the Session Recording Database and the
computer account of the Session Recording Server.

Instance name |

Example: \SQLEXPRESS compuiername\SQLEXPRESS, compuier-name
top:xxxx. daiabase windows.net, 3342

Enable cloud SQL

Database name |

[] Use default database name

Cloud SQL admin |
name

Cloud SQL admin |
password

Session Recording
Server computer
account Example: localhost, domain'computer-name

< Back Mext = Cancel

Note: If you change the cloud SQL admin password, you must update the password in Session
Recording Server Properties. When you open Session Recording Server Properties, an er-
ror message appears. Click OK to proceed, select the Cloud DB tab, and type the new cloud
SQL admin password. Restart the Citrix Session Recording Analytics service, the Citrix Session

Recording Storage Manager service, and the IS service.
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& Session Recording Server Properties - X

Playback MNotfications CEIP  Logging RBAC Email Cloud DB we|+ |+

Azure 5GL Managed Instance support

This option allows you to enable cloud SQL.

Enable cloud SQL

Cloud SQL admin sitsqsladmin
name :

Cloud SQL admin  [rererermmresssses
password:

Cancel | | ol

Migrate an on-premises database to cloud SQL Managed Instance

1. Migrate your on-premises database according to https://docs.microsoft.com/en-us/data-
migration/ or https://docs.aws.amazon.com/prescriptive-guidance/latest/patterns/migrate-
an-on-premises-microsoft-sql-server-database-to-amazon-rds-for-sql-server.html.

2. To make Session Recording work properly after the migration, run SsRecUtils.exe on the
Session Recording Server.

C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils.

exe -modifyazuredbconnectionpara { Database Instance } { Session
Recording Database Name } { Session Recording Logging Database
Name } { AzureAdminName } { AzureAdminPassword } diisreset /

noforce

3. OntheSession Recording Server, restart the Citrix Session Recording Analytics service, the Citrix
Session Recording Storage Manager service, and the IIS service.
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Migrate a production database from Azure SQL Managed Instance to an on-premises database

1. Migrate the database according to https://docs.microsoft.com/en-us/data-migration/.

2. To make Session Recording work properly after the migration, run SsRecUtils.exe on the
Session Recording Server.

C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils
.exe -modifydbconnectionpara { Database Instance } { Session
Recording Database Name } { Session Recording Logging Database
Name } disreset /noforce

3. Onthe Session Recording Server, restart the Citrix Session Recording Analytics service, the Citrix
Session Recording Storage Manager service, and the |IS service.

Deploy the Session Recording Database on SQL Server on Azure VMs

On SQL Server on Azure VMs, you can deploy the Session Recording Database.

1. Check out an Azure SQL VM.

2. Configurethe VM and add it to the domain where you install the Session Recording components.

3. Use the VM’s FQDN as the instance name during the installation of the Session Recording Data-
base.
Note: When you are using SessionRecordingAdministrationx64.msi for the installation, clear
the Enable cloud SQL check box.

4. Follow instructions to complete the installation.

Uninstall Session Recording

To remove the Session Recording components from a server or workstation, use the uninstall
or remove programs option available from the Windows Control Panel. To remove the Session
Recording Database, you must have the same securityadmin and dbcreator SQL Server role permis-
sions as when you installed it.

For security reasons, the Administrator Logging Database is not removed after the components are
uninstalled.

Dynamic session recording

June 10, 2021
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Previously, session recording started strictly at the very beginning of sessions that met the recording
policies and stopped strictly when those sessions ended.

Starting with the 7.18 release, Citrix introduces the dynamic session recording feature. With this fea-
ture, you can start or stop recording a specific session or sessions that a specific user launches, at any
time during the sessions.

Note:

To make the feature work as expected, upgrade Session Recording, VDA, and Delivery Controller
to Version 7.18 or later.

Enable or disable dynamic session recording

On the Session Recording Agent, a registry value is added for enabling or disabling the feature. The
registry value is set to 1 by default, which means that the feature is enabled by default.

To enable or disable the feature, complete the following steps:

1. After the Session Recording installation is complete, log on as an administrator to the machine
where you installed the Session Recording Agent.

2. Open the Registry Editor.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor.

4. Set the value of DynamicControlAllowed to 0 or use the default value, 1.
1: enable dynamic recording
0: disable dynamic recording

5. Restart the Session Recording Agent to make your setting take effect.
If you are using MCS or PVS for deployment, change the setting on your master image and per-
form an update to make your change take effect.

Warning:

Incorrectly editing the registry can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Dynamically start or stop recording by using PowerShell commands in the Citrix SDKs

You can use the dynamic session recording feature in both on-premises and Citrix Cloud environments
by using the Citrix Virtual Apps and Desktops PowerShell SDK and the Citrix Virtual Apps and Desktops
Remote PowerShell SDK, respectively.
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To determine which SDK to install and use, be aware of the Delivery Controller you specified when

creating your recording policy.

If you select the Citrix Cloud Controller check box to record sessions

in a Citrix Cloud environment, you must validate your Citrix Cloud credentials. For more information,

see Create a custom recording

% lelrvery Group or Machine Ma

policy.

~

Cueries >

m

% Create Cuery
Site Address:

Enfer 3 sfe sodess

X

Citrix Cloud Controller

(@ Delivery Groups () Machines
| Enter 5 Delivery Growp name
Create Cancel
Close

Note:

Do not install the Remote PowerShell SDK on a Citrix Cloud Connector machine. You can install
the Remote PowerShell SDK on any domain-joined machine within the same resource location.
We recommend that you do not run this SDK’s cmdlets on Cloud Connectors. The SDK’s opera-

tion does not involve the Cloud Connectors.

The following table lists three
sion recording.

PowerShell commands that both Citrix SDKs provide for dynamic ses-

Command

Description

Start-BrokerSessionRecording

Lets you start recording a specific active session,
a list of active sessions, or sessions launched by

a specific user. For more information, run Get-

Help Start-BrokerSessionRecording
to see the command online help.
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Command

Stop-BrokerSessionRecording

Get-BrokerSessionRecordingStatus

Description

Lets you stop recording a specific active session,
a list of active sessions, or sessions launched by
a specific user. For more information, run Get-
Help Stop-BrokerSessionRecording
to see the command online help.

Lets you get the recording status of a specific
active session. For more information, run
Get-Help Get-
BrokerSessionRecordingStatus to see
the command online help.

For example, when a user reports an issue and needs timely support, you can use the feature to dy-

namically start recording the user’s active sessions and play back the live recording to proceed with

the follow-up troubleshooting. You can do the following:

1. (For Citrix Virtual Apps and Desktops PowerShell SDK only) Launch PowerShell from the Citrix

Studio console.

= = [Adoss
~ TN CITRIX itrStudio (8YT_DE) -

CommonTests | Actons | Powerspol |

“yKage-gge-1

i Retrezn

| rer

2. Usethe Get-BrokerSession command to get all the active sessions of the target user.

rogram Files\Citrix\Desktop
Files\Citrix\Desktop

Files\Citrix\Desktop

\Program Files\Citrix\Desktop

PS C:
Desktop
A cation
\Program Files\Citrix\Desktop
dows 2016
ws 2016
\Program Files\Citrix\Desktop

t Administrator. C\Windows\System32\WindowsPowerShel\w1.0\Powershell exe

Studi

Studio:

Studio:

Studio:

Studio> §

Studio>

s.sessionstate

sessiontype

)Stype

t-brokersession WKAOE\testusert ~
1id

- [m] X
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3. Usethe Get-BrokerSessionRecordingStatus command to get the recording status of

the specified session.

PS C:\Program Files\Citrix\Desktop Studio>
SessionNotRecorded
PS C:\Program Files\Citrix\Desktop
SessionNotRecorded
PS C:\Program Files\Citrix\Desktop

Studio>

Studio>

Get-BrokerSessionRecordingStatus

Get-BrokersessionRecordingstatus

Note:

The -Session parameter can accept only one session Uid at a time.

. Usethe Start-BrokerSessionRecordingcommand to start recording. By default, a no-

tification message appears to inform users of the recording activity.

The following table shows common ways of using the Start-BrokerSessionRecording

command.

Command

Start-BrokerSessionRecording -User DomainA '\
UserA

Start-BrokerSessionRecording -User DomainA '\
UserA -NotifyUser $false

Start-BrokerSessionRecording -Sessions
$SessionObject

Start-BrokerSessionRecording -Sessions
uid1,uid2,...,uidn

Description

Starts recording all sessions of user UserA in the
domain named DomainA and notifies UserA.
Starts recording all sessions of user UserA in the
domain named DomainA and does not notify
UserA.

Starts recording all sessions in the object named
$SessionObject and notifies the user. To get the
object $SessionObiject, run
$SessionObject=Get-BrokerSession
—username UserA. The name of an object is
prefixed with a dollar sign $. For more
information, see Step 2 and the command online
help.

Starts recording the sessions uid1, uid2, ..., and
uidn, and notifies the users.

5. Usethe Get-BrokerSessionRecordingStatus command to get the recording status of

each target session. The status is supposed to be SessionBeingRecorded.

6. Play back the Live or Complete recordings in the Session Recording Player and proceed with

the follow-up troubleshooting.

Note

The last section of the timeline on the Player progress bar might show gray when you

play back a “Complete”recording ended by the Stop-BrokerSessionRecording
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command and the last section of the recorded session is idle. It is not obvious when the
recorded session has constant activities.

7. Usethe Stop-BrokerSessionRecording command to stop recording when the reported
issue has been triaged or resolved.

The following table shows common ways of using this command:

Command Description

Stop-BrokerSessionRecording -User DomainA \ Stops recording all sessions of user UserA in the

UserA domain named DomainA.
Stop-BrokerSessionRecording -Sessions Stops recording all sessions in the
$SessionObject $SessionObject.

Stop-BrokerSessionRecording -Sessions Stops recording the sessions uid1, uid2, ..., and
uid1,uid2,...,uidn uidn.

On the Citrix Studio Logging screen, you can view the resulting logs of the Start-BrokerSessionRecording
and Stop-BrokerSessionRecording commands.

&4 Citrix Studio - X
File Action View Help
4= | 2 |E)|
| Console Root Actions
Legging =
O Search
g Machine Catalogs || Administrator ' Main Task Start + | End Status & Preferences
£ Delivery Groups ¥ Today [E] Create Cust...
® APF'I'_“t‘U"S APRQ\gh Stop Recording of Session "SDAEG3ES-E14E..  8/20/2020 : 3:56:13...  8/20/2020: 3:36:13..  Successful 5¢ Deletelogs
E°""_e‘ APRO\Gh Stop Recording of Session "4DD67787-DDE..  8/20/2020 : 3:56:09...  8/20/2020: 3:56:09...  Successful View ,
» oggin
a 99 APRO\gh Start Recording of Session 'SDAE93E5-E14E..  8/20/2020: 3:56:05...  8/20/2020: 3:56:05...  Successful
~ x4 Configuration [G] Refresh
£ Administrators APROQ\gh Start Recording of Session 'ADD67787-DDE..  8/20/2020: 3:56:02...  8/20/2020: 3:56:02...  Successful
Controllers APRQ\gh Stop Recording of Session "4DD67787-DDE..  8/20/2020: 3:55:13...  8/20/2020: 3:55:13...  Successful Help
Hosting APRO\gh Stop Recording of Session "5DAE93E5-ET4E..  8/20/2020: 3:55:09...  8/20/2020:3:55:10...  Successful
#g Licensing APRQ\gh Create Machine 'Styx_VDA1_1"in Delivery G...  8/20/2020: 1:22:55...  8/20/2020: 1:22:55...  Successful
g ,S:W\Ffﬁnfﬂ il | APRQNGD Create Delivery Group 'Styx VDAT' 8/20/2020: 1:22:54...  8/20/2020: 1:22:55...  Successful
a ublisnir|
0 Z::Es APRQ\gh Create Machine Catalog Styx_VDA1' 8/20/2020: 1:22:24...  8/20/2020: 1:22:24...  Successful
£ Citrix StoreFront APROQ\gh Create Machine 'Styx_VDA2_1"in Delivery G...  8/20/2020:1:20:01...  8/20/2020: 1:20:02...  Successful
APRQ\gh Create Delivery Group "Styx VDA2' 8/20/2020 : 1:19:59...  8/20/2020: 1:20:02...  Successful
APRQ\gh Create Machine Catalog "Styx_VDAZ' 8/20/2020:1:18:50...  8/20/2020: 1:18:51...  Successful
b Vesterday

Configure

June 10, 2021

After installing the Session Recording components, you can perform the following steps to configure
Session Recording to record Citrix Virtual Apps and Desktops sessions and allow users to view them:

+ Configure the connection to the Session Recording Server
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» Authorize users

+ Create and activate recording policies
+ Specify where recordings are stored

« Specify file size for recordings

+ Customize notification messages

« Enable or disable recording

» Enable or disable digital signing

+ Administrator Logging

+ Database high availability

+ Load balancing

» Change your communication protocol
» Configure CEIP

Configure the connection to the Session Recording Server

June 10,2021

Configure the connection of the Session Recording Player to the Session Recording
Server

Before a Session Recording Player can play sessions, configure it to connect to the Session Recording
Server that stores the recorded sessions. Each Player can be configured with the ability to connect to
multiple Session Recording Servers, but can connect to only one Session Recording Server at a time.
If the Player is configured with the ability to connect to multiple Session Recording Servers, users
can change which Session Recording Server the Player connects to by selecting a check box on the
Connections tab at Tools > Options.

Log on to the workstation where the Session Recording Player is installed.

Start the Session Recording Player.

From the Session Recording Player menu bar, choose Tools > Options.

On the Connections tab, click Add.

In the Hostname field, type the name or IP address of the machine hosting the Session Record-

ok

ing Server and select the protocol. By default, Session Recording is configured to use HTTP-
S/SSL to secure communications. If SSL is not configured, select HTTP.

6. To configurethe Session Recording Player with the ability to connect to multiple Session Record-
ing Servers, repeat Steps 4 and 5 for each Session Recording Server.

7. Ensure that you select the check box for the Session Recording Server you want to connect to.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 60


https://docs.citrix.com/en-us/session-recording/2104/configure/grant-access-rights.html
https://docs.citrix.com/en-us/session-recording/2104/configure/policies.html
https://docs.citrix.com/en-us/session-recording/2104/configure/storage.html
https://docs.citrix.com/en-us/session-recording/2104/configure/file-size-limit.html
https://docs.citrix.com/en-us/session-recording/2104/configure/create-notification-messages.html
https://docs.citrix.com/en-us/session-recording/2104/configure/disable-enable-recording.html
https://docs.citrix.com/en-us/session-recording/2104/configure/digital-signing.html
https://docs.citrix.com/en-us/session-recording/2104/configure/administrator-logging.html
https://docs.citrix.com/en-us/session-recording/2104/configure/session-recording-database-high-availability.html
https://docs.citrix.com/en-us/session-recording/2104/configure/load-balancing.html
https://docs.citrix.com/en-us/session-recording/2104/configure/change-communication-protocol.html
https://docs.citrix.com/en-us/session-recording/2104/configure/ceip.html

Session Recording 2104

Configure the connection of the Session Recording Agent to the Session Recording
Server

The connection between the Session Recording Agent and the Session Recording Server is typically
configured when the Session Recording Agent is installed. To configure this connection after the Ses-
sion Recording Agent is installed, use Session Recording Agent Properties.

1. Logon to the server where the Session Recording Agent is installed.

2. From the Start menu, choose Session Recording Agent Properties.

3. Click the Connections tab.

4. In the Session Recording Server field, type the FQDN of the Session Recording Server.
Note:

To use Message Queuing over HTTPS (TCP is used by default), type an FQDN in the Session
Recording Server field. Otherwise, session recording fails.

5. In the Session Recording Storage Manager message queue section, select the protocol that
is used by the Session Recording Storage Manager to communicate and change the default port
number if necessary.

Note:

To use Message Queuing over HTTP and HTTPS, install all the 1IS recommended features.

6. In the Message life field, accept the default 7,200 seconds (two hours) or type a new value for
the number of seconds each message is retained in the queue if there isa communication failure.
After this time elapses, the message is deleted and the file is playable until the point where the
data is lost.

7. Inthe Session Recording Broker section, select the communication protocol that the Session
Recording Broker uses to communicate and change the default port number if necessary.

8. When prompted, restart the Session Recording Agent Service to accept the changes.

Authorize users

June 10, 2021

To grant users the rights, you assign users to roles using the Session Recording Authorization Console
on the Session Recording Server. Five roles are available:
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Important:

For security reasons, grant users only the rights they need to perform specific functions, such as

viewing recorded sessions.

PolicyAdministrator. Grants the right to view, create, edit, delete, and enable recording poli-
cies. By default, administrators of the machine hosting the Session Recording Server are mem-

bers of this role.

PolicyQuery. Allows the servers hosting the Session Recording Agent to request recording pol-
icy evaluations. By default, authenticated users are members of this role.

LoggingWriter. Grants the right to write the Administrator Logging logs. By default, local ad-
ministrators and the Network Service group are members of this role. Changing the default
LoggingWriter membership can cause log writing failure.

LoggingReader. Grants the right to query the Administrator Logging logs. There is no default
membership in this role.

Player. Grants the right to view recorded Citrix Virtual Apps and Desktops sessions. There is
no default membership in this role. When you install Session Recording, no user has the right
to play recorded sessions. You must assign the right to each user, including the administrator.
A user without the permission to play recorded sessions receives the following error message
when trying to play a recorded session:

Search Failed

. b Search for recorded session files failed.

Access to Session Recording Server was denied. Rejected user request as
access is denied by role-based security.

OK

To assign users to a role, do the following:

ok wn =

Log on as an administrator to the machine hosting the Session Recording Server.
Start the Session Recording Authorization Console.

Select the role to which you want to assign users.

From the menu bar, choose Action > Assign Users and Groups.

Add the users and groups.

Session Recording supports users and groups defined in Active Directory.
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Any changes made to the console take effect during the update that occurs once every minute. Also,
starting with the 1906 release, you can use the Session Recording Policy Console to create recording
viewing policies. For more information, see Recording viewing policies.

Configure policies

March 21, 2024

Use the Session Recording Policy Console to create recording policies, event logging policies, and
recording viewing policies. When creating the policies, you can specify Delivery Controllers from both
the Citrix Cloud and on-premises environments.

Important:

To use the Session Recording Policy Console, you must have the Broker PowerShell Snap-in
(Broker_PowerShellSnapln_x64.msi) or the Citrix Virtual Apps and Desktops Remote PowerShell
SDK (CitrixPoshSdk.exe) installed. The installer does not install the snap-ins automatically. Lo-
cate the Broker PowerShell snap-in on the Citrix Virtual Apps and Desktops ISO (\layout\image-
full\x64\Citrix Desktop Delivery Controller). Locate the Citrix Virtual Apps and Desktops Remote
PowerShell (PS) SDK on the Citrix website. Follow the instructions for installing the snap-in and
the SDK manually. Failure to comply can cause an error.

Tip:

You can edit the registry to prevent recording file losses in case that your Session Record-
ing Server might fail unexpectedly. Log on as an administrator to the machine where you
installed the Session Recording Agent, open the Registry Editor, and add a DWORD value
DefaultRecordActionOnError =1 under HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Agent.

Recording policies

You can activate system-defined recording policies or create and activate your own custom recording
policies. System-defined recording policies apply a single rule to all users, published applications,
and servers. Custom recording policies specifying which users, published applications, and servers
are recorded.

The active recording policy determines which sessions are recorded. Only one recording policy is ac-
tive at a time.
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System-defined recording policies

Session Recording provides the following system-defined recording policies:

+ Do notrecord. The default policy. If you do not specify another policy, no sessions are recorded.

+ Record everyone with notification. If you choose this policy, all sessions are recorded. A pop-
up window appears to notify the recording occurrence.

+ Record everyone without netification. If you choose this policy, all sessions are recorded. No
pop-up window appears to notify recording occurrence.

You cannot modify or delete the system-defined recording policies.

Create a custom recording policy

When you create your own recording policy, you make rules to specify which users or groups, pub-
lished applications or desktops, delivery groups or VDA machines, and Citrix Workspace app client IP
addresses have their sessions recorded. A wizard within the Session Recording Policy Console helps
you create rules. To obtain the list of published applications or desktops and the list of delivery groups
or VDA machines, you must have the read permission as a Site administrator. Configure the adminis-
trator read permission on the Delivery Controller of the Site.

For each rule you create, you specify a recording action and rule criteria. The recording action applies
to sessions that meet the rule criteria.

For each rule, choose one recording action:

+ Do not record. (Choose Disable session recording in the Rules wizard.) This recording action
specifies that sessions meeting the rule criteria are not recorded.

« Record with notification. (Choose Enable session recording with notification in the Rules
wizard.) This recording action specifies that sessions meeting the rule criteria are recorded. A
pop-up window appears to notify the recording occurrence.

+ Record without notification. (Choose Enable session recording without notification in
the Rules wizard.) This recording action specifies that sessions meeting the rule criteria are
recorded. Users are unaware that they are being recorded.

For each rule, choose at least one of the following items to create the rule criteria:

+ Usersor Groups. Createsalist of users or groups to which the action of the rule applies. Session
Recording allows you to use Active Directory groups and white list users.

+ Published Applications or Desktop. Creates a list of published applications or desktops to
which the action of the rule applies. In the Rules wizard, choose the Citrix Virtual Apps and
Desktops Site or Sites on which the applications or desktops are available.
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+ Delivery Groups or Machines. Creates a list of Delivery Groups or machines to which the action
of the rule applies. In the Rules wizard, choose the location of the Delivery Groups or machines.

« IP Address or IP Range. Creates a list of IP addresses or ranges of IP addresses to which the
action of the rule applies. On the Select IP Address and IP Range screen, add a valid IP address
or IP range for which recording is enabled or disabled. The IP addresses mentioned here are the
IP addresses of the Citrix Workspace apps.

Note:

The Session Recording Policy Console supports configuring multiple criteria within a single rule.
When a rule applies, both the “AND”and the “OR”logical operators are used to compute the fi-
nal action. Generally speaking, the “OR”operator is used between items within a criterion, and
the “AND”operator is used between separate criteria. If the result is true, the Session Recording
policy engine takes the rule’s action. Otherwise, it goes to the next rule and repeats the process.

When you create more than one rule in a recording policy, some sessions might match the criteria for
more than one rule. In these cases, the rule with the highest priority is applied to the sessions.

The recording action of a rule determines its priority:

+ Rules with the Do not record action have the highest priority
+ Rules with the Record with netification action have the next highest priority
+ Rules with the Record without notification action have the lowest priority

Some sessions might not meet any rule criteria in a recording policy. For these sessions, the action of
the policy fallback rule applies. The action of the fallback rule is always Do not record. You cannot
modify or delete the fallback rule.

To create a custom recording policy:

1. Logon as an authorized Policy Administrator to the server where the Session Recording Policy
Console is installed.

2. Startthe Session Recording Policy Console and select Recording Policies in the left pane. From
the menu bar, choose Add New Policy.

3. Right-click the New policy and select Add Rule.

4. Select a recording option - In the Rules wizard, select Disable session recording, Enable Ses-
sion Recording with notification (or without notification), and then click Next.

5. Select the rule criteria - You can choose one or more rule criteria:
Users or Groups
Published Applications or Desktop
Delivery Groups or Machines
IP Address or IP Range
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6. Edit the rule criteria - To edit, click the underlined values. The values are underlined based on
the criteria you chose in the previous step.

Note:
If you choose the Published Applications or Desktop underlined value, the Site Address

is the IP address, a URL, or a machine name if the Controller is on a local network. The
Name of Application list shows the display name.

When choosing Published Applications or Desktop or Delivery Groups or Machines, specify
the Delivery Controller for your Session Recording Policy Console to communicate with.

The Session Recording Policy Console is the only channel to communicate with Delivery Con-
trollers from the Citrix Cloud and on-premises environments.

%‘ Rules Wizard

Step 2: Select the rule criteria.

[] Users or Groups

Published Applications or Desktop
Delivery Groups or Machines

[] IP Address or IP Range

Step 3: Edit the rule criteria.

Selecting a rule criterion above activates the option here. To edit, click the underlined value.

Users / Groups: All Users

Published Resources: Select Published Applications or Desktop. .
Delivery Groups /| Machines: Select Delivery Groups or Machines...
|P Address / IP Range: 4ll IP Addresses

ot Corcs

For example, when choosing Delivery Groups or Machines, click the corresponding hyperlink
in Step 3 of the preceding screenshot and click Add to add queries to the Controller.
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C.

@' Create Cuery
Site Address:

Efer 5 sife aodess

Citrix Cloud Controller

it

i@ Delivery Groups i) Machines
| Enfer 3 Delivery Group name
Create Cancel
Close

For a description of use cases that cover the on-premises and the Citrix Cloud Delivery Con-

trollers, see the following table:

Use Case

On-Premises Delivery Controller

Citrix Cloud Delivery Controller

Switch from an on-premises Delivery Controller
to a Citrix Cloud Delivery Controller

Action Required

a) Install Broker_PowerShellSnapln_x64.msi.
2. Clear the Citrix Cloud Controller check
box.

a) Install the Citrix Virtual Apps and Desktops
Remote PowerShell SDK. 2. Validate the
Citrix Cloud account credentials. 3. Select
the Citrix Cloud Controller check box.

a) Uninstall
Broker_PowerShellSnapln_x64.msi and
restart the machine. 2. Install the Citrix
Virtual Apps and Desktops Remote
PowerShell SDK. 3. Validate the Citrix
Cloud account credentials. 4. Select the
Citrix Cloud Controller check box.
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Use Case Action Required

Switch from a Citrix Cloud Delivery Controller to

. . a) Uninstall the Citrix Virtual Apps and
an on-premises Delivery Controller

Desktops Remote PowerShell SDK and
restart the machine. 2. Install
Broker_PowerShellSnaplin_x64.msi. 3.
Clear the Citrix Cloud Controller check
box.

Validating the Citrix Cloud credentials

To query Delivery Controllers hosted in the Citrix Cloud, manually validate your Citrix Cloud
credentials on the machine where the Session Recording Policy Console is installed. Failure

to comply can cause an error and your Session Recording Policy Console might not work as
expected.

To do the manual validation:

a) Log on to the Citrix Cloud console and locate Identity and Access Management > API
Access. Create an APl access Secure Client for obtaining an authentication profile that can
bypass the Citrix Cloud authentication prompts. Download your Secure Client, rename,
and save it in a safe location. The file name is defaulted to secureclient.csv.

=  Citrix Cloud

« |dentity and Access Management

Authentication ~ Administrators APl Access  Domains

Secure Clients are used to interact with Citrix Cloud APIs.

To use this secure client in a silent connector install or to access any of our APIs, use the customer ID* * "_.asthe customer parameter.

Name+ Id Creation Date Actions
lient 3:53:01 PM Dec 3, 2018 o

b) Open a PowerShell session and run the following command to have the authentication
profile (obtained in the preceding step) take effect.
asnp citrix.x

Set-XDCredentials —-CustomerId "citrixdemo" -SecureClientFile "

c:\temp\secureclient.csv" -ProfileType CloudAPI - StoreAs "
default"

<!--NeedCopy-->

Set Customerld and SecureClientFile as required. The preceding command creates a
default authentication profile for the customer citrixdemo to bypass authentication
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prompts in the current and all subsequent PowerShell sessions.
7. Follow the wizard to finish the configuration.
Note: Limitation regarding prelaunched application sessions:

« If the active policy tries to match an application name, the applications launched in the
prelaunched session are not matched, which results in the session not being recorded.

« If the active policy records every application, when a user logs on to Citrix Workspace app
for Windows (at the same time that a prelaunched session is established), a recording noti-
fication appears and the prelaunched (empty) session and any applications to be launched
in that session going forward are recorded.

As a workaround, publish applications in separate Delivery Groups according to their recording
policies. Do not use an application name as a recording condition. This approach ensures that
prelaunched sessions can be recorded. However, notifications still appear.

Use Active Directory groups Session Recording allows you to use Active Directory groups when
creating policies. Using Active Directory groups instead of individual users simplifies the creation and
management of rules and policies. For example, if users in your company’s finance department are
contained in an Active Directory group named Finance, you can create a rule that applies to all mem-
bers of this group by selecting the Finance group in the

Rules wizard when creating the rule.

White list users You can create Session Recording policies ensuring that the sessions of some users
in your organization are never recorded. This case is called

white listing these users. White listing is useful for users who handle privacy-related information or
when your organization does not want to record the sessions of a certain class of employees.

For example, if all managers in your company are members of an Active Directory group named Exec-
utive, you can ensure that sessions of these users are never recorded by creating a rule that disables
session recording for the Executive group. While the policy containing this rule is active, no sessions
of members of the Executive group are recorded. The sessions of other members of your organization
are sessions recorded based on other rules in the active policy.

Configure Director to use the Session Recording Server

You can use the Director console to create and activate the recording policies.

1. For an HTTPS connection, install the certificate to trust the Session Recording Server in the
Trusted Root Certificates of the Director server.
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2. To configurethe Director serverto use the Session Recording Server, run the C:\inetpub\wwwroot\Director)
[configsessionrecording command.

3. Type the IP address or FQDN of the Session Recording Server and the port number and con-
nection type (HTTP/HTTPS) that the Session Recording Agent uses to connect to the Session
Recording Broker on the Director server.

Event logging policies

Session Recording supports centralized configuration of event logging policies. You can create poli-
cies in the Session Recording Policy Console to log various events.

Note:

To log the insertion of USB mass storage devices and the application starts and ends, use Session
Recording Version 1811 or later.

To log file operation events and web browsing activities, use Session Recording Version 1903 or
later.

To log clipboard activities, use Session Recording Version 2012 or later.

System-defined event logging policy

The system-defined event logging policy is Do not log. It is inactive by default. When it is active, no
events are logged.

You cannot modify or delete the system-defined event logging policy.

Create a custom event logging policy

When you create your own event logging policy, you make rules to specify which users or groups, pub-
lished applications or desktops, delivery groups or VDA machines, and Citrix Workspace app client IP
addresses have specific events logged during session recording. A wizard within the Session Record-
ing Policy Console helps you create rules. To obtain the list of published applications or desktops and
the list of delivery groups or VDA machines, you must have the read permission as a Site administrator.
Configure the administrator read permission on the Delivery Controller of the Site.

To create a custom event logging policy:

1. Logon as an authorized Policy Administrator to the server where the Session Recording Policy
Consoleisinstalled.

2. Start the Session Recording Policy Console.
By default, there is no active event logging policy.
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File Action View Help

= | Z | 6| HE

% Citrix Session Recording Poelicy Console

% Session Recording Policy Consol
~ [ Recording Paolicies
[ Custom Recording Policy
[E De not record

[E Record everyone without
v [# Event Logging Policies
[= Donotlag

[E Record everyone with notif

2 || Policy Name

@Cus’[om Recording Policy
E Do not record
@ Record everyone with notification

@ Record everyone without notification
n

Description

This policy will disable recording of all sessions.
This policy will enable recording of all sessions. ...
This policy will enable recording of all sessions. ...

3. Select Event Logging Policies in the left pane. From the menu bar, choose Add New Policy to

create an event logging p

olicy.

4. (Optional) Right-click the new event logging policy and rename it.

% Citrix Session Recording Policy Console

File Action VWiew Help

= %5 & HE

& Session Recording Pelicy Conscle || Rule Name Action
h E‘ Recording Policies _-igSystem defined nule Logs no events
(& Custom Recording Policy
[Z Do not record
[E Record everyone with notif
[Z Recerd everyone without n
v [ Event Logging Policies
[Z Donotleg
[E New event [nnminn nalis
Add Rule
Activate Policy
Copy Policy
Delete Policy
View Policy
All Tasks »
View »
Refresh
Help

5. Right-click the new event logging policy and select Add Rule.

a) Specify one or more target events to monitor by selecting the check box next to each event

type.
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]

File Action View Help
o= 2 6l H

3 Session Recording Policy Console || Ruie Name Descrption Action
s

v (5 Recor e [ System defined nie Logs no events
rd

ever with notif|
[E Record everyone without n e Rules Wizard x
v [ Event Logging Palicies
Do not log
|5 New event logging policy
[ Email Alert Policies

Step 1: Select one or more of the following options to specify whether to log the related events.

Log clipboard activities

Next > Cancel

+ Log CDM mapped USB events: Logs the insertion of a Client Drive Mapping (CDM)
mapped mass storage device in a client device where Citrix Workspace app for Win-
dows or for Mac is installed, and tags the event in the recording.

+ Log generic redirected USB events: Logs the insertion of a generic redirected mass
storage device in a client where Citrix Workspace app for Windows or for Mac is in-
stalled, and tags the event in the recording.

+ Log app start events: Logs the starts of target applications and tags the event in the
recording.

+ Log app end events: Logs the ends of target applications and tags the event in the
recording.

Note:

Session Recording cannot log the end of an application without logging its start.
Therefore, in the Rules wizard, the Log app end events check box is grayed out
before you select Log app start events.

« App monitoring list: When you select Log app start events and Log app end events,
use the App monitoring list to specify target applications to monitor and to avoid an
excessive number of events from flooding the recordings.

Note:

- To capture the start and end of an application, add the process name of the
application in the App monitoring list. For example, to capture the start of
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Remote Desktop Connection, add the process name mstsc.exe to the App
monitoring list. When you add a process to the App monitoring list, applica-
tions driven by the added process and its child processes are monitored. Ses-
sion Recording adds the process names, cmd . exe, powershell.exe, and
wsl.exe, to the App monitoring list by default. If you select Log app start
events and Log app end events for an event logging policy, the starts and
ends of the Command Prompt, PowerShell, and Windows Subsystem for Linux
(WSL) apps are logged regardless of whether you manually add their process
names to the App monitoring list. The default process names are not visible
on the App monitoring list.

- Separate process names with a semicolon (;).

- Only the exact match is supported. Wildcards are not supported.

- Process names you add are case-insensitive.

- To avoid an excessive number of events from flooding the recordings, do not
add any system process names (for example, explorer.exe) and web browsers
in the registry.

+ Log sensitive file events: Logs the operations on target files in the recording.

« File monitoring list: When you select Log sensitive file events, use the File moni-
toring list to specify target files to monitor. You can specify folders to capture all files
within them. Nofile is specified by default, which means no file is captured by default.

Note:

- To capture renaming, creation, deletion, or moving operations on a file, add
the path string of the file folder (not the file name or the root path of the
file folder) in the File monitoring list. For example, to capture renaming,
creation, deletion, and moving operations on the sharing.pptfilein C:\
User\File, add the path string C:\User\F1ile in the File monitoring
list.

- Both local file paths and remote shared folder paths are supported. For exam-
ple, to capture operations on the RemoteDocument.txt file in the \\ remote
.address\Documents folder, add the path string \\remote.address
\Documents in the File monitoring list.

- Separate monitored paths with a semicolon (;).

- Only exact matches are supported. Wildcards are not supported.

- Path strings are case-insensitive.

Limitations:

- Copying files or folders from a monitored folder to an unmonitored folder cannot
be captured.
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- When the length of a file or folder path including the file or folder name exceeds
the maximum length (260 characters), operations on the file or folder cannot be
captured.

- Pay attention to the database size. To prevent large numbers of events from being
captured, back up or delete the “Eventtable regularly.

- When large numbers of events are captured at time intervals, the Player displays
and the database stores only one event item for each event type to avoid storage
expansion.

+ Log web browsing activities: Logs user activities on supported browsers and tags
the browser name, URL, and page title in the recording.

Events and Bookmarks

Ab web browsing: hitp sy, google.com, Google - Google Chrome, chrome

List of supported browsers:

Browser Version
Chrome 69 and later
Internet Explorer 11

Firefox 61 and later

+ Log top-most window activities: Logs the top-most window activities and tags the
process name, title, and process number in the recording.

Events and Bookmarks x

€3 1:56:08 &AM Top-most window: EXCEL, BookZ, 380

3 1:56:22 &AM Top-most window:, explorer, CITRIXINSTALLATIONLOGS, 7212
3 1:56:36 b Top-most window: Taskmgr, CdfiSve exe, 9276

3 1:56:39 b Top-most window: explorer, Application. evts, 7212

2 1:56:55 A Top-most window: notepad-++, , 4940

2 1:56:59 &AM Top-most window: explorer, Desktop, 7212

23 1:57:08 &M Top-most window: WINWIORD, Bisjisbb |.docx, 8995

3 1:5713 AM Top-most window: notepad++, , 4540

3 1:57:20 AW Top-most window: T askmgr, CdfS vo.exe, 9276

3 1:57:34 &M Top-most window: Tazkmgr, CitiAuthentication VitualSmartcard exe, 9276
3 1:57:51 AM  Top-most window: regedit, FileDperationtonitorList, 5584

2 1:58:04 AW Top-most window: notepad++, shi, 4940

2 1:55:25 M Top-most window: explorer, Task Switcher, 7212

€3 1:55:26 AWM Top-most window: EXCEL, Grid, £220

+ Log clipboard activities: Logs copy operations of text, images, and files using the
clipboard. The process name and file path are logged for a file copy. The process
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name and title are logged for a text copy. The process name is logged for an image
copy.

b) Select and edit the rule criteria.

Similar to creating a custom recording policy, you can choose one or more rule criteria:
Users or Groups, Published Applications or Desktop, Delivery Groups or Machines,
and IP Address or IP Range. For more information, see the instructions in the Create a
custom recording policy section.

Note:

Some sessions might not meet any rule criteria in an event logging policy. For these
sessions, the event logging action of the fallback rule applies, which is always Do not
log. You cannot modify or delete the fallback rule.

c) Follow the wizard to complete the configuration.

[Ee Rules Wizard X

Step 4: Complete the rule setup.

Specify a name for this rule:
|1 |

Provide a description for this rule:
[ Speciic user nie fitet |

Enable this nile

Summary (click Back to edit):
Options sefected:

Log &CDM mapped USB events
Rule criena:

Users / Groups  Published Resources  Delivery Groups / Machines  |P Address / IP Range

MName Location
& user JZUAI-SRS-1
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Compatibility with registry configurations

When Session Recording is newly installed or upgraded, no active event logging policy is avail-
able by default. At this time, each Session Recording Agent respects the registry values under
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents to determine whether to log
specific events. For a description of the registry values, see the following table:

Registry Value Description

EnableSessionEvents 1: enables event logging globally; 0: disables
event logging globally (default value data).

EnableCDMUSBDriveEvents 1: enables logging the insertion of CDM mapped
USB mass storage devices; 0: disables logging
the insertion of CDM mapped USB mass storage
devices (default value data).

EnableGenericUSBDriveEvents 1: enables logging the insertion of generic
redirected USB mass storage devices; 0: disables
logging the insertion of generic redirected USB
mass storage devices (default value data).

EnableAppLaunchEvents 1: enables logging only application starts; 2:
enables logging both application starts and
ends; 0: disables logging application starts and
ends (default value data).

AppMonitorList Specifies target applications to monitor. No
application is specified by default, which means
no application is captured by default.

EnableFileOperationMonitorEvents 1: enables logging file operations; 0: disables
logging file operations (default value data).

FileOperationMonitorList Specifies target folders to monitor. No folder is
specified by default, which means no file
operation is captured by default.

EnableWebBrowsingActivities 1: enables logging web browsing activities; 0:
disables logging web browsing activities (default
value data).

Here are some compatible scenarios:

+ Session Recording 1912 is newly installed or upgraded from a previous release (earlier than
1811) that does not support event logging, the related registry values on each Session Record-

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 76



Session Recording 2104

ing Agent are the default. Because there is no active event logging policy by default, no events
are logged.

If Session Recording 1912 is upgraded from a previous release (earlier than 1811) that supports
event logging but has the feature disabled before your upgrade, the related registry values on
each Session Recording Agent remain the default. Because there is no active event logging pol-
icy by default, no events are logged.

If Session Recording 1912 is upgraded from a previous release (earlier than 1811) that supports
event logging and has the feature partially or fully enabled before your upgrade, the related
registry values on each Session Recording Agent remain the same. Because there is no active
event logging policy by default, the event logging behavior remains the same.

If Session Recording 1912 is upgraded from 1811, the event logging policies configured in the
Policy Console remain in use.

Caution:

When you activate the system-defined or a custom event logging policy in the Session Recording

Policy Console, the relevant registry settings on each Session Recording Agent are ignored and

you cannot use registry settings for event logging any longer.

Recording viewing policies

The Session Recording Player supports role-based access control. You can create recording viewing

policiesin the Session Recording Policy Console and add multiple rules to each policy. Each rule deter-

mines which user or user group can view the recordings originating from other users and user groups,

published applications and desktops, and delivery groups and VDAs you specify.

Create a custom recording viewing policy

Before you can create recording viewing policies, enable the feature as follows:

1

N

Log on to the machine hosting the Session Recording Server.
From the Start menu, choose Session Recording Server Properties.
In Session Recording Server Properties, click the RBAC tab.

Select the Allow to configure recording viewing policies check box.
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i@] Session Recording Server Properties — )4

Storage  Signing Follover Flayback Notifications CEIP Logging REBAC
Recarding viewing policy

This option allows you to configure recording wiewing policies in the
Session Recording Policy Conscle.

Allow to configure recording viewing policies.

To create a custom recording viewing policy:

Note: Different from recording policies and event logging policies, a recording viewing policy (includ-
ing all rules added within) is active immediately when it is created. You do not have to activate it.

1. Logon as an authorized Policy Administrator to the server where the Session Recording Policy
Console is installed.

2. Start the Session Recording Policy Console. By default, there is no recording viewing policy.
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% Session Recording Policy Consele || Palicy Name
~ [=; Recording Policies
[ Do not record
[= Record everyone with notif
[= Recerd everyone without n
[ Event Logging Policies
[ Recording Viewing Policies

Note: The Recording Viewing Policies menu is not available unless you have enabled the fea-
ture in Session Recording Server Properties.

3. Select Recording Viewing Policies in the left pane. From the menu bar, choose Add New Policy
to create a recording viewing policy.

% 5ession Recording Policy Console || Palicy Name
~ [ Recording Policies
[ Do not record
|= Record everyone with notif
@ Record everyone without n
[ Event Logging Policies
5 Recrrdina Wicwinn Daliciar

Add Mew Policy

All Tasks ¥
View ¥
Refresh

Help

4. (Optional) Right-click the new policy and rename it.
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% Session Recording Policy Censcle || Bule Mame
~ [= Recording Policies
[ Do not record
E Mew policy
[= Record everyone with notif
[= Record everyone without n
[% Event Logging Policies
w [ Recording Viewing Policies

E Mews Pnlinme

Add rule

Type

Delete Policy
All Tasks »
View »

Rename

Refresh

Help

5. Right-click the new policy and select Add rule.

a) Specify which user or user group can view the recordings originating from other users and
user groups you specify.
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[Ef Rules Wizard X

Selected user or user group who can view recordings

| Add..

Selected users and user groups whose recordings can be viewed

< Back MNexd = Cancel

Note:

In eachrule, you can select only one user or user group as the recording viewer. If you
select multiple users or user groups, only your most recent selection takes effect and
appears in the text box.

When you specify a recording viewer, ensure that you have assigned the viewer to the
Player role. A user without the permission to play recorded sessions receives an error
message when trying to play a recorded session. For more information, see Authorize
users.

b) Select and edit the rule criteria to specify whose recordings are visible to the viewer spec-
ified earlier:

« Users or Groups
+ Published Applications or Desktop
« Delivery Groups or Machines
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% Rules Wizard

Step 2: Select the rule criteria.

[ Users or Groups
] Published Applications or Desktop
[ Delivery Groups or Machines

Step 3: Edit the rule criteria.

Users / Groups: All Users
Published Resources: All Applications and Desktop
Delivery Groups / Machines: All Delivery Groups and Machines

< Back Meat = Cancel

Note: If you leave the rule criteria unspecified, the viewer specified earlier has no record-
ings to view.

c) Follow the wizard to complete the configuration.
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% Rules Wizard

Complete the rule setup.

Recording viewer:

(s administratar

Rule crfera:

Users / Groups  Published Resources  Delivery Groups / Machines

Name
8 administrator

Location
SHNKG

< Back

Cancel

Email alert policies

This policy setting allows you to send email alerts to specified recipients when a session start or a
logged eventis detected. Email alerts are intended for recorded sessions and logged events according

to the active recording and event logging policies.

For an example email alert, see the following screen capture:
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Citrix Session Recordin

File Message Help @ Tell me what you want to do
]ﬂ[ Delete | ~  [=] Archive E\I?I Move ~ 6) Reply <é) Reply Al — Forward Elf'ITodn = EE Mark Unrea

Citrix Session Recording Alert: A TopMost was detected. VDAMachine: AWTSVDA-0002;

° SR-ALERT <srt-no-reply@outlook.com=

Thizs email comes from Citrix Session Recording to notify vou that a Tophlost was detectad:

[CAUTION - EXTERNAL EMAIL] DO NOT re

Session Details

Lzer Marme administr ator

Daomain Mame KEHTE

Start Time 115872020 215:06 &M

Delivery Group Fde Desh top And SppGroup

Application R Desktop,

DA Machine

Flavback LIRL hittpis:, wehplaver S/ plaver £
Ewent Text Topfpp: regedit

Event Time 11872020 %1751 &M

You can find the session recording video and more information hers.

This is an automated email from Crtrix Session Recording. Do not reply:

Tip:

Clicking the playback URL opens the playback page of the recorded session in the web player.
Clicking here opens the All recordings page in the web player.

You can activate the system-defined email alert policy or create and activate your own custom email
alert policies. When creating a custom policy, you can add multiple rules to each policy. Each rule
determines which users or groups, published applications or desktops, delivery groups or VDA ma-
chines, and Citrix Workspace app client IP addresses can trigger the email alerts when session starts
are detected.

Only one email alert policy can be active at a time.
System-defined email alert policy

Session Recording provides one system-defined email alert policy:

« Do not alert. The default policy. If you do not specify another policy, no email alerts are sent.
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Create a custom email alert policy

To create a custom email alert policy, do the following:

1. Configure outgoing email settings in the Session Recording Server Properties.

[y Session Recording Server Properties -
Rolover Playback Notfications CEIP  Logging RBAC Emai
SMTP server: |smip.office365.com
Port 587| [ Enable SSL
Display name: |Cirix Session Recording
Email address: |st-noeply@outlook com|
Password: e
Email title Emai body
User name User name
[(] Domain name Domain name
[[] Start time ] Start time
[[] Delivery group {4 Delivery group
[[] Application Application
(] VDA Machine VDA Machine
Recording URL
] Allow sending email notifications
OK Cancel
Note:

If you select more than two options in the Email title section, a warning dialog appears,

saying that the email subject might be too long. After you select Allow sending email no-

tifications and click Apply, Session Recording sends an email to verify your email settings.

If any setting is incorrect, for example, an incorrect password or port, Session Recording
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returns an error message with the error details.

Vahdation Error -

The email account can't send message successfully, please
! check your configuration.

The SMTP server requires a secure connection or the client was
not authenticated. The server response was: 5.7.57 SMTP:
Client was not authenticated to send anonymous mail during
MAIL FROM [BN3PRO3CANDT2. namprdD3.prod.outlook.com]

Your email settings need about five minutes to take effect. To have your email settings
take effect immediately or fix the issue that emails are not sent according to the settings,
restart the Storage Manager (CitrixSsRecStorageManager) service. Also, restart the Storage
Manager service if you upgrade to the current release from Version 2006 and earlier.

2. Create a custom email alert policy in the Session Recording Policy Console.

a) Log on as an authorized Policy Administrator to the server where the Session Recording
Policy Console is installed.

b) Startthe Session Recording Policy Console. By default, there is no active email alert policy.
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% Citrix Session Recerding Pelicy Console
File Action View Help
o= |FclHm
C73 ‘S_aisi on Rc.cording. ?olicyfonsol! Session Recording Server
v [= Recording Policies Thie Sessen Recordng Server is responsible for providing cerfrakzed storage of recordng

|= Do not record polcies.
(& Record everyene with notification

Huoat: SRSERVER
|= Record everyone without notification pename
w [%; Event Logging Policies Protecad; HTTP
. E [?o not Iog. . Port: a0
~ (2 Email Alert Policies
[E Do not alert Active Session Recording Policy

Al existing recording policies are ited in the left pane. Onlly one recording policy is active
at atime. To activate a recording policy, fight-click & and select "Activate Policy” from the:
shortcut menu

The active recording policy is appiied when a Ciric Virtual Apps 7 session is established.

Name: Record everyone with natfication
Dascription: This palicy records all sessions and notifies usars of the recording
activity

Active Evert Logging Policy

Al exigting event logging policies ane sted in the left pane. Only one event logging policy is
active at a time. To aclivate an event logging policy. fightclick t and select "Activale
Policy” from the shortout menu.

The active event logging pobcy is appied when session recording is ensbled,
Name:

Description:

Active Alert Motfication Logging Palicy

Al esdsting alert notification policies are listed in the left pane. Only one alert policy i active:
at 3 time. To aclivate an alert policy. nght-click it and select "Activate Polcy” from the
shodeut menu

The active aled nofification policy is applied when session recording is enabled.

MName:

Description:

c) Select Email Alert Policies in the left pane. From the menu bar, choose Add New Policy
to create an email alert policy.

d) (Optional) Right-click the new email alert policy and rename it.
e) Right-click the new email alert policy and select Add Rule.

5a. Select A session start is detected or A session event is detected. Add email ad-
dresses for the alert recipients.
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[E% Rules Wizard X

Step 1-1: Select one or more options you want to trigger email alerts.

[ A session start is detected.
A session event is detected.

Curment Event Triggers (0)

Step 1-2: Enter one or more email addresses as the alert recipients.

Email recipients:
Type the emai sdoresses who will receive alerfs according fo this mile. Separste ihe sodesses with 5 semicolon (1

Cance

If you select A session event is detected, click Current Event Triggers to specify logged
events that trigger email alerts. Select event types from the drop-down list and set event
rules through the two dimensions that are combined using the logical AND operator. You
cansetuptoseven eventrules. If you select an event type but leave its dimensions unspec-
ified, email alerts are sent when events of the type occur. Also, you can define your event
triggers in the Description column or leave the column empty. Your defined description
of an event trigger is provided in the alert emails when events of the type are logged. Click

Confirm when you are finished.

Note: You must select the event types that the active event logging policy logs.
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Q Rules Wizard

Step 1-1: Select one or more options you want to trigger email alerts.

[] A session start is detected
[] A session event is detected

| Curent Event Triggers (D)

Step 1-2: Enter one or more email as the alert

Email recipients

Tipe the email addresses who will receive alerts according fo this rule. Separate the addresses with 3 semicalon (7.

Event Triggers

Or evert type is

Dimension 1

Dimension 2

UGN File size (MB)

| |Greaterth... [~

File

ing
File Rename

File Move

File Delete

CDM USB

Generic USB

Idle

For a complete list of supported event types, see the following table.

Event type Dimension Option
App Start
App name
Full command line
App End
App name
Top Most
App hame

Web Browsing

File Create

Windows title

URL
Tab title

Browser name

Path
File size(MB)
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Event type Dimension Option
File Rename
Path
Name
File Move

Source path

Destination path

File size(MB)
File Delete

Path

File size(MB)
CDM USB

Drive letter
Generic USB

Device name
Idle

idle duration(Hrs)

5b. Add email addresses for the alert recipients.
5c. Click Next to select and edit the rule criteria.

Similar to when creating a custom recording policy, you can choose one or more rule crite-
ria: Users or Groups, Published Applications or Desktop, Delivery Groups or Machines,
and IP Address or IP Range. For more information, see the instructions in the Create a
custom recording policy section.
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" Rules Wizard X

Step 2: Select the rule criteria.
] Users or Groups

[[] Published Appications or Desktop
[[] Delvery Groups or Machines

[] 1P Address or IP Range

Step 3: Edit the rule criteria.
Selecting a rule criterion above activates the option here. To edit, click the underlined value

Users / Groups: Select Users or Groups .,

Published Resources: All Applications and Desktop

Delivery Groups / Machines: All Delivery Groups and Machines
IP Address / IP Range: All IP Addresses

< Back Cancel

Note:

When a session or an event meets more than one rule in a single email alert policy,
the oldest rule takes effect.

5d. Follow the wizard to complete the configuration.

f) Activate the new email alert policy.

3. Edit registry for accessing the web player.

To make the playback URLs in your alert emails work as expected, browse to the registry key
at HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server and do the
following:

+ Set the value data of LinkHost to the URL of the domain you use to access the web player.
For example, to access a web player at https://example.com/webplayer/#/
player/,setthevalue data of LinkHost to https: //example. com.

+ Add a new value, EmailThreshold, and set its value data to a number in the range of 1
through 100. The value data determines the maximum number of alert emails that an
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email sending account sends within a second. This setting helps slow down the number
of emails that are being sent and thus reduces the CPU usage. If you leave the value data
unspecified or set it to a number out of range, the value data falls back to 25.

Note:

+ Your email server might treat an email sending account as a spam bot and thus prevent it
from sending emails. To allow an account to send emails, an email client such as Outlook
might request that you verify that the account is used by a human user.

+ Thereis a limit for sending emails within a given period. For example, when the daily limit
is reached, you cannot send emails until the start of the next day. In this case, ensure that
the limit is more than the number of sessions being recorded within the period.

Activate a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.

3. Ifthe Connect to Session Recording Server window appears, ensure that the name of the Ses-
sion Recording Server, protocol, and port are correct. Click OK.

4. Inthe Session Recording Policy Console, expand Recording Policies or Event Logging Policies
as required.

5. Select the policy to activate.

6. From the menu bar, choose Activate Policy.

Modify a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.

3. Ifthe Connect to Session Recording Server window appears, ensure that the name of the Ses-
sion Recording Server, protocol, and port are correct. Click OK.

4. Inthe Session Recording Policy Console, expand Recording Policies or Event Logging Policies
as required.

5. Select the policy you want to modify. The rules for the policy appear in the right pane.

6. To add, modify, or delete a rule:

« From the menu bar, choose Add New Rule. If the policy is active, a pop-up window ap-
pears requesting confirmation of the action. Use the Rules wizard to create a rule.
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« Select the rule you want to modify, right-click, and choose Properties. Use the Rules wiz-
ard to modify the rule.
+ Select the rule you want to delete, right-click, and choose Delete Rule.

Delete a policy

Note:

You cannot delete a system-defined policy or a policy that is active.

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.

3. Ifthe Connect to Session Recording Server window appears, ensure that the name of the Ses-
sion Recording Server, protocol, and port are correct. Click OK.

4. Inthe Session Recording Policy Console, expand Recording Policies or Event Logging Policies
as required.

5. In the left pane, select the policy to delete. If the policy is active, you must activate another
policy.

6. From the menu bar, choose Delete Policy.

7. Select Yes to confirm the action.

Understand rollover behavior

When you activate a policy, the previously active policy remains in effect until the session being
recorded ends or the session recording file rolls over. Files roll over when they have reached the
maximum size. For more information about the maximum file size for recordings, see Specify file size
for recordings.

The following table details what happens when you apply a new recording policy while a session is
being recorded and a rollover occurs:

If the previous recording policy After a rollover, the recording
was And the new recording policy is policy will be
Do not record Any other policy No change. The new policy

takes effect only when the user
logs on to a new session.

Record without notification Do not record Recording stops.

Record without notification Record with notification Recording continues and a
notification message appears.
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If the previous recording policy After a rollover, the recording
was And the new recording policy is policy will be

Record with notification Do not record Recording stops.

Record with notification Record without notification Recording continues. No

message appears the next time
a user logs on.

Specify where recordings are stored

April 3,2023

Use Session Recording Server Properties to specify where recordings are stored and where archived
recordings are restored for playback.

You can store recordings on a local drive, a SAN volume, and a location specified by a UNC network
path. Starting from Version 2103, you can store recordings in Azure file shares. For more information,
see Configure an Azure file share to store recordings later in this article.

Note:

« Storing data on a NAS, based on file-based protocols such as SMB and NFS, might have
performance and security implications. Use the latest version of the protocol in place to
avoid security implications and perform scale testing to ensure proper performance.

 To archive files or restore deleted files, use the ICLDB command.

Specify one or more folders for storing recordings and a folder for restoring archived
recordings

=

. Log on to the machine hosting the Session Recording Server.

2. From the Start menu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the Storage tab.

4. Use the File storage directories list to manage the folders where recordings are stored.

After you select the folders, Session Recording grants its service with Full Control permission to
these folders.

By default, recordings are stored in the <drive>:\SessionRecordings folder of the machine
hosting the Session Recording Server. You can change the folder where you store recordings,
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add extra folders to load-balance across multiple volumes, or make use of more space. Multiple
folders in the list indicate that recordings are load-balanced across the folders. Load balancing
cycles through the folders.

5. Inthe Restore directory for archived files field, type your folder for restoring archived record-
ings.

By default, archived recordings are restored in the <drive>:\SessionRecordingsRestore folder
of the machine hosting the Session Recording Server. You can change the folder.
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[% Session Recording Server Properties — X ‘

Storage Signing Rollover Playback Notfications CEIP  Logging RE*|* |

Recorded session files are stored in the directonies specified. To store files
ir\::,I a load-balanced manner, specify multiple directories across different
volumes.

File storage directories:

List of folders is empty.
The default folder C:\SessionRecordings will be Modify...
used.
Remove

Specify a folder to temporanily store archived session recordings and make
them available for playback.

Restore directory for archived files:
C:\SessionRecordingsRestored Browse...

OK  Cancel Apply
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Configure an Azure file share to store recordings

To create an Azure file share to store recordings, complete the following steps:

1. Inthe Azure portal, create a storage account and then create an Azure file share.

For a quick start guide, see Create and manage Azure file shares with the Azure portal. The

following table recommends configurations for your consideration.

Recording File
Size MB/hour

<6.37

<6.37

<6.37

<6.37

Approx.10

Approx.10

Approx.10

Session
Quantity

<1,000

1,000-2,000

2,000-3,000

3,000-4,000

<1,000

1,000-2,500

2,500-4,000

File Share
Type

HDD Standard
(StorageV2)
SSD Premium

SSD Premium
SSD Premium
HDD Standard
(StorageV2)

SSD Premium

SSD Premium

File Share
Quota (TB)

2

10

Session
Recording
Server
Quantity

1

Session
Recording
Server Size

Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4
Standard
D4as_v4

The file share quota is calculated based on eight hours per day, 23 working days per month, and

a one-month retention period for each recording file.

2. Add the Azure file share credentials to the host where you installed the Session Recording

Server.

a) Start a command prompt as an administrator and change the drive to the <Session
Recording Server installation path>\Bin folder.

By default, the Session Recording Serverisinstalledin C: \Program Files\Citrix\

SessionRecording\Server.

b) Run the SsRecUtils.exe -AddAzureFiles <storageAccountName> <fileShareName>

<accesskey> command.

Where,
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+ <storageaccountname> is the name of your storage account in Azure.

+ <filessharename> is the name of the file share contained within your storage
account.

+ <accesskey> is your storage account key that can be used to access the file share.

There are two ways to obtain your storage account key:

« You can obtain your storage account key from the connection string that appears
when you click the Connect icon in your file share page.

1 docs (G+/) T ® & 2 ©

Connect X
& sessionrecordings sessionrecordings

SMB File share

2 Search (Ctrl+/) ‘ « & Conmnect |T Upload + Add directory | 4A ‘Secure transfer required" is enabled on the storage account. SMB clients connecting to this
—— share must support SMB protocol version 3 or higher in order to handle the encryption

requirement. Click here to learn more.

& Overview [ search files by prefix
82 Access Control (IAM) Name
Windows  Linux  macOS
Settings No files found.
m
Il properties To connect to this Azure file share from Windows, choose from the following
authentication methods and run the PowerShell commands from a normal (not elevated)
Operations PowerShell terminal:
@ snapshots Drive letter
& Backup | z v
Monitoring Authentication method

: QO Active Directory
Al Metrics )
(®) storage account key

© Connecting
Utilizing Activ
within a share.

are using the storage account key is only appropriate for admin access.
ctory allows to differentiate file and folder access, per AD account,
n more

$connectTestResult = Test-NetConnection -ComputerName
sremdstg.file.corewindows.net -Port 445
if (SconnectTestResult.TepTestSucceeded) {
# Save the password so the drive will persist on reboot
cmd.exe /C "cmdkey /add:sremdstg file core windows.net™
Juser:"Azure\: 3
/pass:DSjcn/SOpzwPxhckjTgGZUZtolh8A3PAOHBWOe +19kuid6p7xX11eqNMUOXke? )

This script will check to see if this storage account is accessible via TCP port 445, which is
the port SMB uses. If port 445 is available, your Azure file share will be persistently
mounted. Your organization or internet service provides bl

you may use Azure Point-to-Site (P2S) VPN, Azure Site- e (S25) VPN,
to tunnel SMB traffic to your Azure file share over a different port.

Learn how to circumvent the port 445 problem (VPN)

« You can also obtain your storage account key by clicking Access keys in the left navi-
gation of your storage account page.
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Home > sremd > -
DT Access keys

Storage account

L Search (Ctrl+/) | « Use access keys to authenticate your applications when making requests to this Azure storage account. Store your access b
keys so that you can maintain connections using one key while regenerating the other.

= Overview

When you regenerate your access keys, you must update any Azure resources and applications that access this storage acc
Activity log
Storage account name

L Tags
| sremstg
£ Diagnose and solve problems
PR Access Control (IAM)
W Data migration keyl (D
Key

== Storage Explorer (preview)

| Dsjen/SOpzwPxhck TgGZUZtolhBA3PAOHE WO +19kuid6p7xX11egNMUOXkx7R352f2GHRFUZPIIFI 1 TvbE/A==

Settings

Connection string
| DefaultEndpointsProtocol=https;AccountNa me:_;Accou ntkey=Dsjcn/SOpzwPxhckjTgGZUZtolh8A3PADHSWDe+.

CORS
keyz ()

@

Confi ti
onfiguration Koy

=
& Encryption | O97VNcAmy +WpgFYYO6r30fMyaD20sSGGpJuBgfkDYv3Z27) 19TYOMbWFaz1N6nO81c2qF5IZ00VxqydmysO2A==

&

Shared access signature Connection string

%@ Networking | Deiau\lEndpDintsProtocol:https;AccountName:-,‘AccountKey:GQTVNcAmv—ngFYYOﬁrSOfMyaDZDsSGGpJuB;

@ Security
:|' Properties

E| Locks

File service

& File shares

Monitoring
@ insights
E plerts
¢) Mount the Azure file share to the host where you installed the Session Recording Server.
i. Open Session Recording Server Properties.
ii. Click Add on the Storage tab.
iii. Enterthe UNC pathinthe format of \\<storageaccountname>.file.core.windows.net\<filesshar:

Specify a subfolder under the file share to store your recording files. The Session
Recording Server then automatically creates the subfolder for you.
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!
)

Storage  Signing FRollover Playback MNotfications CEIP  Logging RE |+

Fecorded session files are stored in the directories specified. To store files
in & load-bzalanced manner, specify multiple directories across different
volumes.

File storage directories:

File Storage Directory

Enter a directory for storing recorded session files:

|er.file.co,le.windows.net'-sessionrecording'recon:lings | Browse. ..

Cancel

Specify a folder to temporarily store archived session recordings and make
them awvailable for playback.

Restore directory for archived files:

C:\SessionRecordings Restored Browse...

oK Cancel

iv. Click OKin the File Storage Directory dialog box.
v. Click Apply in the Session Recording Server Properties window.
vi. Click OK after Apply becomes grayed out.

vii. Click Yes when you are prompted to restart the Session Recording Storage Manager
service.

Session Recording Server Properties

The "Citrix Session Recording Storage Manager” service needs
to be restarted for changes to come into effect,

Do you wish to restart the service now?

Specify file size for recordings

June 10, 2021
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As recordings grow in size, recording files can take longer to download and respond more slowly when
you use the seek slider to navigate during playback. To control file size, specify a threshold limit for a
file. When the recording reaches this limit, Session Recording closes the file and creates an extra file
to continue recording. This action is called a rollover.

You can specify two thresholds for a rollover:

« File size. When the file reaches the specified number of MB, Session Recording closes the file
and opens a new one. By default, files roll over after reaching 50 MB. You can specify a limit from
10 MB to 300 MB.

« Duration. After the session records for the specified number of hours, the file is closed and a
new file is opened. By default, files roll over after recording for 12 hours. You can specify a limit
from one to 24 hours.

Session Recording checks both fields to determine which event occurs first to determine when to roll
over. For example, if you specify 17MB for the file size and six hours for the duration and the recording
reaches 17MB in three hours, Session Recording reacts to the 17MB file size to close the file and open
anew one.

To prevent the creation of many small files, Session Recording does not roll over until at least one hour
elapses (this value is the minimum number that you can type) regardless of the value specified for the
file size. The exception to this rule is if the file size surpasses 300 MB.

Specify the maximum file size for recordings

1. Log on to the machine hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the Rollover tab.
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% Session Recording Server Properties — X ‘

Storage Signing Rollover Playback Notfications CEIP Logging RE *[*]

Rollover thresholds specify the maximum limit to which a file may grow
before a new file is started. Files are rolled over when the file size or
recording duration specified, whichever occurs first, is reached. Files are
not rolled over if the recording duration is less than 1 hour and size is less
than 200MB. Files are always rolled over when the size reaches 200MB

regardless of the duration.
File size threshold (MB): 50
Recording duration threshold (hours): 12

OK | Cancel Aoply

4. Type an integer between 10 and 300 to specify the maximum file size in MB.

5. Type an integer between 1 and 24 to specify the maximum recording duration in hours.
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Customize notification messages

March 20, 2024

If the active recording policy specifies that users are notified when their sessions are recorded, a no-
tification message appears after the users type their credentials. The default notification message
is Your activity with the desktop or program(s) you recently started is being recorded. If you
object to this condition, close the desktop or program(s). The users can click OK to dismiss the
window and continue their sessions.

The default notification message appears in the language of the operating system on the VDA.

You can create custom notifications in the languages you choose. However, you can have only one
notification message for each language. Your users see notification messages in the languages of their
preferred local settings.

Create a notification message

Log on to the machine hosting the Session Recording Server.

From the Start menu, choose Session Recording Server Properties.

In Session Recording Server Properties, click the Notifications tab.

Click Add.

Choose the language for the message and type the new message. You can create only one mes-

ok w e

sage for each language.

After accepting and activating, the new message appearsin the
language-specific notification message box.

Enable or disable recording

June 10, 2021

You install the Session Recording Agent on multi-session OS VDAs for which you want to record ses-
sions. Within each Agent is a setting that enables recording for the VDA on which it is installed. After
recording is enabled, Session Recording evaluates the active recording policy that determines which
sessions are recorded.

When you install the Session Recording Agent, recording is enabled. We recommend that you disable
Session Recording on VDAs that are not recorded because they experience a small impact on perfor-
mance, even if no recording takes place.
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Enable or disable recording on a VDA

1. Log on to the server where the Session Recording Agent is installed.

2. From the Start menu, choose Session Recording Agent Properties.

3. Under Session Recording, select or clear the Enable session recording for this VDA machine
check box to specify whether sessions can be recorded for this VDA.

4. When prompted, restart the Session Recording Agent Service to accept the change.

Note:

When you install Session Recording, the active policy is
Do not record (no sessions are recorded on any server). To begin recording, use the
Session Recording Policy Console to activate a different policy.

Enable custom event recording

Session Recording allows you to use third-party applications to insert custom data, known as events,
to recorded sessions. These events appear when the session is viewed using the Session Record-
ing Player. They are part of the recorded session file and cannot be modified after the session is
recorded.

For example, an event might contain the following text: “User opened a browser.”Each time a user
opens a browser during a session that is being recorded, the text is inserted to the recording at that
point. When the session is played using the Session Recording Player, the viewer can locate and count
the times that the user opened a browser by noting the number of markers that appear in the Events
and Bookmarks list in the Session Recording Player.

To insert custom events to recordings on a server:

+ Use Session Recording Agent Properties to enable a setting on each server where you want
to insert custom events. Enable each server separately. You cannot globally enable all servers
in a site.

« Write applications built on the Event API that runs within each user’s Citrix Virtual Apps and
Desktops session (to inject the data into the recording).

The Session Recording installation includes an event recording COM application (API) that allows you
to insert text from third-party applications to a recording. You can use the API from many program-
ming languages including Visual Basic, C++, or C#. For more information, see the Knowledge Center
article CTX226844. The Session Recording Event API .dllis installed as part of the Session Recording in-
stallation. You canfinditat C:\Program Files\Citrix\SessionRecording\Agent\Bin\Interop.UserApi.dll.

To enable custom event recording on a server, do the following:

1. Logon to the server where the Session Recording Agent is installed.
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2. From the Start menu, choose Session Recording Agent Properties.

3. In Session Recording Agent Properties, click the Recording tab.

4. Under Custom event recording, select the Allow third party applications to record custom
data on this server check box.

Enable or disable digital signing

June 10,2021

If you install certificates on machines where you installed the Session Recording Server and the Ses-
sion Recording Player, you can enhance the security of your deployment by assigning digital signa-
tures to Session Recording.

By default, digital signing is disabled. After you select the certificate to sign the recordings, Session
Recording grants the read permission to the Session Recording Storage Manager Service.

Enable digital signing

Log on to the machine hosting the Session Recording Server.
From the Start menu, choose Session Recording Server Properties.
In Session Recording Server Properties, click the Signing tab.

>

Browse to the certificate that enables secure communication among the machines where you
installed the Session Recording components.

Disable digital signing

Log on to the machine hosting the Session Recording Server.

From the Start menu, choose Session Recording Server Properties.
In Session Recording Server Properties, click the Signing tab.

Click Clear.

HwnN e

Administrator Logging

June 10, 2021

Session Recording Administrator Logging logs the following activities:
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Changes to recording policies and event logging policies on the Session Recording Policy Con-
sole or Citrix Director.

Changes in Session Recording Server Properties.

Downloads of recordings in the Session Recording Player.

Recording a session by Session Recording after policy query.

Unauthorized attempts to access the Administrator Logging service.
Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Disable or enable Administrator Logging

After installation, you can disable or enable the Session Recording Administrator Logging feature in
Session Recording Server Properties.

1. As an administrator, log on to the machine where Session Recording Administrator Logging is
installed.

2. From the Start menu, choose Session Recording Server Properties.
3. Click the Logging tab.

When Session Recording Administrator Logging is disabled, no new activities are logged. You can
query the existing logs from the web-based Ul.

When mandatory blocking is enabled, the following activities are blocked if the logging fails. A sys-
tem eventis also logged with an Event ID 6001:

« Changes to recording policies on the Session Recording Policy Console or Citrix Director.
+ Changes in Session Recording Server Properties.

The mandatory blocking setting does not impact the recording of sessions.

Configure an Administrator Logging service account

By default, Administrator Loggingis running as a web applicationin Internet Information Services (l1S),
and its identity is Network Service. To enhance the security level, you can change the identity of this
web application to a service account or a specific domain account.

1. As an administrator, log on to the machine hosting the Session Recording Server.
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2. In lIS Manager, click Application Pools.
3. In Application Pools, right-click SessionRecordingLoggingAppPool and choose Advanced
Settings.
4. Change the attribute identity to the specific account that you want to use.
5. Grant the db_owner permission to the account for the database CitrixSessionRecordinglLog-
ging on the Microsoft SQL Server.
6. Granttheread permissiontotheaccountfortheregistry key at HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\

Disable or enable the recording action logging

By default, Administrator Logging logs every recording action after the policy query completes. This
case might generate a large amount of loggings. To improve the performance and save the storage,
disable this kind of logging in Registry.

1. As an administrator, log on to the machine hosting the Session Recording Server.
2. Open the Registry Editor.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
4. Set the value of EnableRecordingActionLogging to:

0: disable the recording action logging
1: enable the recording action logging

Query the Administrator Logging data

Session Recording provides a web-based Ul to query all Administrator Logging data.

On the computer hosting the Session Recording Server:

1. From the Start menu, choose Session Recording Administrator Logging.
2. Type the credentials of a LoggingReader user.

The Administrator Logging webpage integrated with the web player appears.
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CilTIX | Session Recording

Recordings v D Logging Time
Comments v 18 2/22/2021 10:07 PM
| [EX Administrator Logging A 17 2/22/2021 10:06 PM
Configuration Logging 16 2/22/2021 9:41 PM
Record Reason Logging 15 2/22/2021 9:32 PM
Configuration v ) 29212021 632 P11
13 2/22/2021 9:32 PM

12 2/22/2021 9:32 PM

11 2/22/2021 9:32 PM

10 2/22/2021 9:31 PM

9 2/22/2021 9:31 PM

On other machines:

Task Category

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Component Affected

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

+ Action =

+ Action =

+ Action =

+ Action =

+ Action =

+ Action =

+ Action =

+ Action =

+ Action =

+ Action =

Task Details

Session File Path and Size Query ...

Session File Path and Size Query

Session File Path and Size Query ..

Session File Path and Size Query ...

Session File Path and Size Query

Session File Path and Size Query ..

Session File Path and Size Query ...

Session File Path and Size Query

Session File Path and Size Query ..

Session File Path and Size Query

1. Open a web browser and visit the webpage for Administrator Logging.

+

Task Excuted By Authorized
true

true

1-100f18 2 >

« For HTTPS: https://servername/WebPlayer/#/logging/config and
https://servername/WebPlayer/#/logging/record, where servername

is the name of the machine hosting the Session Recording Server.
« For HTTP: http://servername/WebPlayer/#/logging/config and http
://servername/WebPlayer/#/logging/record, where servername is the

name of the machine hosting the Session Recording Server.

2. Type the credentials of a LoggingReader user.

Database high availability

June 10, 2021

Session Recording supports the following solutions for database high availability based on the Mi-
crosoft SQL Server. Databases can automatically fail over when the hardware or software of a principal
or primary SQL Server fails, which ensures that Session Recording continues to work as expected.

+ Always On availability groups

The Always On availability groups feature is a high availability and disaster-recovery solution
that provides an enterprise-level alternative to database mirroring. Introduced in SQL Server
2012, the Always On availability groups solution maximizes the availability of a set of user data-

bases for an enterprise. It requires that the SQL Server instances reside on the Windows Server
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Failover Clustering (WSFC) nodes. For more information, see Always On availability groups: a
high-availability and disaster-recovery solution.

+ SQL Server clustering

The Microsoft SQL clustering technology allows one server to automatically take over the tasks
and responsibilities of the server that has failed. However, setting up this solution is compli-
cated and the automatic failover is typically slower than alternatives such as SQL Server data-
base mirroring. For more information, see Always On Failover Cluster Instances (SQL Server).

+ SQL Server database mirroring

Database mirroring ensures that an automatic failover occurs in seconds if the active database
serverfails. This solutionis more expensive than the other two solutions because full SQL Server
licenses are required on each database server. You cannot use the SQL Server Express edition
in a mirrored environment. For more information, see Database Mirroring (SQL Server).

Methods for configuring Session Recording with database high availability

To configure Session Recording with database high availability, do either of the following:

+ Install the Session Recording Server components first and then configure database high avail-
ability for the created databases.
You can install the Session Recording Administration components with databases configured to
be installed on the prepared SQL Server instance. Then, configure database high availability for
the created databases.

- For Always On availability groups and clustering, you must manually change the SQL
Server instance name to the name of the availability group listener or SQL Server network
inHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\SmAudDatabaselnstance.

- For database mirroring, you must manually add the failover partners for databases in
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\DatabaseFailoverPartner
and HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\LoggingDatabaseFailoverPartnel

+ Configure database high availability for empty databases first and then install the Session
Recording Administration components.
You can create two empty databases as the Session Recording Database and the Administrator
Logging Database in the expected primary SQL Server instance and configure high availability.
Then enter the SQL Server instance name when installing the Session Recording Server
components:

- TousetheAlways On availability groups solution, enter the name of your availability group
listener.
- To use the database mirroring solution, enter the name of your principal SQL Server.
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- To use the clustering solution, enter the network name of your SQL Server.

Load balancing

June 10, 2021

Session Recording supports load balancing across Session Recording Servers. This article summa-
rizes the load balancing configuration using the Citrix ADC as an example. For more information, see
Configure load balancing in an existing deployment and Deploy and load-balance Session Recording
in Azure.

You can synchronize load balancing configurations among all Session Recording Servers.
Note:

The load balancing feature requires Version 7.16 or later of the Session Recording Server and
Session Recording Agent.

Changes to Session Recording in support of load balancing:

+ All Session Recording Servers share one folder to store recording files.

+ All Session Recording Servers share one Session Recording Database.

+ (Recommended) Install only one Session Recording Policy Console and all Session Recording
Servers share this Console.

Configure load balancing

To use this feature, perform the following steps on Citrix ADC and on the various Session Recording
components:

Configure load balancing (Citrix ADC part)

Configure load balancing servers Add the Session Recording Servers to the load balancing servers
in Citrix ADC.

Configure load balancing services

1. Add a load balancing service for each needed protocol on each Session Recording Server.
2. (Recommended) Select the relevant protocol monitor to bind each service monitor.
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Configure load balancing virtual servers

1. Create virtual servers with the same Citrix ADC VIP address based on the needed protocols and
bind the virtual servers to the relevant load balancing services.

2. Configure persistence on each virtual server.

3. (Recommended) Choose LEASTBANDWITH or LEASTPACKETS as the load balancing method
rather than the default method (LEASTCONNECTION).

4. Create a certificate to make the HTTPS virtual server UP.

Configure load balancing (Session Recording part)

On each server where you installed the Session Recording Server, do the following

1. (Recommended) Type the same Session Recording Database name during the Session Record-
ing Server installation.

2. If you choose the Administrator Logging feature, Citrix recommends that you type the same
Administrator Logging Database name when you install each Session Recording Server.

3. After sharing the Read/Write permission of the file storage folder with all Session Recording
Server machine accounts, change to use the file storage folder as the shared folder in Session
Recording Server Properties. For more information, see Specify where recordings are restored.

4. Addavaluetothe Session Recording Serverregistry key at HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\Smart/
Value name: EnableLB
Value data: 1 (DWORD, meaning enable)

5. If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager
message queue, create a host record for the Citrix ADC VIP address, add redirections in
C:\Windows\System32\msmq\Mapping\sample_map, and restart the Message Queuing
service.

The redirection is similar to:
<redirections xmlns="msmg-queue-redirections.xml">
<redirection>
<from>http:
<to>http:
</redirection>

<redirection>
<from>https:

<to>https:

</redirection>
</redirections>
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<!--NeedCopy-->

Where <ADCHost> is the created FQDN of the Citrix ADC VIP address, and <LocalFqdn> is the
FQDN of the local host.

6. (Recommended) After configuring one Session Recording Server registry, you can use the <Ses-
sion Recording Server installation path>\Scripts\SrServerConfigurationSync.ps1 script to
export configurations from this Server registry and import the registry to the other Session
Recording Server registries. You can also use the SrServerConfigurationSync.ps1 script to
add redirection mapping for message queuing.

a) On one Session Recording Server, after configuring the EnableLB registry value, start a
command prompt as an administrator and run the powershell.exe -file SrServerCon-
figurationSync.ps1 —Action Export,AddRedirection ~ADCHost <ADCHost> command,
where <ADCHost> is the created FQDN of the Citrix ADC VIP address.

b) Afterthe scriptruns, an exported registry file named SrServerConfig.regis generated and
an sr_lb_map.xmlfile is added to the C:\Windows\System32\msmq\Mapping path.

c) On other Session Recording Servers, copy SrServerConfig.reg generated in the preced-
ing step, start a command prompt as an administrator, and run the powershell.exe -
file SrServerConfigurationSync.psl —Action Import,AddRedirection ~ADCHost <AD-
CHost> command, where <ADCHost> is the created FQDN of the Citrix ADC VIP address.

d) After the script runs, the EnableLB value is added to the other Session Recording Server
registry keys and an sr_lb_map.xmlfileisadded to the C:\Windows\System32\msmq\Mapping
path.

On the machine where you installed the Session Recording Agent, do the following in Session
Recording Agent Properties

+ If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager mes-
sage queue, type the FQDN of the Citrix ADC VIP address in the Session Recording Server text
box.

« If you choose the default TCP protocol for the Session Recording Storage Manager message
queue, type the Citrix ADC VIP address in the Session Recording Server text box.

On the machine where you installed the Session Recording Player, do the following Add the
Citrix ADC VIP address or its FQDN as the connected Session Recording Server.

On the SQL Server where you installed the Session Recording Database, do the following Add
all the Session Recording Server machine accounts to the shared Session Recording Database and
assign them with the db_owner permission.
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Change your communication protocol

June 10, 2021

For security reasons, Citrix does not recommend using HTTP as a communication protocol. The
Session Recording installation is configured to use HTTPS. To use HTTP instead of HTTPS, you must
change several settings.

Use HTTP as the communication protocol

1. Logon to the machine hosting the Session Recording Server and disable secure connections for
Session Recording Broker in IIS.

2. Change the protocol setting from HTTPS to HTTP in Session Recording Agent Properties on
each server where the Session Recording Agent is installed:

a)

b) From the Start menu, choose Session Recording Agent Properties.
c) In Session Recording Agent Properties, choose the Connections tab.
d)

Log on to each server where the Session Recording Agent is installed.

In the Session Recording Broker area, select HTTP from the Protocol drop-down list and
click OK to accept the change. If you are prompted to restart the service, click Yes.

3. Change the protocol setting from HTTPS to HTTP in the Session Recording Player settings:

a) Logon to each workstation where the Session Recording Player is installed.

b) From the Start menu, choose Session Recording Player.

c) From the Session Recording Player menu bar, choose Tools > Options > Connections,
select the server, and choose Modify.

d) Select HTTP from the Protocol drop-down list and click OK twice to accept the change
and exit the dialog box.

4. Change the protocol setting from HTTPS to HTTP in the Session Recording Policy Console:

a) Logon to the server where the Session Recording Policy Console is installed.

b) From the Start menu, choose Session Recording Policy Console.

c) Select HTTP from the Protocol drop-down list and click OK to connect. If the connectionis
successful, this setting is remembered the next time you start the Session Recording Policy
Console.

Revert to HTTPS as the communication protocol

1. Logon to the machine hosting the Session Recording Server and enable secure connections for
the Session Recording Broker in IIS.
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2. Change the protocol setting from HTTP to HTTPS in Session Recording Agent Properties on
each server where the Session Recording Agent is installed:

a) Logon to each server where the Session Recording Agent is installed.
c) In Session Recording Agent Properties, choose the Connections tab.

)
b) From the Start menu, choose Session Recording Agent Properties.
)
d)

In the Session Recording Broker area, select HTTPS from the Protocol drop-down list
and click OK to accept the change. If you are prompted to restart the service, click Yes.

3. Change the protocol setting from HTTP to HTTPS in the Session Recording Player settings:

a) Log on to each workstation where the Session Recording Player is installed.

b) From the Start menu, choose Session Recording Player.

c) From the Session Recording Player menu bar, choose Tools > Options > Connections,
select the server, and choose Modify.

d) Select HTTPS from the Protocol drop-down list and click OK twice to accept the change
and exit the dialog box.

4. Change the protocol setting from HTTP to HTTPS in the Session Recording Policy Console:

a) Logon to the server where the Session Recording Policy Console is installed.

b) From the Start menu, choose Session Recording Policy Console.

c) Select HTTPS from the Protocol drop-down list and click OK to connect. If the connection
is successful, this setting is remembered the next time you start the Session Recording
Policy Console.

Configure Citrix Customer Experience Improvement Program (CEIP)

March 21, 2024

When you participate in the Citrix Customer Experience Improvement Program (CEIP), anonymous
configuration and usage data is collected and sent to Citrix to help improve the product quality and
performance. In addition, a copy of the anonymous data is sent to Google Analytics (GA) for fast and
efficient analysis.

Settings
CEIP setting

By default, you automatically participate in CEIP when you install Session Recording. The first upload
of data occurs approximately seven days after you install Session Recording. To unsubscribe from
CEIP, do the following:
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[y

. Log on to the machine hosting the Session Recording Server.

2. From the Start menu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the CEIP tab.

4. Clear the Participate in the Customer Experience Improvement Program check box.

5. Restart the Citrix Session Recording Analytics Service to make the setting take effect.

iEE] Zession Recording Server Properties — >

Storage  Signing  Follower Plavback  Motiications CEIP Logging  RBAC

Thiz option allows wou to make the product better by joining the Custamer
Expenence Improvement Program. Leamn more

Participate in the Cuztomer Experience Improvement Program.

Cancel Aoy

GA setting

When GA is enabled, the heartbeat data between GA and the Session Recording Server is collected
every 5 hours.

Registry setting that enables or disables GA (default = 0):
Location: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\
Name: CeipHeartBeatDisable

Value: 1 =disabled, 0 = enabled
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When unspecified, GA is enabled.
To disable GA:

1. Log on to the machine hosting the Session Recording Server.

2. Open the Registry Editor.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\.

4. Add aregistry value and name it CeipHeartBeatDisable.

5. Set the value data of CeipHeartBeatDisable to 1.

6. Restart the Citrix Session Recording Analytics Service to make the setting take effect.

Data collected from the Session Recording Server

The following table gives an example of the types of anonymous information collected. The data does

not contain any details that identify you as a customer.

Data Point

Machine GUID

Operating System version

Session Recording Server
version

Number of application
recordings

Key Name

machine_guid

OS_version

SRS_version

application-recording-number

Description

Identifying the machine where
the data originates. When GA is
enabled, the heartbeat data is
sent to GA regardless of

whether CEIP is enabled.
Text string denoting the

machine’s operating system.
When GA is enabled, the
heartbeat data is sent to GA
regardless of whether CEIP is

enabled.

Text string denoting the
installed version of the Session
Recording Server. When GA is
enabled, the heartbeat data is
sent to GA regardless of
whether CEIP is enabled.
Integer denoting the number of
application recording files. The
data is sent when both GA and
CEIP are enabled.
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Data Point

Number of recordings

Number of dynamic recordings

Number of agents hosting
recorded sessions

Number of agents hosting
recorded sessions containing
logged events

Number of recordings

containing logged events

Administrator logging
enablement

Number of logged events

Number of custom policies

Key Name

recording-number

dynamic-recording-number

recorded-agent-number

event-logging-enabled-agent-
number

event-logging-recording-
number

admin-logging-status

collected-events-number

customized-policies-number

Description

Integer denoting the number of
both application and desktop
recording files. The data is sent
when both GA and CEIP are
enabled.

Integer denoting the number of
dynamically recorded files. The
data is sent when both GA and
CEIP are enabled.

Integer denoting the number of
VDAs hosting recorded sessions.
The data is sent when both GA
and CEIP are enabled.

Integer denoting the number of
VDAs hosting recorded sessions
that contain logged events. The
data is sent when both GA and
CEIP are enabled.

Integer denoting the number of
recording files that contain
logged events. The data is sent
when both GA and CEIP are
enabled.

Digit indicating the enablement
of administrator logging. “1”
means enabled. “0”means
disabled. The data is sent when
both GA and CEIP are enabled.
Integer denoting the number of
logged events. The data is sent
when both GA and CEIP are
enabled.

Integer denoting the number of
custom session recording and
event logging policies. The
data is sent when both GA and
CEIP are enabled.
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Data Point Key Name Description

Load balancing enablement load-balancing-status Digit indicating the
enablement of load balancing.
“1”’means enabled. “0”means
disabled. The data is sent when
both GA and CEIP are enabled.

Recording viewing policy rbac-status Digit indicating the enablement

enablement of recording viewing policies.
“1”’means enabled. “0”means
disabled. The data is sent when
both GA and CEIP are enabled.

Log events

June 10, 2021

Session Recording can log events and tag events in recordings for later search and playback. You can
search for events of interest from large amounts of recordings and locate the events during playback
in the Session Recording Player.

System-defined events

Session Recording can log the following system-defined events:

+ Insertion of USB mass storage devices

« Application starts and ends

« File renaming, creation, deletion, and moving operations
+ Web browsing activities

« Top-most window activities

+ Clipboard activities

Insertion of USB mass storage devices

Session Recording can log the insertion of a Client Drive Mapping (CDM) mapped or generic redirected
USB mass storage device in a client where Citrix Workspace app for Windows or for Mac is installed.
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Session Recording tags these events in the recording.
Note:

Currently, only the insertion of USB mass storage devices (USB Class 08) can be logged. To make
the feature work as expected, upgrade the Session Recording Administration components and
the Session Recording Agent to Version 1811 or later. For more information, see Event logging
policies.

Application starts and ends

Note:

This feature requires Session Recording Version 1811 or later. For more information, see Event
logging policies.

Session Recording supports logging of both application starts and ends. When you add a process to
the App monitoring list, apps driven by the added process and its child processes are monitored.
Child processes of a parent process that starts before Session Recording runs can also be captured.

Session Recording adds the process names, cmd.exe, powershell.exe, and wsl.exe, to the
App monitoring list by default. If you select Log app start events and Log app end events for an
event logging policy, the starts and ends of the Command Prompt, PowerShell, and Windows Subsys-
tem for Linux (WSL) apps are logged regardless of whether you manually add their process names to
the App monitoring list. The default process names are not visible on the App monitoring list.

In addition, Session Recording provides a full command line for each app start event logged.
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Fle Edit View Flay Tools Help

| b O @“’3" A | Search: = Anytime - 5 Advanced Search...

Workspace »

=8 Workspace - administrator
| Search Results

(] Favorites
Now Playing X
User: administrator ~
Domain: LEEwA

Applicabionc Desktop
Delivery Group: T5YDAZ
VYDAMachine: AWTSYDA-OO02

Site: BYT_DB
Status; Complete
Start 9414/2020 1:57 AM ¥
Events and Bookmarks x
) 1:58:36 &M App End: 8976 chrome -

¥ 1:58:36 &M &pp End: 9164 chrome

) 1:58:36 AM &pp End; 10008 software_reporter_tool

) 1:58:36 AM &pp End: 9920: software_reporter_tool

3 1:58:36 AM App End: 9900; software_reporter_tool

) 1:58:36 AM &pp End; 10164: software_reporter_tool

¥ 1:58:36 &M &pp End: 8760 chrome

3 1:58:36 &M App End: 8680: chrome

) 1:58:37 &M App Start 5080: conhost: 8416 Y7P\CNwindowshaystem3Zhconhost. exe Oxd

) 1:58:37 &M App Start 8416 cmd: 8092; "C:AWindows \system32hemd. exe’

) ;5858 AM App Start: 3980; cmd: 2416 cmd -help

3 1:59.34 &M App Start 7260 MessageQueuingT ool 99800 C:\UsershAdministrator LKEWAAD eskiopsMessageQueuingT ool exe
3 1:5%:42 AM App End: 7260: MeszageluesuingT ool

) 200:34 AW App Start 9144: Consoledpplication?: 9980 C:\Consoledpplication0.exe

) 200:49 &AM App End: 9144 Consoletpplication]
L} AM App 4: PINI in

) 201:30 A App End: 9544 PING
) 2:01:43 AW App Start 9560 chrome: 9980; "'C:\Program Files (x86)4Googlet\Chrome\bpplicationtchrome. sxe"

() 2:01:44 AM  App Start: 1392 chrome: 9560: "C:MProgram Files [#BE]\Google\ChromeApplicationschrome.exe” -type=renderer -figld-tial-handle=1540,5975 ..
(3 2:01:44 AM  App Start 2644: chrome: 9560 "C:MProgram Files [#86)\Gooale\Chrome\Applicationschrome.exe” -twpe=renderer -figld-tial-handle=1540,5975...
() 2:01:44 AWM App Start: 2256: chrome: 9560: "C:\Program Files [x86]\Google’\ChromehApplicationschrome. exe’ -tppe=utility --utility-sub-type=storage. mojom. ..
(3 2:01:44 AM  App Stat 1416: chrome: 9560: "T:\Program Files (#8685 ooglet Chrometdpplicationtchrome. exe’’ -type=utility --utilitp-sub-type=network. majom...
(2 2:01:44 AM  App Start: 10172 chrome: 9560; "C:\Program Files [#86)GooglesChromesapplicationchrome. exe” -type=apu-process -field-tial-handle=1540, .
() 2:01:44 AM  App Start: 10048: chrome: 9560: "C:\Program Files [x86]\Google’\ChromehApplicationschrome. exe’ -type=crazhpad-handler --uzer-data-dir=C:4 .
(3 2:01:44 AM  App Start 8980 chrome: 9560: "C:MProgram Files [#26)\Google\Chrome\Applicationschrome.exe” --type=renderer -field-tial-handle=1540,5975.. o

aidu. com -+

End of file

File renaming, creation, deletion, and moving operations

Session Recording can log file or subfolder renaming, creation, deletion, and moving operations in
target folders, and tag the eventsin the recording. For more information, see Event logging policies.

Note:

This feature requires Session Recording Version 1903 or later.
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Web browsing activities

You can log user activities on supported browsers and tag the events in the recording. The browser
name, URL, and page title are logged. For an example, see the following screen capture.

Events and Bookmarks

Ak wieb browsing https: 4 fwww, google.com, Google - Google Chrome, chrome

When you move your cursor away from a webpage that has focus, your browsing of this webpage is
tagged without showing the browser name. This feature can be used to estimate how long a user stays
on a webpage. For an example, see the following screen capture.

Events and Bookmarks

3 301:43 M web browsing: hitps: /v facebook. com, Facebook - Log In or Sign Up - Google Chrome, chrome
3 30200 &M ‘Web browsing: https:/ A facebook. com, Facebook - Log In or Sign Up - Google Chiome E

List of supported browsers:

Browser Version

Chrome 69 and later

Internet Explorer 11

Firefox 61 and later
Note:

This feature requires Session Recording Version 1906 or later. For more information, see Event
logging policies.

Top-most window activities

Session Recording can log top-most window activities and tag the eventsin the recording. The process
name, title, and process number are logged.
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Events and Bookmarks b4

) 1:56:08 AM Top-most window: EXCEL, Book2, 2S00

() 1:56:22 4k Top-most window: explarer, CITRIXINSTALLATIONLOGS, 7212
% 1:56:36 AM Top-most window: Taskmgr, CdiSve.exe, 9276

3 1:56:39 AM  Top-most window: explorer, Application.evts, 7212

3 1:56:55 &M Top-most window: notepad++, . 4340

(r 1:56:59 &AM Top-most window: explorer, Deskiop, 7212

) 1:57:08 A Top-most window: WINWORD, Bisjisbb | docx, 8296

(2 1:5713AM Top-most window: notepad++, , 4940

(2 1:57:20 &AM Top-most window: Taskmar, CdiSve.exe, 9275

(3 1:57:34 &M  Top-most window: Taskmar, CiixAuthentication. VitualSmartzard. exe, 9276
(% 1:57:51 &M  Top-most window: regedit, FileOperationtonitorList, G584

3 1:58:04 AM Top-most window: notepad++, shi, 4940

3 1:55:25 &AM Top-most window: explorer, Task Switcher, 7212

(3 1:55:26 &AM Top-most window: EXCEL, Grid, G350

Clipboard activities

Session Recording can log copy operations of text, images, and files using the clipboard. The process
name and file path are logged for a file copy. The process name and title are logged for a text copy.
The process name is logged for an image copy.

Note: Content of copied text is not logged by default. To log text content, go to the Session
Recording Agent and set HKEY_LOCAL_MACHINE\SOFTWARE\ Citrix\SmartAuditor\
Agent\CaptureClipboardContent to 1(the default value is 0).

@ Session Recording Player g %

User Name Appication Satus Star Tene: Dumbon  Delvery Group VDA Machire
B scmnisrotor Deskiop. Complete 11717200 427AM 002744 DG_TSVDA EBSDK-TSVDA- 1579KB

Del rour DG_T5V04

VDA Machine:  EBSDK-TSVDAT
Site: BVT_DB

Status Camplete

Stait 11772020 427 AW
Login 111772020 4:27 AW

End. 1772020 455 4M
Duration onz7a

Sessiort ICALEPH0

me:  NEGWLINLINKDT

ress 101571376

Events and Bookmarks x
© 43822 AM_Dipbosid Opstation: Fie, explores, CUsers\Adiisuslor
© 250 AM ad

€ 45353 AM Cipboard Operstor: Simap, expiorer

[T

(<] ] © oo
b Size 1573KE © 43822 2M File explorer. Csers\Adminisirator EBSDKIDeskiop! =

11/17/2020 4:39:30 AM
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Custom events

The Session Recording Agent provides the IUserApi COM interface that third-party applications can

use to add application-specific event data into recorded sessions. Based on the event customiza-

tion, Session Recording can block sensitive information and log the session pause and session resume

events accordingly.

Sensitive information blocking

Session Recording lets you skip certain periods when recording the screen and blocks sensitive infor-

mation in these periods during session playback. To use this feature, use Session Recording 2012 and

5 Session Recording Player - o x
Fle Edt View Flay Toos Help
&=, 1@ [T |5 | Seach - Anytime - (4 [ |[E] Advanced Search
Workspace X || Search Results x
=) Wﬂf‘gslﬂaﬂhé ;d":“"istmf User Name Application Status Stat Tme: Durstion  Delivery Group VDA Machine Size ~
j F:j:;“:s” . B administrator Desktop Complete  11/17/2020309AM  D0:00:46  TSClient AWTSVDAD00T 10,422 KB
B sdministrator Desktop Complets  11/17/2020 306 AM 000241 TSClient AWTSVDA-G0D1 10,428 KB
B scministrator Desktop Complets  11/17/2020 303 AM 000330 TSClent AWTSVDA-G0D1 6,064 KB
B scministrator Desktop Complets  11/16/2020 409 AM  D0-19:27  TSClient AWTSVDA-I0D1 11,940 KB
E scmiristrator Desktop Complets  11/16/2020221 AM  D006:35  TSClient AWTSVDA-00D1 40057 KB

LI administrator

Events and Bookmarks

x

© 30655 AWM Motepads++Sensitive content detecte.
) 30851 AM  Motepad++Sensitive content detecte

10| |||

[> Size: 10.428 KB

Desktop

Complete

11/16/2020 217 AM

Sensitive content detected

M Notepad++ Sensitive content detected::

00.02:42

T5Client

Content blocked

AWTSVDA-0001

4409 KB

11/17/2020 3:07:13 AM

Playing

To use this feature, complete the following steps:

1. In Session Recording Agent Properties, select the Allow third party applications to record

custom data on this VDA machine check box and click Apply.
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[% Session Recerding Agent Properties — >
Recording  Connections

Session recording

Select this option to enable policy-based session recording on this VDA

machine. If this option is not selected, session recording is disabled on
this machine.

Enable session recording for this VDA machine

Custom evert reconding

Select this option to allow third party applications to inject custom data

into the recorded session while recording is in progress. This data is
available during playback.

Allorw third party applications to record custom data on this VDA
machine

Carcel | | donly

2. Grant users permission to invoke the Session Recording Event API (IUserApi COM interface).

Session Recording added access control to the event API COM interface in version 7.15. Only au-
thorized users are allowed to invoke the functionality to insert event metadata into a recording.

Local administrators are granted with this permission by default. To grant other users this per-
mission, use the Windows DCOM configuration tool:

a) Open the Windows DCOM configuration tool on the Session Recording Agent by running
dcomcnfg.exe.
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Recording ..

& & & &

=

CMLUAUTIL CMSTPLUA Color
Management
B B D
= Run x

Type the hame of a program, folder, document, or Internet
resource|and Windows will open it for you.

| —
Open: I‘ decomenfg.exel |

hd |

& This tosk will be cre

ated with administrative privileges.

Cancel Browse...

COM+ Event ComEvents...

System

&

CheAudioC...

&

DevicesFle...

&

EditicnUpg...

&

CheVideoC...

&

DfsShix.dll

&

Elevated
System S...

“omponent Services - [m] X
%. File Action View Window Help - &%
o=@ XEE @
[(] Console Root Activation Addte  AgentConf.. ahadmin AP Client  Application  Application Application.. AppReadin.. Actions
v & c‘_omponentg,emce; Manage.. Windows .. HxHelpPan... Activatio.. Frame Host Service e N
~ ] Computers
v 8 My Computer F &« &« 4 § ¥ &« & & More Acons >
» [ COM+ Applicatio|| Appvclient appwizcpl Authentica.. Authentica.. Authentica.. Authentica. AuthHost AvailableN..  AxinstSv
> | DCOM Config Ul CredUl... UlCredUl.. UlCredUl.. UlTerminal...
> 3 Rum-m Processt
| ¥ & % & & & & & &
> ,E Event Viewer (Lofal) Background Bitmap BrowserBr... CdfSve  CFmlfsEng... Citrix Agent  Citrix EUEM Citrix Citrix
> & Services (Local) Intelligent... Image host COM Server ImeMsgFer.. LogonCs.
Citrix Session Citrix.Dme.... CitrixCseEn... CitrixSpeex... CitrixSpeex.. Cloud CloudExper... CloudExper... CloudStor...

Change W... Broker ApplD Create Syst...

& & &

ComEvents... Connected COpenCo...
User Store
ChovideoC..  CustReg  DataExcha...
Class

& & &

DictationH... Dockinterfa... DsmAdmi...
Class COM server

Elevated-U... EmailClient Enhanceds..

Explorer Fa... Class

&

&

DEFRAGSVC
service

&

&

EntAppSvc

CortanaExp...

DVCRender...

Right-click Citrix Session Recording Agent and choose Properties.
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3

S & & @

Citrix Session | Citrie.Drnec.... CitrixCseEn... CitrixSpeex.. CitrixSpeex...

(

Service Mame: CitreeSmAud Agent

Leam maore about getting these properdies.

Cancel Aooly

Recording ... Cha
=Y £ Y m
Citrix Session Recording Agent Properties ? x
General |ocation Secuity Endpoints  Identity

General properties of this DCOM application
Application Mame:  Citrie Session Recording Agert
Application |D: {07chic101-d1ac-442%be 2e-bech 7oe 98012}
Application Type: Local Service
Authentication Level: | Default v

c) Select the Security tab, click Edit to add users with Local Activation permission in the

Launch and Activation Permissions section.
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e
Launch and Activation Permission > CustReg
Class
Securty
(Group or user names: a’
SR SYSTEM . Dockinterfa.
a Administrator COM serve
a Administrator (AW TSVDA-D001 Administrator) i
EmailClieni
Clazss
Add... Remove
1. | 7.
Select Users, Computers, Service Accounts, or Groups >
Select this object type:
|Users. Groups, or Built-n securty principals | | Ohject Types... |
From this location:
|b'u't.lncal | | Locations... |
Enter the object names to select (2xamples):
| Check Mames
R [ e
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Launch and Activation Permission ? >

Securty

GI’DIJP ar User names:

HR SYSTEM
a Administrator

A

Administrat LA

l guoxiangzh (UQYEB \guomdang

Add.. Remove
Permissions for guoxianagzh Allow Dermy
Local Launch ] ]
Remate Launch ] ]
| Local Activation M O
Remoate Activation L] ]

Cancs

Note:

DCOM configuration takes effect immediately. There is no need to restart any services or
the machine.

3. Start a Citrix virtual session.

Start PowerShell and change the current drive to the <Session Recording Agent installation
path>\Bin folder to import the SRUserEventHelperSnapin.dll module.

Run the Session-Pause and Session-Resume cmdlets to set parameters for triggering
sensitive information blocking.

Parameter Description Required or Optional
-APP The app name that calls the Required
cmdlet.
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Parameter Description Required or Optional

-Reason The reason that content is Optional
blocked. If you leave this
parameter unspecified, the
default setting shows, stating
Content Blocked and
Sensitive information exists
and is blocked. If you set this
parameter, the reason you
specify shows when you
navigate to the blocked period
during session playback.

For example, you can run Session-Pause similar to the following:

EN Select Administrator: PowerShell — O X

\Bin> man 5 ion-Pause

<CommonParamet

\Bin> Session-Pause pp Motepad++

Search for and play back recordings with tagged events
Search for recordings with tagged events

The Session Recording Player allows you to perform advanced searches for recordings with tagged

events.
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1. In the Session Recording Player, click Advanced Search on the tool bar or choose Tools > Ad-
vanced Search.
2. Define your search criteria in the Advanced Search dialog box.

The Events tab allows you to search for tagged events in sessions by Event text or Event type or
both. You can use the Events, Common, Data/Time, and Other filters in combination to search for
recordings that meet your criteria.

Advanced Search e
Saved Searches. .. Save As.. Reset Values
Search Criteria
Common Date/Time Events Other
Citrix-defined events and events inserted by third-party applications can be tagged while a session is being recorded. To search for
recordings with target events tagged, set the search criteria below.
Event text: | |
Event type: | |v
Citrix. Event Monitor. AppEnd
Citrix.Evert Monitor App Start
Citrix. Event Monitor COMUSBDrive Attach
Citrix. Event Monitor Clipboard
Citrix. Event Monitor FileCreate
Citrix. Event Monitor File Delete
Citrix. Event Monitor. File Move
Citrix. Event Monitor File Rename
Citrix. Event Monitor GenericlU 5B Drive Attach
Query Builder Citrix. Event Monitor. Top Most
Citrix. Event Monitor. Web Browsing
Find the 200 most relevant serfpi. SessionPause
Citrix. UserApi SessionResume
Any Citrin-defined event
Note:

« The Event type list itemizes all event types that have been logged by Citrix Session Record-
ing. You canselectany one of the event types to search. Selecting Any Citrix-defined event
means to search for all recordings with any type of events logged by Citrix Session Record-
ing.

« The Event text filter supports partial match. Wildcards are not supported.

+ The Event text filter is case-insensitive when matching.

« For the types of events, the words App Start, App End, Client drive mapping,
and File Rename do not participate in matching when you search by Event text.
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Therefore, when you type App Start, App End, Client drive mapping, or
File Rename inthe Event text box, no result can be found.

Play back recordings with tagged events

When you play back a recording with events tagged, the events are present in the Events and Book-
marks panel and show as yellow dots in the lower part of the Session Recording Player:

(9 Session Recording Player - O X
Fle Edt \View Pay Tools Help
& | b O @[E]d | » | Seach: - Antime - (4 (% | [ Advanced Search...
Workspace X || Search Results x
=] WD“;SWC: ;dmn‘"'stfa‘w User Name Application Start Time Durstion  Delivery Group VDA Machine ~
j i I=] adniristrator AWTSVDA-0001

Bl administretor Desktop Complete 00:1654  TSClent AWTSVDADOD1 3,333 KB

B administretor Desktop Complete  11/17/2020346 AM 001835 TSClent AWTSVDAD0D1 3834 KB

B administrator Desktop Complete  11/17/20203710AM 000042  TSClent AWTSVDAD0D1 6.731 KB

B administrator Desktop Complete  11/17/2020310AM 000046  TSClent AWTSVDAD001 10,306 KB

Bl administrator Desktop Complete  11/17/2020 3:09AM __ 00.00:46 _ TSClient AWTSVDADOD! 10.422 KB v
Events and Bookmarks x

© 42813 &M Topmost window; ipeonfia, C:\Wind
© 42614 4M Topmost window: Bginfo, , 1372

© 42619 AM  Topmest window: Configuratioriv/iz.
© 42821 AW Topmest window: explorer, , 2472

© 42623 AM  Topmost window: powsishel, Admi
© 42515 8M  Natepads+Sensiive content detecte
© 43041 AW Natepads+Sensiive content detecte
© 43045 AW Topmost window: WiShel, CtxDnD.
© 43047 AW Top-mast windaw: explorer, , 2472

MiFEs +0h0 i SRS | 0h03m +Dho4m +0h35m
[> UQYEB 11/17/2020 4:28:11 AM

Playing

You can use events to navigate through a recorded session, or skip to the points where the events are
tagged.

View recordings

June 10, 2021

Use the Session Recording Player to view, search, and bookmark recorded Citrix Virtual Apps and
Desktops sessions.

If sessions are recorded with the live playback feature enabled, you can view sessions that are in
progress, with a delay of 1-2 seconds.

Sessions that have a longer duration or larger file size than the limits configured by your Session
Recording administrator appear in more than one session file.
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Note:

A Session Recording administrator must grant users the right to access the recorded sessions of
VDAs. If you are denied access to viewing sessions, contact your Session Recording administrator.

When the Session Recording Player is installed, the Session Recording administrator typically setsup a
connection between the Session Recording Player and a Session Recording Server. If this connection
is not set up, the first time you perform a search for files, you are prompted to set it up. Contact your
Session Recording administrator for setup information.

Launch the Session Recording Player

June 10, 2021

Launch the Session Recording Player

Note:

« If a recording contains blocked content, Session Recording skips it. However, if you navi-
gate to the blocked period, your playback shows a black screen and a message indicating
that that content is blocked. To use this feature, use Session Recording 2012 and later.

+ If you are using the Session Recording Player 2009 and earlier to play back a recording, the
following error message appears. The web player is not impacted.

Errcr Playing File *

The recorded session file requires a newer version of the
Session Recording Player for playback,

1. Log on to the workstation where the Session Recording Player is installed.

2. From the Start menu, choose Session Recording Player. The Session Recording Player ap-
pears.
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(&8 Session Recording Player - [m] ®
Fle Edt View Play Toos Help

=, ] @ e[| |3 | Search ~ Anyiime - 4 [ Advanced Search
Workspace % || Search Results X
{31 Workspace - administrator User Name Application Status Start Time Durstion  Delivery Group VDA Machine Size ~
Search Result
B Seuch Rents sininistte

B administrator Desktop Complete  11/17/2020 4:06 AM TSClient AWTSVDA-0001 3.333KB
Ef administrator Desktop Complete  11/17/2020 3:46 AM : TSClient AWTSVDA-D001 3,834 KB
Ef administrator Desktop Complete  11/17/2020 3:10 AM TSClient AWTSVDA-0001 6,731 KB
Ef administrator Deskiop Complete  11/17/2020 3:10 AM 2 TSClient AWTSVDA-DOO1 10.306 KB
B administrator Desktop Complete  11/17/2020 3:09 AM 00:00:46  TSClient AWTSVDA-0001 10.422 KB

Events and Bookmarks X

© 4:28:13 AM  Top-most windaw: ipconfig, C:4wind.
© 4:28:14AM Topmast window: Bginfo, , 1372

© 42819 AM  Top-mast window: Configuration'iz.
© 4:26:21 &AM Top-most window: explarer, , 2472

© 428:29 M Topmast window: powershell, Admi
O 42315 AW Motepad++Sensitive content detecte.
© 430:41 AW MNotepad++Sensiive content detecte.
© 430045 AW Top-most window: "WiShell, CtsDnD..
© 4:30:47 AM Top-most window: explorer, , 2472

hd4m +Dhdsm

> UQYEB 11/17/2020 4:28:11 AM

Playing

To show all recording files of a recorded session, right-click a recording on the list and choose

Fle Edt View Play Tools Help
=20 Ak | : Search ~ Anytime -9 { Advanced Search
Workspace X || Search Results
(&5 Workspace - administrator User Name Application Status Start Time Duration Delivery Group VDA Machine Size
& Search Results 5/12/2020 8 00:00-46 AWTSVDA
Favorites B administrator Desktop Complete 12/13/2020 851 PM_ 00.0046  TSClient AWTSVDA-0001
! -] adminigtra < 12/13/2020 8551 PM
B admini p Complete  12/13/2020 8:50 PM TSClient AWTSVDA-0001 11786 KB
o adrwm Complete  12/13/2020 8:49 PM TSClient AWTSVDA-0001 10,456 KB
Now Playing X

admiristrator ~ Copyto Folder

Applicaior  Desktop ¥| Properties
Delivery Group: TSClient
VDA Machine:  AWTSVDA-0001

Site: BVT_DB
Status: Complete:
Start 12/13/2020 8:50 PM v
Events and Bookmarks X
(AR
Desktop

End of file

Display or hide window elements

The Session Recording Player has window elements that toggle on and off.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
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3. From the Session Recording Player menu bar, choose View.
4. Choose the elements that you want to display. Selecting an element causes it to appear imme-
diately. A check mark indicates that the element is selected.

Connect to the desired Session Recording Server

If the Session Recording administrator sets up your Session Recording Player with the ability to con-
nect to multiple Session Recording Servers, you can select the Session Recording Server that your
Session Recording Player connects to. The Session Recording Player can connect to only one Session
Recording Server at a time.

Log on to the workstation where the Session Recording Player is installed.
From the Start menu, choose Session Recording Player.
From the Session Recording Player menu bar, choose Tools > Options > Connections.

> w e

Select the Session Recording Server to which you want to connect.

Enable or disable live session playback and playback protection

June 10, 2021

Enable or disable live session playback

If sessions are recorded with the live playback feature enabled, you can view a session after or while
it is being recorded. Viewing a session that is being recorded is similar to seeing actions happening
live. However, there is actually a delay of 1-2 seconds when the data propagates from the VDA.

Some functionality is not available when you view sessions that are not recorded completely:

+ Adigital signature cannot be assigned until recording is complete. If digital signing is enabled,
you can view live playback sessions. But they are not digitally signed and you cannot view the
certificates until the session is completed.

+ Playback protection cannot be applied until recording is complete. If playback protection is
enabled, you can view live playback sessions. But they are not encrypted until the session is
completed.

+ You cannot cache a file until recording is complete.

By default, live session playback is enabled.

1. Logon to the computer hosting the Session Recording Server.
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2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Playback tab.
4. Select or clear the Allow live session playback check box.

Enable or disable playback protection

As a security precaution, Session Recording automatically encrypts recorded files that are down-
loaded for viewing in the Session Recording Player. This playback protection prevents recorded files
from being copied and viewed by anyone other than the user who downloaded the file. The files
cannot be played back on another workstation or by another user. Encrypted files are identified
with an . icle extension. Unencrypted files are identified with an . i cl extension. The files remain
encrypted while they reside in %localAppData%\Citrix\SessionRecording\Player\
Cache on the Session Recording Player until an authorized user opens them.

We recommend that you use HTTPS to protect the transfer of data.

By default, playback protection is enabled.
. Log on to the machine hosting the Session Recording Server.
. From the Start menu, choose Session Recording Server Properties.

1

2

3. In Session Recording Server Properties, click the Playback tab.

4. Select or clear the Encrypt session recording files downloaded for playback check box.

Open and play recordings

June 10, 2021

Open recordings

You can open session recordings in the Session Recording Player in three ways:

+ Perform a search using the Session Recording Player. Recorded sessions that meet the search
criteria appear in the search results area.

« Access recorded session files directly from your local disk drive or a shared drive.

+ Access recorded session files from a Favorites folder.

When you open afile that was recorded without a digital signature, a warning message appears saying
that the origin and integrity of the file were not verified. If you are confident of the integrity of the file,
click Yes in the warning window to open the file.
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A check on the Citrix Workspace app version is conducted before the Session Recording Player plays
back arecordingfile. Ifthe Player does not support the version of the Citrix Workspace app that has the
file recorded, an error is returned. To eliminate the error, select Skip Citrix Workspace app version
check before playback in Session Recording Server Properties.

% Session Recording Server Properties — >

Storage Signing Rollover i Motifications CEIP  Logging RE*|*

Live session playback

This option permits the playback of session recordings while recording 1s
still in progress.

Allow live session playback

Playback protection

This option encrypts session recording files before download to the
Session Player. This prevents session recordings from being copied and
viewsd by users other than the user that originally downloaded the file.

Encrypt session recording files downloaded for playback

Citrix Workspace app version check

This option allows users to skip the Citrix Workspace app version check
before the Session Recording Player plays back a recording.

Skip Citrix Works pace app version check before playback

Concal | | osh

Note:

The Administrator Logging feature of Session Recording allows you to log the downloads of
recordings in the Session Recording Player. For more information, see Administrator Logging.
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Open a recording in the search results area

Log on to the machine where the Session Recording Player is installed.

From the Start menu, choose Session Recording Player.

Perform a search.

If the search results area is not visible, select Search Results in the Workspace pane.
In the search results area, select the session you want to play.

ok~ w N

Do any of the following:

» Double-click the session.
+ Right-click and select Play.
+ From the Session Recording Player menu bar, choose Play > Play.

Open a recording by accessing the file

The name of a recorded session file begins with i _, followed by a unique alphanumeric file ID and
then the .icl or .icle extension. The .icl extension denotes the recordings without playback
protection applied. The . cle extension denotes the recordings with playback protection applied.
Recorded session files are saved in a folder that incorporates the date the sessions were recorded.
For example, the file for a session recorded on December 22, 2014, is saved in the folder path
2014\12\22.

1. Logon to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Do any of the following:

« From the Session Recording Player menu bar, choose File> Open and browse for thefile.

« Using Windows Explorer, navigate to the file and drag the file to the Player window.

« Using Windows Explorer, navigate to and double-click the file.

« Ifyou created Favorites in the Workspace pane, select Favorites and open the file from the
Favorites area in the same way you open files from the search results area.

Use favorites

Creating the Favorites folders allows you to quickly access recordings that you view frequently. These
Favorites folders reference recorded session files that are stored on your workstation or on a network
drive. You can import and export these files to other workstations and share these folders with other
Session Recording Player users.
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Note:

Only users with access rights to the Session Recording Player can download the recorded session
files associated with the Favorites folders. Contact your Session Recording administrator for the
access rights.

To create a Favorites subfolder:

Log on to the workstation where the Session Recording Player is installed.

From the Start menu, choose Session Recording Player.

In the Session Recording Player window, select the Favorites folder in your Workspace pane.
From the menu bar, choose File > Folder > New Folder. A new folder appears under the Fa-

A

vorites folder.
5. Type the folder name, then press Enter or click anywhere to accept the new name.

Use the other options that appear in the File > Folder menu to delete, rename, move, copy, import,
and export the folders.

Play recordings

After you open a recorded session in the Session Recording Player, you can navigate through the
recorded sessions using these methods:

+ Use the player controls to play, stop, pause, and increase or decrease playback speed.
+ Use the seek slider to move forward or backward.

If you have inserted markers to the recording or if the recorded session contains custom events, you
can also navigate through the recorded session by going to those markers and events.

Note:

+ During playback of a recorded session, a second mouse pointer might appear. The second
pointer appears at the point in the recording when the user navigated within Internet Ex-
plorer and clicked an image that was originally larger than the screen but was scaled down
automatically by Internet Explorer. While only one pointer appears during the session, two
might appear during playback.

« This version of Session Recording does not support SpeedScreen Multimedia Acceleration
and the Flash quality adjustment policy setting. When this option is enabled, playback dis-
plays a black square.

« Whenyou record a session with aresolution higherthan orequal to 4096 x 4096, there might
be fragments in the recording appearance.
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Use the player controls

You can click the player controls in the lower part of the Player window or access them by choosing
Play from the Session Recording Player menu bar.

Player Control Function

Plays the selected session file.

Pauses playback.

@ Stops playback. If you click Stop, then Play, the
recording restarts at the beginning of the file.

4]

Halves the current playback speed down to a
minimum of one-quarter of the normal speed.

g |

Doubles the current playback speed up to a
maximum of 32 times the normal speed.

Use the seek slider

Use the seek slider in the lower part of the Player window to jump to a different position within the
recorded session. You can drag the seek slider to the point in the recording you want to view or click
anywhere on the slider bar to move to that location.

You can also use the following keyboard keys to control the seek slider:

Keyboard Key Function

Home Seeks to the beginning.

End Seeks to the end.

Right Arrow Seeks forward five seconds.
Left Arrow Seeks backward five seconds.
Move the mouse wheel one notch down Seeks forward 15 seconds.
Move the mouse wheel one notch up Seeks backward 15 seconds.
Ctrl + Right Arrow Seeks forward 30 seconds.
Ctrl + Left Arrow Seeks backward 30 seconds.
Page Down Seeks forward one minute.
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Keyboard Key Function

Page Up Seeks backward one minute.
Ctrl + Move the mouse wheel one notch down Seeks forward 90 seconds.
Ctrl + Move the mouse wheel one notch up Seeks backward 90 seconds.
Ctrl + Page Down Seeks forward six minutes.
Ctrl + Page Up Seeks backward six minutes.

To adjust the speed of the seek slider: From the Session Recording Player menu bar, choose Tools >
Options>Player and dragthe slider to increase or decrease the seek response time. A faster response
time requires more memory. The response might be slow depending on the size of the recordings and
your machine’s hardware.

Change the playback speed

You can set the Session Recording Player to play recorded sessions in exponential increments from
one-quarter normal playback speed to 32 times normal playback speed.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.

3. From the Session Recording Player menu bar, choose Play > Play Speed.
4. Choose a speed option.

The speed adjusts immediately. Text indicating the exponential rate appears briefly in green in the
lower part of the Player window.

Highlight the idle periods of recorded sessions

Idle periods of arecorded session are the portions in which no action takes place. The Session Record-
ing Player can highlight the idle periods of recorded sessions during playback. The option is On by
default. For more information, see Highlight idle periods.

Skip over spaces where no action occurred

Fast review mode allows you to set Session Recording Player to skip the portions of recorded sessions
in which no action takes place. This setting saves time for playback viewing. However, it does not
skip animated sequences such as animated mouse pointers, flashing cursors, or displayed clocks with
second hand movements.
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1. Logon to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Play > Fast Review Mode.

The option toggles on and off. Each time you choose it, its status appears briefly in green in the Player
window.

Change the playback display

Options allow you to change how recorded sessions appear in the Player window. You can pan and
scale the image, show the playback in full screen, display the Player window in a separate window,
and display a red border around the recorded session to differentiate it from the Player window back-
ground.

Display the Player window in full screen

1. Logon to the workstation where the Session Recording Player is installed.

2. From the Start menu, choose Session Recording Player.

3. From the Session Recording Player menu bar, choose View > Player Full Screen.
4. To return to the original size, press Esc or F11.

Display the Player window in a separate window

1. Log on to the workstation where the Session Recording Player is installed.

2. From the Start menu, choose Session Recording Player.

3. From the Session Recording Player menu bar, choose View > Player in Separate Window. A
new window appears, containing the Player window. You can drag and resize the window.

4. To embed the Player window in the main window, choose View > Player in Separate Window,
or press F10.

Scale the session playback to fit the Player window

1. Logon to the workstation where the Session Recording Player is installed.

2. From the Start menu, choose Session Recording Player.

3. From the Session Recording Player menu bar, choose Play > Panning and Scaling > Scale to
Fit.

+ Scale to Fit (Fast Rendering) shrinks images while providing good quality. Images are
drawn quicker than using the High Quality option but the images and texts are not sharp.
Use this option if you are experiencing performance issues when using the High Quality
mode.
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+ Scale to Fit (High Quality) shrinks images while providing high quality. Using this option
can cause the images to be drawn more slowly than the Fast Rendering option.

Pan the image

1. Logon to the workstation where the Session Recording Player is installed.

2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Play > Panning and Scaling > Panning.

The pointer changes to a hand. And a small representation of the screen appears in the top right
of the Player window.

4. Dragtheimage. The small representation indicates where you are in the image.

To stop panning, choose one of the scaling options.

Display a red border around Session Recording

> wnh

Log on to the workstation where the Session Recording Player is installed.

From the Start menu, choose Session Recording Player.

From the Session Recording Player menu bar, choose Tools > Options > Player.

Select the Show border around session recording check box.

If the Show border around session recording check box is not selected, you can temporarily
view the red border by clicking and holding down the left mouse button while the pointer is in
the Player window.

Highlight idle periods

June 10, 2021

Idle periods of a recorded session are the portions in which no action takes place. The Session Record-
ing Player can highlight the idle periods of recorded sessions during playback. The option is On by
default.

Note: Idle periods are not highlighted when playing back live sessions with the Session Recording

Player.

To highlight the idle periods of recorded sessions, do the following:

1. Log on to the workstation where the Session Recording Player is installed.

2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose View > Idle Periods and select or clear

the check box.
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Cache recordings

June 10, 2021

Each time you open a recorded session file, the Session Recording Player downloads the file from the
location where the recordings are stored. If you download the same files frequently, you can save
download time by caching the files on your workstation. Cached files are stored on your workstation
in this folder:

userprofile\AppData\Local\Citrix\SessionRecording\Player\Cache

You can specify how much disk space is used for the cache. When the recordings fill the specified disk
space, Session Recording deletes the oldest, least used recordings to make room for new recordings.
You can empty the cache at any time to free up disk space.

Enable caching

Log on to the workstation where the Session Recording Player is installed.

From the Start menu, choose Session Recording Player.

From the Session Recording Player menu bar, choose Tools > Options > Cache.

Select the Cache downloaded files on local machine check box.

To limit the amount of disk space used for caching, select the Limit amount of disk space to

ok wpn =

use check box and specify the number of MB to be used for cache.
6. Click OK.

Empty caches

Log on to the workstation where the Session Recording Player is installed.

From the Start menu, choose Session Recording Player.

From the Session Recording Player menu bar, choose Tools > Options > Cache.
Select the Cache downloaded files on local machine check box.

In the Session Recording Player, choose Tools > Options > Cache.

ok~ w N

Click Purge Cache and OK to confirm the action.

Use events and bookmarks

June 10, 2021
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You can use events and bookmarks to help you navigate through recorded sessions.

Citrix-defined events are inserted to sessions while the sessions are recorded. You can also use the
Event APl and a third-party application to insert custom events. Events are saved as part of the session
file. You cannot delete or alter them using the Session Recording Player.

Bookmarks are markers you insert in a recorded session during session playback using the Ses-
sion Recording Player. After insertion, bookmarks are associated with the recorded session until
you delete them. However, they are not saved as part of the session file but stored as sepa-
rate .ic’lb files in the Bookmarks cache folder on the Session Recording Player, for example,
C:\Users\SpecificUser\AppData\Local\Citrix\SessionRecording\Player\Bookmarks, with the same
file name as the . icl recording file. To play back a recording using bookmarks on a different Player,
copy the .1clb files to the Bookmarks cache folder on that Player. By default, each bookmark is
labeled with the text “Bookmark,”but you can change it to any text annotation up to 128 characters
long.

Events appear as yellow dots and bookmarks appear as blue squares in the lower part of the Player
window. Moving the mouse over the dots and squares displays the text label associated with them.
You can also display the events and bookmarks in the Events and Bookmarks list of the Session
Recording Player. They appear in this list with their text labels and the times in the recorded session
at which they appear, in chronological order.

You can use events and bookmarks to help you navigate through recorded sessions. By going to an
event or bookmark, you can skip to the pointin the recorded session where the event or bookmark is
inserted.

Display events and bookmarks in the list

The Events and Bookmarks list displays the events and bookmarks inserted in the recorded session
thatis currently playing. It can show events only, bookmarks only, or both.

1. Log on to the workstation where the Session Recording Player is installed.

2. From the Start menu, choose Session Recording Player.

3. Move the mouse pointer to the Events and Bookmarks list area and right-click to display the
menu.

4. Choose Show Events Only, Show Bookmarks Only, or Show All.

Insert a bookmark

1. Logon to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Begin playing the recorded session to which you want to add a bookmark.
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4,
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6.

Add

Move the seek slider to the position where you want to insert the bookmark.
Move the mouse pointer to the Player window area and right-click to display the menu.
Add a bookmark with the default Bookmark label or create an annotation:

» To add a bookmark with the default Bookmark label, choose Add Bookmark.

+ To add a bookmark with a descriptive text label that you create, choose Add Annotation.
Type the text label you want to assign to the bookmark, up to 128 characters. Click OK.

or change an annotation

After a bookmark is created, you can add an annotation to it or change its annotation.

Nk N

Log on to the workstation where the Session Recording Player is installed.
From the Start menu, choose Session Recording Player.

Begin playing the recorded session containing the bookmark.

Ensure that the Events and Bookmarks list is displaying bookmarks.

Choose Edit Annotation.
In the window that appears, type the new annotation and click OK.

Delete a bookmark

S T o

Log on to the workstation where the Session Recording Player is installed.
From the Start menu, choose Session Recording Player.

Begin playing the recorded session containing the bookmark.

Ensure that the Events and Bookmarks list is displaying bookmarks.

Choose Delete.

Go to an event or bookmark

Select the bookmark in the Events and Bookmarks list and right-click to display the menu.

Select the bookmark in the Events and Bookmarks list and right-click to display the menu.

Going to an event or bookmark causes the Session Recording Player to go to the pointin the recorded

sess
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ion where the event or bookmark is inserted.

. Log on to the workstation where the Session Recording Player is installed.
. From the Start menu, choose Session Recording Player.

. Begin playing a session recording containing events or bookmarks.

. Go to an event or bookmark:

+ In the lower part of the Player window, click the dot or square representing the event or

bookmark to go to the event or bookmark.
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« In the Events and Bookmarks list, double-click the event or bookmark to go to it. To go
to the next event or bookmark, select any event or bookmark from the list, right-click to
display the menu, and choose Seek to Bookmark.

Search for recordings

June 10, 2021

The Session Recording Player allows you to perform quick and advanced searches and to specify op-
tions that apply to all searches. Results of searches appear in the search results area of the Session
Recording Player.

Note:

To display all available recorded sessions, up to the maximum number of sessions that might
appear in a search, perform a search without specifying any search parameters.

Perform a quick search

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Define your search criteria:

« Enter a search criterion in the Search field.

« Move the mouse pointer over the Search label to display a list of parameters to use as a
guideline.

Click the arrow to the right of the Search field to display the text for the last 64 searches

you performed.
Use the drop-down list to the right of the Search field to select a period or duration speci-
fying when the session was recorded.

4. Click the binocular icon to the right of the drop-down list to start the search.

Perform an advanced search

Advanced searches might take up to 20 seconds to return results containing more than 150,000 enti-
ties. Citrix recommends using more accurate search conditions such as a date range or user to reduce
the result number.

1. Log on to the workstation where the Session Recording Player is installed.
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2. From the Start menu, choose Session Recording Player.

3. In the Session Recording Player window, click Advanced Search on the tool bar or choose
Tools > Advanced Search.

4. Define your search criteria on the tabs of the Advanced Search dialog box:

« Common allows you to search by domain or account authority, site, group, VDA for multi-
session OS, application, or file ID.

» Date/Time allows you to search date, day of week, and time of day.

« Events allows you to search for Citrix-defined and custom events that are inserted to the
sessions.

« Other allows you to search by session name, client name, client address, and recording
duration. It also allows you to specify, for this search, the maximum number of search
results displayed and whether archived files are included in the search.

When you specify search criteria, the query you are creating appears in the pane at the
bottom of the dialog box.

5. Click Search to start the search.

You can save and retrieve advanced search queries. Click Save in the Advanced Search dialog
box to save the current query. Click Open in the Advanced Search dialog box to retrieve a saved
query. Queries are saved as files with an . i sq extension.

Set search options

The Session Recording Player search options allow you to limit the maximum number of session
recordings that appear in search results and to specify whether search results include archived
session files.

Log on to the workstation where the Session Recording Player is installed.
From the Start menu, choose Session Recording Player.
From the Session Recording Player menu bar, choose Tools > Options > Search.

> wnh e

In the Maximum result to display field, type the number of search results you want to display.
A maximum of 500 results can be displayed.
5. To set whether archived files are included in searches, select or clear Include archived files.

Session Recording web player

July 9, 2021
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Overview

The web player lets you use a web browser to view and play back recordings. Using the web player,
you can:

+ Search for recordings by using filters, including host name, client name, user name, application,
client IP address, event text, event type, and time.

« View and play back both live and completed recordings with tagged events listed in the right
pane.

« configure cache memory for storing recordings while playing.
» Record idle events and highlight idle periods.
+ Leave comments about a recording and set comment severities.

+ Share URLs of recordings.

Note:

Supported browsers include Google Chrome, Microsoft Edge, and Firefox.

Enable the web player

The web player is enabled by default.

« To disable the web player, start a Windows command prompt and run the <Session
Recording Server -installation path>\Bin\SsRecUtils.exe —-disablewebplayer
command.

« To enable the web player, start a Windows command prompt and run the <Session
Recording Server -installation path>\Bin\SsRecUtils.exe -enablewebplayer
command.

Logon and password

The URL of the web player website is http(s)://<FQDN of Session Recording Server
>/WebPlayer. To ensure the use of HTTPS, add an SSL binding to the website in IIS and update
the SsRecWebSocketServer.config configuration file. For more information, see the HTTPS
configuration section in this article.

Note:
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When logging on to the web player website, domain users do not need to enter credentials while
non-domain users must.

Installation

Install the web player on the Session Recording Server only. Double-click SessionRecordingWeb-
Player.msi and follow the instructions to complete your installation. For more information about
installing Session Recording, see Install, upgrade, and uninstall.

Starting from Version 2103, Session Recording migrates the WebSocket server to IIS. With the web

player installed, the SessionRecordingRestApiService, SessionRecordingWebStreaming, and
WebPlayer applications appearin IIS.
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A fresh installation of Session Recording 2103 and later connects your web browser to the WebSocket
server hosted in IIS when you access the web player website. The WebSocket server hosted in IIS is

versioned 2.0, as indicated by the registry value WebSocketServerVersion under the registry key at
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
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[ Registry Editor — X
File Edit View Favorites Help

Computer\HKEY_LOCAL MACHINE\SOFTWARE\Citrix\SmartAuditor\Server
v | SOFTWARE A || Name Type Data A
7-Zip :ab| DatabaseFailoverPartner REG_SZ
Business Objects ab) DatabaseName REG_SZ CitrixSessionRecording2
v Citrix | DeferredHashCalcFileSizeThreshold REG_DWORD 0x00200000 (2097152)
Citrix Desktop Delivery Controller f| DormantTimelnHours REG_DWORD 0x00000030 (48)
InstallAgent 4| EnableAnalytics REG_DWORD 0x00000001 (1)
Metalnstall #5|EnableAzureSQL Service REG_DWORD 0x00000000 (0)
v B SmartAuditor § EnableRecordingActionLogging REG_DWORD 0x00000001 (1)
Server 4| EnableSRStoragelogging REG_DWORD 0x00000001 (1)
i::?:;i“’" 4| EnableWebBasedSrPlayer REG_DWORD 0x00000001 (1)
XenToolsInstaller linkEmail ReG.sz
YenToolsNetSettings a5 LinkExpire REG_SZ 1728000000000
Closses 28]LinkHost REG_SZ
Clents -""\LinkSalt REG_SZ kk20d974
DefaultUserEnvironment #LoggingBlockState REG_DWORD 0x00000000 (0)
dotnet 3"‘\Logg'\ngDatabaseFailoverPanner REG_SZ
GiForWindoms 28]LoggingDatabaseName REG_SZ CitrixSessionRecordingLogging
Google | LoggingLoggingState REG_DWORD 0x00000001 (1)
Intel MaxOpenfFiles REG_DWORD 0x00002710 (10000)
JavaSoft MaxRolloverFileSizelnMB REG_DWORD 0x0000012¢ (300)
JreMetrics PlaybackProtection REG_DWORD 0x00000001 (1)
Microsoft #4|PlayerUserRBACEnabledKey REG_DWORD 0x00000000 (0)
MozillaPlugins ab|PolicyFilePath REG_SZ C:\Program Files\Citrix\SessionRecording\Server\\A...
ODBC #4|PolicyFileRefreshPeriodinSeconds REG_DWORD 0x0000012¢ (300)
OpenSSH 4| RoleBasedSecurityEnabled REG_DWORD 0x00000001 (1)
Partner RolloverFileSizelnMB REG_DWORD 0x00000032 (50)
Policies RolloverTimelnHours REG_DWORD 0x0000000c (12)
Python #4|SkipReceiverVersionCheck REG_DWORD 0x00000001 (1)
Qualys 25| SmAudDatabaselnstance REG_SZ 10.108.92.40
RegisteredApplications 4| WebPlayerDisableAllRecording REG_DWORD 0x00000000 (0)
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An upgrade installation from an earlier version to Session Recording 2103 and later connects your web
browser to the Python-based WebSocket server. To connect to the WebSocket server hosted in IIS, run
the <Session Recording Server installation path>\Bin\SsRecUtils.exe -enablestreamingservice
command. To connect back to the Python-based WebSocket server, run the <Session Recording
Server installation path>\Bin\SsRecUtils.exe - disablestreamingservice command. The Python-
based WebSocket server is versioned 1.0.

HTTPS configuration

To use HTTPS to access the web player website:
1. Add an SSL bindingin IIS.

a) Obtain an SSL certificate in PEM format from a trusted Certificate Authority (CA).
Note:

Most popular browsers such as Google Chrome and Firefox no longer support the
common name in a Certificate Signing Request (CSR). They enforce Subject Alterna-
tive Name (SAN) in all publicly trusted certificates. To use the web player over HTTPS,
take the following actions accordingly:

« When a single Session Recording Server is in use, update the certificate of the
Session Recording Server to a SAN certificate.
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+ When load balancing is in use, ensure that a SAN certificate is available both on
Citrix ADC and on each Session Recording Server.
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b) On lIS, right-click the website and select Add Bindings. The Site Bindings dialog box ap-

pears.
Site Bindings ? >
Type Host Mame Port IP Address Binding Informa... Add...
htt, 20 "

. Edit...
Remove

Browse

Close
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c) Click Add in the upper right corner. The Add Site Binding dialog box appears.

d) Select https from the Type list and select your SSL certificate.

Add Site Binding ? >
Type: IP address: Port:
http o |AII Unaszigned v| |3D |
httE l
Exarnple: www.contoso.com or marketing.contoso.com
OK Cancel
Add Site Binding ? >
Type: IP address: Port:
https ~ | |All Unassigned v| |-‘143 |
Host names:
] Require Server Mame Indication
S5L certificate:
Mot selected Select... View...
OK Cancel

e) Click OK.
2. Update the SsRecWebSocketServer.conf1ig configuration file.

a) Locate and open the SsRecWebSocketServer.conf1ig configuration file.

The SsRecWebSocketServer.config configuration file is typically located in the <
Session Recording Server 1installation path>\Bin\ folder.
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b) (Optional) For Session Recording 2103 and later that host the WebSocket server in IS, en-
able TLS by editing TLSEnable=1 and ignore the ServerPort, SSLCert, and SSLKey fields.

c) (Optional) For Session Recording 2012 and earlier, enable TLS by editing TLSEnable=1, and
fillin the paths to the SSL certificate and its key, respectively.

Note:

Only the PEM format of SSL certificates and key files is supported.
The ServerPort field indicates the port number that the web player uses to collect

recording files. In the following screen capture, it is set to the default value (22334).

Mj SsRecWebSocketServer.exe.config - Motepad

File Edit Format WView Help

#l-enable TLS
#8-disable TLS
TLSEnable=08
#default-enable web socket serveron all ip address
#x.x.x.x-only enable serveron the given ip address
Serverfddress=default

#default-enable web socket serwveron tcp port 22334
#[0-65535] -enable serveron the given tcp port
[ServerPort=default|

#cert file path and name, only config it when TLSEnable=1
|SSLCert=C:\aSRS2.pem |

#key file path and name, only config it when TLSEnable=1
|SSLKey=C: \newaSRS2key . pen

To extract the separate certificate and key files used in the WebSocket server configuration:

i. Ensure that OpenSSL is installed on your Session Recording Server that contains the
SSL certificate.

ii. Exportthe SSL certificate as a .pfx file. The .pfx file includes both the certificate and
the private key.

iii. Open the command prompt and go to the folder that contains the .pfx file.
iv. Start OpenSSL from the OpenSSL\bin folder.
v. Run the following command to extract the certificate:

openssl pkcsl2 -in [yourfile.pfx] -clcerts -nokeys -out [
aSRS2.pem]
<!--NeedCopy-->

Enter the import password that you created when exporting the .pfx file.

vi. Run the following command to extract the private key:

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 153



Session Recording 2104

openssl pkcsl2 -in [yourfile.pfx] -nocerts -out [
newaSRS2keyWithPassword.pem]
<!--NeedCopy-->

Enter the import password that you created when exporting the .pfx file. Provide a
new password for protecting your key file when prompted for the PEM pass phrase.

vii. Run the following command to decrypt the private key:
openssl rsa -in [newaSRS2keyWithPassword.pem] -out [

newaSRS2key.pem]
<!--NeedCopy-->

d) Saveyour changes.

e) Checkyour firewall settings. Allow SsRecWebSocketServer.exe to use the TCP port (22334
by default) and allow access to the web player URL.

f) Runthe SsRecUtils —stopwebsocketserver command.

View recordings

After you log on, the web player home page might hide or show content based on whether the follow-
ing option is selected in Session Recording Server Properties.

i_@.i.; Session Recording Server Properties — *

MNotifications  CEIP

Hide content on the web player home page

This option prevents the web player home page from displaying any
O content. Recordings can be accessed only by way of their URLs.
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« With the option selected, the web player home page hides all content. Recordings can be ac-
cessed only by way of their URLs. Recording URLs are provided in email alerts that are sent
to specified recipients. For information about email alerts, see Email alert policies.You can
also share recording URLs through the Share Current Playback control on recording playback
pages. See descriptions later in this article.

CifT1X | Session Recording n

AN

Failed to access Citrix Session Recording

Your account is not authorized to use the Session Recording Player and the Session Recording web player. or your configuration such as the SSL certificate is not
correct. Contact your IT admin for help.

« With the option unselected, the web player home page shows content similar to the following
screen capture. Click All Recordings in the left navigation to refresh the page and display new
recordings if there are any. Scroll down the webpage to select recordings to view or use filters
to customize your search results. For live recordings, the Duration column shows Live and the
play button appears green.

& v administrator ) 0008:14 (»)

\2/

S

q o 0:03 ()

Administrator Logging 1h — ] 00:03:12 (>

t 0 154 »)

figurat ah J 00:01:5
ah _ 0 Live

To show all recording files of a recorded session, select a recording on the list and click the Follow up
icon. The Follow up icon is available only when a recording is selected.
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CilTIX | Session Recording _

[®] Recordings

Recordings of the selected session
This session starts from February 9, 2021 5:22 PM and including 1 recordings

=3 Fo‘gw up

sterttime vser iost Client Events Duration Action
All Recordings Start Time

February 24, 2021 9:57 AM e 15:22 PA : (\
Comments v ebruary 9, 2021 5:22 PM ah 5 00:30:07 »)

February 24, 2021 9:56 AM
Administrator Logging ¥

|E|February9, 2021 5:22PM
Configuration v

February 9, 2021 5:21 PM

February 9, 2021 5:20 PM

For a description of the recording items, see the following table.

Item Description

Start time The recording start time. Click the up and down
arrows to list recordings in chronological order.

User The user whose session was recorded. Click the
up and down arrows to concentrate recordings
of a user on the list and arrange users in
alphabetical order.

Host The host name of the VDA where the recorded
session was hosted. Click the up and down
arrows to arrange the VDA host names in
alphabetical order.

Client The name of the client device where the session
was running. Click the up and down arrows to
arrange the client host names in alphabetical
order.

Events The quantity of events in the recording. Click the
up and down arrows to arrange recordings on
the list by event quantity.

Duration The time length of the recording. Click the up
and down arrows to arrange recordings on the
list by time length.

Search for recordings by using filters

You can search for recordings by using filters. The available filters include host name, client name,
user name, application, client IP address, event text, event type, and time.
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[»] recordings ~ Start Time Hostname User name vehis Duration Action
All Recordings February 9. 2021 522 Application Client name 00:30:07 >
p i ras
Comments v ebruary 9, 2( Client IP address Event text 00:29:26 »)
o

o 8 2021 50 ent tv 4 30043 {
Administrator Logging v ary 8, 2021 5120 Event type Time: 00:30:43 )
N
N ) February 8, 2021 5|3 anouniszialr " 2 00:32:27 (»)
Configuration v T Ny
=
February 9, 2021 5:19 PM user2 00:32:39 )
February 9. 2021 5:18 PM use1 10 00:33:03 ()

For example, after you select the host name filter, the following dialog box appears. Type in the host
name (of the VDA where recorded sessions are hosted) and click Search to filter out irrelevant record-
ings and display only the relevant ones.

You can change to a different filter by clicking the currently selected Host name, as shown in the
following screen capture. All filters are listed after you click Host name. Select a different filter as
needed.

FILTER Clear All

= |
& Host name @
& User name User Host Client Events Duration Action
Hf Application
. Pl gh 5 00:30:07 @
I Client name
@ Client IP address P dzl 14 00:29:26 @
T3 Event text
o Pl dlg 14 00:30:43 @
= Comments
§= Event type P administrator 9 00:32:27 @
=] Time

Lehriary 9 2027 519 PN user2 12 00:32:39 @

You can also click the + symbol to add filters.

FILTER Clear All
| |

For example, you can add the Time filter as shown in the following screen.
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FILTER

m Clear All

Host name ~ ‘

Start date End date

Start Time End time
Duration
At least v Seconds
Start Time User Host
February 9, 2021 5:22 PM gh

v

Client Events Duration Action

5 00:30:07 @

The Time filter consists of recording start date, start time, and duration.

Open and play recordings

On the recordings page, each recording has a play button on the right side, next to the Duration

item.

[®] Recordings ~ Start Time -
All Recordings February 23, 2021 3:17 PM administrator
Comments v February 23, 2021 3:05 PM administrator
Administrator Logging v February 23, 2021 2:55 PM ah
Configuration . February 23, 2021 2:50 PM gh

February 23, 2021 2:43 PM gh

Click the play button. The playback page appears.

Host Client Events Duration Action

0 Live

p
0 00:08:14 @
—
0 00:03:12 @
~
0 00:01:54 @

0 Live

Playback starts after memory caching.
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FEB 23,2021

11:10:58-00:07:32-11 Events

Host name:

Client name:

Sort by All Categories v
- Q

00:00:00 Alert
Notification:Session Start

00:00:59 App Start:5692:
powershell: 8352: "C:\Win...

. Please wait for the Citrix Profile
" " Management

> D

00:00:04/00:07:32 B Comments (A Share Current Playback X1

00:01:00 App Start:8416:
conhost: 5692: 172\C\Win.

00:01:36 Session Pauseisik;;

00:02:27 Session Resume:l:;

00:03:02 Session Pause:/help;;

FULL SCREEN 00:03:19 Session Resumehj;;

For a description of the player controls, see the following table:

Player Control

>

*
|| 1)

00:01:29/00:07:32

00:00:00/00:02:17

= Comments
"

[~} Share Current Playback

X1

FULL SCREEN

Description

Plays the selected recording file.

Pauses playback.

You can drag the progress bar during playback.
Idle periods of recorded sessions are highlighted
during playback.

Seeks backward 7 seconds.

Indicates the current position of the recording
playback and the total recording duration. The
time format is HH:MM:SS.

Lets you click and leave a comment about the

recording being played.

Lets you click and copy the URL of the current
recording to the clipboard.

Indicates the current speed of playback. Click
the icon to switch between options including
X0.5, X1, X2, and X4.

Displays the playback in full screen.
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Player Control Description

Exit full screen

Displays the playback within the webpage.

Intheright pane of the playback page, the following recording data, event filters, and the quick search
box are available:

FEB 23, 2021

11:10:58-00:07:32 - 11 Events

Q o User name:-
& Host name:-
1 Client name:-

Sort by All Categories w
Filters - Q

00:00:00 Alert
Notification:Session Start

00:00:59 App Start:5692: —
powershell: 8352: "C:\Win... ()

00:01:00 App Start:8416: S~
conhost: 5692: \22\C:\Win... ()

00:01:36 Session Pause:sk;;
00:02:27 Session Resume:l:;
00:03:02 Session Pause:/help;;

00:03:19 Session Resume:hj;;

» The date and time on the web player machine. In this example, February 23, 2021 and
11:10:58.

+ The duration of the recording in playback. In this example, 00:07:32.
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« The number of events in the recording. In this example, 11 EVENTS.
+ The name of the user whose session was recorded.

+ The host name of the VDA where the recorded session was hosted.

+ The name of the client device where the session was running.

+ Options for sorting search results: Select Sort by All Categories, Sort by Events, or Sort by
Comments to sort search results.

« Event filters. You can select more than one filter to search for events in the current recording.

Sort by All Categories w

e ]

AP

Ny

Append
USB drive insertion

Client drive mapping

File renaming
Web browsing
Top-most window

Custom events

Alert notification
Clipboard operation
Session pause

Session resume

Click the icon to expand folded displays of events.

. ) 00:01:00 App Start:8416:
00:01:00 App Start:8416: conhost: 5602177
conhost: 5692: P7\CAWin... * \CAWindows\system32\conhost.ex

elxd

« Event list. Clicking an event on the list takes you to the position of the event in the recording.

» Quick search box. The search events quick search box helps to quickly narrow down a list of
events in the current recording.

Configure cache memory for storing recordings while playing

On the Configuration page of the web player, click the slider to set up the cache memory for storing
recordings while playing.
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Tip:

You can access the Configuration page directly through http(s)://<FQDN of Session Recording
Server>/WebPlayer/#/configuration/cache.

CilTIX | Session Recording Q

Recordings

Set up recording cache

Comments v You can set up cache memory to store recordings while playing.

Administrator Logging C
| @ Configuration -~

Storage

Record idle events and highlight idle periods

Session Recording can record idle events and highlight idle periods in the Session Recording web
player. Idle events are not visible in the Session Recording Player because idle events are saved in
the Session Recording Database but not in the relevant recording files (. i cl files).

To customize the idle event feature, set the following registry keys as required. The registry keys are
located at HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents.

Registry key Default value Description

DisableldleEvent 0 To disable the idle event
feature, set the value to 1.To
enable the idle event feature,
set the value to 0.
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Registry key Default value Description

IdleEventThrottle 120 seconds If there is no user activity
(including graphics changes
and keyboard/mouse inputs)
longer than the time threshold
set by the registry key, an idle
eventis recorded. Theidle
period is highlighted when the
recorded session plays back on
the Session Recording web
player.

IdleEventActiveThrottle 30 seconds Only a certain number of
graphics changes within a
specified amount of time
qualify as user activities. By
default, at least three packets
within 30 seconds can qualify
as user activities.

IdleEventActivePktNumThrottle 3 packets Only a certain number of
graphics changes within a
specified amount of time
qualify as user activities. By
default, at least three packets
within 30 seconds can qualify
as user activities.

IdleEventActivePktSizeThrottle 100 bytes Graphics packets smaller than
the key value are ignored and
the relevant time duration is
regarded as idle.

Comment on recordings

When a recorded session is being played, you can click the Comments player control to leave com-
ments and set comment severities. Comments of different severities are displayed in different colors
in the right event list panel. Severities include Normal, Medium, and Severe. During session playback,
you can view all comments about a recording and delete comments from the event list. Refresh the
webpage before being able to delete a comment you just left.
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FEB 23,2021

12:48:23-00:00:14 - 1 Events

l I User name:

Host name: §

Client name
Sort by All Categories v

00:00:00 Alert
Notification:Session Start

00:00:04 gh: Please take a look

00:00:07 gh: Shell

00:00:12 gh: Session quit

(4 Share Current Playback X1 FULL SCREEN

» f7> 00:00:12/00:00:14

Clickinga commentin the event list lets you jump to the location where the comment was given. Click-
ing the comment icon in the upper left corner redirects you to the My comments page where all your
comments are presented.

CilrIX | Session Recording Q v w I
Recordings v
Comments Q
| =) comments N
My Comments
Administrator Logging v Q Q Q
Configuration v Please take alook shell Session quit
Jump to Recording Jump to Recording Jump to Recording
Delete Delete Delete
:
Note

To make the comment feature work as expected, clear the WebDAV Publishing check box in the
Add Roles and Features wizard of Server Manager on the Session Recording Server.
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Add Roles and Features Wizard

Select server roles

Before You Begin Select one or more roles to install on the selected server.

Installation Type Roles

Server Selection [ Hyper-v P

Features [ ] Network Policy and Access Services
[ ] Print and Document Services
[ ] Remote Access
[ ] Remote Desktop Services
[ ] Volume Activation Services
4 [m] Web Server (IIS) (27 of 43 installed)
4 [E] Web Server (21 of 34 installed)
PRICIRCommon HTTP Features (5 of 6 installed)
+ Default Document (Installed)
+/| Directory Browsing (Installed)
«/| HTTP Errors (Installed)

« | Static Content (Installed)
+| HTTP Redirection (Installed)
WebDAV Publishing

b [m] Health and Diagnostics (4 of 6 installed)
b |« Performance (Installed)
b [m] Security (3 of 9 installed) -

< Previous l l Next >

Share URLs of recordings

Clicking Share Current Playback on the playback page of a recording copies the recording URL to the
clipboard. You can share the URL with other users for them to access the recording directly without
the need to search in all recordings.
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FEB 23,2021

12:48:23-00:00:14 - 1 Events

Client name:

Sort by All Categories v

00:00:00 Alert
Notification: Session Start

00:00:04 gh: Please take a look

00:00:07 gh: Shell

00:00:12 gh: Session quit

» f7> 00:00:12/00:00:14 & Comments

X1 FULL SCREEN

After you click Share Current Playback, either of the following messages appears, indicating a suc-
cessful or failed operation respectively:

« The URL to the shared recording has been copied to the clipboard
« Sharing the recording URL failed

Pasting the shared URL in the address bar lets you jump to the location where the URL was copied.

For secure sharing, set the following registry values under HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Server:

Registry value Description Default value Remarks
LinkExpire Time span beyond 1,728,000,000,000 (The -

which a shared URL default value equals 2

expires. Counted as days.)

timeticks in the unit of
10 microseconds.

LinkSalt A security method to Kk20d974 Change the default
protect the preceding value to an arbitrary
URL expiration time string that preferably

ends with digits.

Administrator Logging integrated with the web player

The web player integrates the Administrator Logging webpage. An administrator assigned to both the
LoggingReader and the Player roles can view the administrator activity logs in the web player.
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Note:

The language set for the web player browser must match the language you selected when you

installed the Session Recording Administration components.

+ Configuration logging:

CifTIX | Session Recording

Recordings v D Logging Time
Comments v 18 2/22/202110:07 PM
[ER Administrator Logging  ~ 17 2/22/2021 10:06 PM
Configuration Logging 16 2/22/2021 9:41 PM
Record Reason Logging 15 2/22/2021 9:32 PM
Configuration N 14 2/22/2021 9:32 PM
13 2/22/2021 9:32 PM
12 2/22/2021 9:32 PM
11 2/22/2021 9:32 PM
10 2/22/2021 9:31 PM
9 2/22/2021 9:31 PM

+ Recording reason logging:

CilrIX | Session Record

Recordings v )

Comments v E

Configuration Logging

Record Reason Logging

ca

.

Task Category

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Recording File Play Back

Task Category

Email Alert Resson

Record Reason

Component Affected

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Session Recording Player

Component Affected

Session Recording Agent

Session Recording Agent

‘Session Recording Agent

Session Recording Agent

+ Action = Session File Path and Size Query ...

+ Action = Session File Path and Size Query ...

Task Details

+ Action = Session File Path and Size Query

+ Action = Session File Path and Size Query ...

+ Action = Session File Path and Size Query ..

+ Action = Session File Path and Size Query

+ Action = Session File Path and Size Query ...

+ Action = Session File Path and Size Query ...

+ Action = Session File Path and Size Query

+ Action = Session File Path and Size Query ...

Task Details

ons = GDDC Desktop/###Desktop.

ons = GDDC/Desktop

s = GDDC/Desktop/#:1

+= GDDC/Des

ons = GDDC Desktop/###Desktop.

ons = GDDC/Desktop #2Desitop

s = GDDC/Desktop/#:1

s = GDDC Desktop/#+Desktop.

s = GDDC Desktop ##Desktop.

ons = GDDC/Desktop

Task Excuted By

1-100f 18

bi APRQgh

Task Excuted By

Authorized

true

true

true

true

true

true

true

true

true

true

Authorized

e

e

Ensure that your SessionRecordingLoggingWebApplication site in 1IS and the web player have the

same SSL settings. Otherwise, 403 errors occur when you request to access the administrator activity

logs.
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€3 Internet Information Services (1IS) Manager

‘Q-‘» 3 » I > stes > et ebSte » RecordingLoggi ,
File View Help . :
@-id 1218, &) /sessionRecordingLoggingWebApplication Home
- id & |8 |5,
€3 Start P =
: ‘Eh Filter: « % Go -~ G ShowAll | Groupby: Area - -
a
7 Application Pools ASP.NET ~ A
v 8] Sites o $ = T £3
- = ' o \ -
v ) Default Web Site ) N~ @ ¢ ‘\ 2 3 f?.)
1 aspnet_client NET NET  .NET Error NET  NETProfile .NETRoles .NETTrust .NET Users
3 MsMQ izat.. Compilati Pages jzati Levels
P SessionRecordingBroker ) d = Y
g = e ) @
9 SessionRecordinglogging = ab) ﬁ ua: “}?A &“» 3]
P Sessi i i ication C ion MachineKey Pagesand  Providers Session State SMTP E-mail
(@ SessionRecordingRestApiService Settings Strings Controls
(@ SessionRecordingWebStreaming s .
@ WebPlayer _ —
@ =
2 & B 9 o F @ B
ASP  Authentic..  CGI  Compression Default  Directory ErrorPages  Failed
Document  Browsing Request Tra...
-~ == = B i
sy e g = e " 3 &
& a & 0 oF A P s
Handler HTTP HTTP logging MIMETypes Modules  Output  Request
Mappings ~ Redirect  Respon. Caching Filtering
SSL Settings
Management -
e v
[E]Features View |i:% Content View
Ready %
June 10, 2021

The troubleshooting information contains solutions to some issues you might encounter during or
after installing the Session Recording components.
Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Installation of Server components fails

June 10, 2021

The installation of the Session Recording Server components fails with error codes 2503 and 2502.
Resolution: Check the access control list (ACL) of folder C:\windows\Temp to ensure that the Local
Users and Groups have write permission for this folder. If not, manually add write permission.
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Test connection to the Database fails during install

June 10, 2021

When you install the Session Recording Database or the Session Recording Server, the test connection
fails with the error message Database connection test failed. Please correct Database instance
name even if the database instance name is correct.

In this case, ensure that the current user has the public SQL Server role permission to correct the
permission limitation failure.

Agent cannot connect to the Server

June 10, 2021

When the Session Recording Agent cannot connect to the Session Recording Server, the Exception
caught while sending poll messages to Session Recording Broker event message is logged, fol-
lowed by the exception text. The exception text provides reasons why the connection failed. The
reasons include:

+ The underlying connection was closed. Could not establish a trust relationship for the
SSL/TLS secure channel. This exception means that the Session Recording Server is using a
certificate signed by a CA that the server hosting the Session Recording Agent does not trust or
the server hosting the Session Recording Agent does not have a CA certificate. Alternatively, the
certificate might have expired or been revoked.

Solution: Verify that the correct CA certificate is installed on the server hosting the Session
Recording Agent or use a CA that is trusted.

« The remote server returned an error: (403) forbidden. This standard HTTPS error occurs
when you attempt to connect using HTTP that is unsecure. The machine hosting the Session
Recording Server rejects the connection because it accepts only secure connections.

Solution: Use Session Recording Agent Properties to change the Session Recording Broker pro-
tocol to HTTPS.

+ The Session Recording Broker returned an unknown error while evaluating a record pol-
icy query. Error code 5 (Access Denied). For more information, see the Event log on the
Session Recording Server. This error occurs when sessions are started and a request for a
record policy evaluation is made. The error is a result of the Authenticated Users group (the de-
faultmember) being removed from the Policy Query role of the Session Recording Authorization
Console.
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Solution: Add the Authenticated Users group back to this role, or add each server hosting each
Session Recording Agent to the PolicyQuery role.

+ The underlying connection was closed. A connection that was expected to be kept alive
was closed by the server. This error means that the Session Recording Server is down or un-
available to accept requests. The IIS might be offline or restarted, or the entire server might be
offline.

Solution: Verify that the Session Recording Server is started, 1IS is running on the server, and
the server is connected to the network.

« The remote server returned an error: 401 (Unauthorized). This error manifests itself in the
following ways:

- On startup of the Session Recording Agent Service, an error describing the 401 error is
recorded in the event log.

- Policy query fails on the Session Recording Agent.

- Session recordings are not captured on the Session Recording Agent.

Solution: Ensure that the NT AUTHORITY\Authenticated Users group is a member of the local
Users group on the Session Recording Agent.

$ Computer Management

) —

File Action View Help

«2 | rEXE= HE

&' Computer Management | Name Description
« [fi System Tacls & Administrators Administrators have complete and unrestricted access to the computer...
» O Task S(heduler & Backup Operators Backup Operators can override security restrictions for the sole purpos...
’ @ E:lent:;:ev:rjl & Cryptographic Operators Members are authorized to perform cryptographic operations.
© @ shared Folgers & Distributed COM Users Members are allowed to launch, activate and use Distributed COM obj...
4 #& Local Users and Gn . .
< Users & Event Log Readers Members of this group can read event logs from local machine
“| Groups & Guests [ Users Properties . — . a— . —- - m‘ by defaul..
» (@ Performance &S IUSRS - e
& Device Manager & Network Configuratig | | General es to ma...
4 [ Storage & Performance Log Use e counter...
=F Disk Management || & Performance Monito % Users locally a...
» s Services and Applicat| & power Users pssess limi...
$& Remote Desktop Usel o ly
) Descriptien: Users are prevented from making accidental or intentional
& Replicator Ny system-wide changes and can run mostapplications
¥ Users E stem-wid...
& HelpLibraryUpdaters M mempers:
& Message Capture Usd)| 82, CITRTE\Domain Users
BSQLServer2005MssQ 5}
NT AUTHORITYINTERACTIVE (S-1-54
#sQusenver200sMssQf| | |y, L &1
2 SQLServer20055QLBH|
P sQLServerDTSUser$NY|
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Server cannot connect to the Database

June 10, 2021

When the Session Recording Server cannot connect to the Session Recording Database, you might see
a message similar to one of the following:

Event Source:

A network-related or instance-specific error occurred while establishing a connection to SQL
Server. This error appears in the applications event log with ID 2047 in the Event Viewer of the com-
puter hosting the Session Recording Server.

Citrix Session Recording Storage Manager Description: Exception caught while establishing
database connection. This error appears in the applications event log in the Event Viewer of the
machine hosting the Session Recording Server.

Unable to connect to the Session Recording Server. Ensure that the Session Recording Server is
running. This error message appears when you launch the Session Recording Policy Console.

Resolution:

» The Express Edition of Microsoft SQL Server 2008 R2, Microsoft SQL Server 2012, Microsoft SQL
Server 2014, or Microsoft SQL Server 2016 is installed on a stand-alone server and does not
have the correct services or settings configured for Session Recording. The server must have
the TCP/IP protocol enabled and the SQL Server Browser service running. See the Microsoft
documentation for information about enabling these settings.

+ During the Session Recording installation (administration portion), incorrect server and data-
base information was given. Uninstall the Session Recording Database and reinstall it, supply-
ing the correct information.

+ The Session Recording Database Server is down. Verify that the server has connectivity.

« The machine hosting the Session Recording Server or the machine hosting the Session Record-
ing Database Server cannot resolve the FQDN or NetBIOS name of the other. Use the ping com-
mand to verify that the names can be resolved.

+ Check the firewall configuration on the Session Recording Database to ensure that the SQL
Server connections are allowed. For more information, see the Microsoft article at https://docs
.microsoft.com/en-us/sql/sql-server/install/configure-the-windows-firewall-to-allow-sql-
server-access?redirectedfrom=MSDN&view=sql-server-verl5.

Logon failed for user ‘NT_AUTHORITY\ANONYMOUS LOGON’. This error message means that the
services are logged on incorrectly as .\administrator.

Resolution: Restart the services as local system user and restart the SQL services.
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Sessions are not recording

June 10, 2021

If application sessions are not recording successfully, start by checking the application event login the
Event Viewer on the VDA for multi-session OS that runs the Session Recording Agent and the Session
Recording Server. Doing so can provide valuable diagnostic information.

If sessions are not recording, the possible cause might be:

+ Component connectivity and certificates. If the Session Recording components cannot com-
municate with each other, session recording can fail. To troubleshoot recording issues, verify
that all components are configured correctly to point to the correct machines and that all cer-
tificates are valid and correctly installed.

+ Non-Active Directory domain environments. Session Recording is designed to run in a Mi-
crosoft Active Directory domain environment. If you are not running in an Active Directory en-
vironment, you might experience recording issues. Ensure that all Session Recording compo-
nents are running on machines that are members of an Active Directory domain.

+ Session sharing conflicts with the active policy. Session Recording matches the active policy
with the first published application that a user opens. Subsequent applications opened during
the same session continue to follow the policy thatisin force for the first application. To prevent
session sharing from conflicting with the active policy, publish the conflicting applications on
separate VDAs for multi-session OS.

+ Recordingis not enabled. By default, installing the Session Recording Agent on a multi-session
OS VDA enables recording for the VDA. Recording does not occur until an active recording policy
is configured to allow it.

+ The active recording policy does not permit recording. A session can be recorded only when
the session meets the rules of the active recording policy.

» Session Recording services are not running. For sessions to be recorded, the Session Record-
ing Agent service must be running on a VDA for multi-session OS and the Session Recording Stor-
age Manager service must be running on the machine hosting the Session Recording Server.

+ MSMQ s not configured. If MSMQ is not correctly configured on the server running the Session
Recording Agent and the machine hosting the Session Recording Server, recording problems
might occur.

Unable to view live session playback

June 10, 2021
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If you experience difficulties when viewing recordings using the Session Recording Player, the follow-
ing error message might appear:

Download of recorded session file failed. Live session playback is not permitted. The server
has been configured to disallow this feature. This error indicates that the server is configured to
disallow the action.

Resolution: In Session Recording Server Properties, choose the Playback tab and select the Allow
live session playback check box.

Recordings are corrupted or incomplete

June 5,2024

« If recordings are corrupted or incomplete when you view them using the Session Recording
Player, you might also see warnings in the Event logs on the Session Recording Server.
Event Source: Citrix Session Recording Storage Manager
Description: Data lost while recording file <icl file name>

The issue occurs when MCS or PVS is used to create VDAs with a master image configured and
Microsoft Message Queuing (MSMQ) installed. In this condition, the VDAs have the same QMId
for MSMQ.

As aworkaround, create a unique QMId for each VDA. For more information, see Install, upgrade,
and uninstall.

+ The Session Recording Player might report an internal error with the message - “The file being
played has reported that an internal system error (error code: 9) occurred during its origi-
nalrecording. The file can still be played up to the point that the recording error occurred”
when playing back a certain recording file.

The issue occurs due to insufficient buffer size on the Session Recording Agent when graphic
intensive sessions are recorded.

Asaworkaround, change HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SmAudBufferSizeMB
to higher value data on the Session Recording Agent, and then restart the machine.

Verify component connections

June 10, 2021
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During the setup of Session Recording, the components might not connect to other components. All
the components communicate with the Session Recording Server (Broker). By default, the Broker (an

IIS component) is secured using the 1IS default website certificate. If one component cannot connect

to the Session Recording Server, the other components might also fail when attempting to connect.

The Session Recording Agent and the Session Recording Server (Storage Manager and Broker) log con-
nection errors in the applications event log in the Event Viewer of the machine hosting the Session

Recording Server. The Session Recording Policy Console and The Session Recording Player display

connection error messages on screen when they fail to connect.

Verify that the Session Recording Agent is connected

o w e

Log on to the server where the Session Recording Agent is installed.

From the Start menu, choose Session Recording Agent Properties.

In Session Recording Agent Properties, click Connection.

Verify that the correct FQDN is entered in the Session Recording Server field.

Verify that the server given as the value for the Session Recording Server is accessible to your
VDA for multi-session OS.

Note: Check the application event log for errors and warnings.

Verify that the Session Recording Server is connected

Caution:

Using Registry Editor can cause serious problems that might require you to reinstall the operating

system. Citrix cannot guarantee that problems resulting from incorrect use of Registry Editor can

be solved. Use Registry Editor at your own risk.**

N

Log on to the machine hosting the Session Recording Server.

Open the Registry Editor.

Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.

Verify that the SmAudDatabaselnstance value correctly references the Session Recording Data-
base you installed on your SQL Server instance.

Verify that the Session Recording Database is connected

1.

2.

Using a SQL Management tool, open your SQL instance that contains the Session Recording
Database you installed.
Open the Security permissions of the Session Recording Database.
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3. Verify that the Session Recording Computer Account has access to the database. For example,
if the machine hosting the Session Recording Server is named SsRecSrv in the MIS domain,
the computer account in your database must be configured as MIS\SsRecSrv$. This value is
configured during the Session Recording Database installation.

Test IS connectivity

Testing connections to the Session Recording Server IIS site by using a Web browser to access the
Session Recording Broker webpage can help you determine whether problems with communication
between Session Recording components stem from misconfigured protocol configuration, certifica-
tion issues, or problems starting Session Recording Broker.

To verify IS connectivity for the Session Recording Agent:

1. Logon to the server where the Session Recording Agent is installed.
2. Open a Web browser and type the following address:

o ForHTTPS:https:

, Where servername is the name of the machine hosting the Session
Recording Server.
o For HTTP: http:

, where servername is the name of the machine hosting the Session Record-
ing Server.

3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain adminis-
trator account.

To verify 1IS connectivity for the Session Recording Player:

1. Log on to the workstation where the Session Recording Player is installed.
2. Open a Web browser and type the following address:

« For HTTPS: https:

, Where servername is the name of the machine hosting the Session Recording
Server

« For HTTP: http:

, Where servername is the name of the machine hosting the Session Recording
Server

3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain adminis-
trator account.

To verify 1S connectivity for the Session Recording Policy Console:

1. Logon to the server where the Session Recording Policy Console is installed.
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2. Open a Web browser and type the following address:

o ForHTTPS:https:
, Where servername is the name of the machine hosting the Session
Recording Server
o FOrHTTP:http:
, where servername is the name of the machine hosting the Session
Recording Server

3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain adminis-
trator account.

If you see an XML document within your browser, it verifies that the machine running the Session
Recording Policy Console is connected to the machine hosting the Session Recording Server using
the configured protocol.

Troubleshoot certificate issues

If you are using HTTPS as your communication protocol, the machine hosting the Session Recording
Server must be configured with a server certificate. All component connections to the Session Record-
ing Server must have root certificate authority (CA). Otherwise, attempted connections between the
components fail.

You can test your certificates by accessing the Session Recording Broker webpage as you would when
testing IIS connectivity. If you are able to access the XML page for each component, the certificates
are configured correctly.

Here are some common ways certificate issues cause connections to fail:

+ Invalid or missing certificates. If the server running the Session Recording Agent does not
have a root certificate to trust the server certificate and cannot trust and connect to the Session
Recording Server over HTTPS, causing connectivity to fail, verify that all components trust the
server certificate on the Session Recording Server.

+ Inconsistent naming. If the server certificate assigned to the machine hosting the Session
Recording Server is created using an FQDN, all connecting components must use the FQDN
when connecting to the Session Recording Server. If a NetBIOS name is used, configure the
components with a NetBIOS name for the Session Recording Server.

+ Expired certificates. If a server certificate expired, connectivity to the Session Recording Server
through HTTPS fails. Verify the server certificate assigned to the machine hosting the Session
Recording Server is valid and has not expired. If the same certificate is used for the digital sign-
ing of session recordings, the event log of the machine hosting the Session Recording Server
provides error messages that the certificate expired or warning messages when it is about to
expire.
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Search for recordings using the Player fails

June 10, 2021

If you experience difficulties when searching for recordings using the Session Recording Player, the
following error messages might appear:

+ Search for recorded session files failed. The remote server name could not be resolved:
servername. The servername is the name of the server to which the Session Recording Player
is attempting to connect. The Session Recording Player cannot contact the Session Recording
Server. Two possible reasons are an incorrectly typed server name or that the DNS cannot re-
solve the server name.

Resolution: From the Player menu bar, choose Tools > Options > Connections and verify that
the server namein the Session Recording Servers listis correct. Ifitis correct, fromacommand
prompt, run the ping command to see if the name can be resolved. When the Session Recording
Server is down or offline, the search for recorded session files failed error message is Unable to
contact the remote server.

+ Unable to contact the remote server. This error occurs when the Session Recording Server is
down or offline.

Resolution: Verify that the Session Recording Server is connected.

+ Access denied. An access denied error can occur if the user was not given permission to search
for and download recorded session files.

Resolution: Assign the user to the Player role using the Session Recording Authorization Con-
sole.

+ Access denied when the Player role is assigned. This error occurs when you install the Ses-
sion Recording Player on the same machine with the Session Recording Server, and you have
enabled UAC. When you assign the Domain Admins or Administrators user group as the Player
role, a non-built-in administrator user included in that group might fail to pass the role-based
check when searching recordings in the Session Recording Player.

Resolutions:

- Run the Session Recording Player as an administrator.
- Assign specific users as the Player role rather than the entire group.

- Install the Session Recording Player in a separate machine rather than Session Recording
Server.

« Search for recorded session files failed. The underlying connection was closed. Could not
establish a trust relationship for the SSL/TLS secure channel. The error occurs when the
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Session Recording Server uses a certificate that is signed by a CA that the client device does not
trust or have a CA certificate for.

Resolution: Install the correct or trusted CA certificate workstation where the Session Recording
Player is installed.

« The remote server returned an error: (403) forbidden. This error is a standard HTTPS error
that occurs when you attempt to connect using HTTP (nonsecure protocol). The server rejects
the connection because, by default, it is configured to accept only secure connections.

Resolution: From the Session Recording Player menu bar, choose Tools > Options > Connec-
tions. Select the server from the Session Recording Servers list, and click Modify. Change the
protocol from HTTP to HTTPS.

Troubleshoot MSMQ

If a notification message is given but the viewer cannot find recordings after a search in the Session
Recording Player, there is a problem with MSMQ. Verify that the queue is connected to the Session
Recording Server (Storage Manager). Use a Web browser to test for connection errors (if you are using
HTTP or HTTPS as your MSMQ communication protocol).

To verify that the queue is connected:

1. Logon to the server hosting the Session Recording Agent and view the outgoing queues.

2. Verify that the queue to the machine hosting the Session Recording Server has a connected
state.

« If the state is waiting to connect, there are messages in the queue, and the protocol is
HTTP or HTTPS (corresponding to the protocol selected on the Connections tab in Ses-
sion Recording Agent Properties), perform Step 3.

+ Ifthestateis connected and there are no messages in the queue, there might be a problem
with the server hosting the Session Recording Server. Skip Step 3 and perform Step 4.

3. If there are messages in the queue, open a Web browser and type the following address:

o For HTTPS: https: , where
servername is the name of the machine hosting the Session Recording Server.

o For HTTP: http: , Where
servername is the name of the machine hosting the Session Recording Server.

If the page returns an error such as The server only accepts secure connections, change the
MSMQ protocol listed in Session Recording Agent Properties to HTTPS. If the page reports a
problem with the website security certificate, there might be a problem with a trust relationship
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for the TLS secure channel. In that case, install the correct CA certificate or use a CA that is
trusted.

4. If there are no messages in the queue, log on to the machine hosting the Session Recording
Server and view private queues. Select citrixsmauddata. If there are messages in the queue
(Number of Messages Column), verify that the Session Recording StorageManager service is
started. If it is not, restart the service.

Manage your database records

June 10, 2021

The ICA Log database (ICLDB) utility is a database command-line utility used to manipulate the ses-
sion recording database records. This utility is installed, during the Session Recording installation, to
thedrive:\Program Files\Citrix\SessionRecording\Server\Bin folderon theserver
hosting the Session Recording Server.

Quick reference chart

The following table lists the commands and options that are available for the ICLDB utility. Type the
commands using the following format:

icldb [version | locate | dormant | import | archive | remove |
removeall] command-options [/1] [/f] [/s] [/?]

Note:

More extensive instructions are available in the help associated with the utility. To access the
help, from a command prompt, type the drive:

\Program Files\Citrix\SessionRecording\Server\Bin folder, and type

icldb /7. To access help for specific commands, type

icldb *commandx /2.
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Command

archive

dormant

import

locate

remove

Description

Archives the session recording files older than
the retention period specified. Use this
command to archive recordings and events in
the recordings. The events are archived in the
ArchivedEvent database table.

Displays or counts the session recording files
that are considered dormant. Dormant files are
session recordings that were not completed due
to data loss. Use this command to verify if you
suspect that you are losing data. You can check
whether the session recording files are
becoming dormant for the entire database, or
only recordings made within the specified
number of days, hours, or minutes.

Imports session recording files to the Session
Recording database. Use this command to
rebuild the database if you lose database
records. Also, use this command to merge
databases (if you have two databases, you can
import the files from one of the databases).
Locates and displays the full path to a session
recording file using the file ID as the criteria. Use
this command when you are looking for the
storage location of a session recordingfile. It is
also one way to verify if the database is
up-to-date with a specific file.

Removes the references to session recording
files from the database. Use this command (with
caution) to clean up the database. Specify the
retention period to be used as the criteria. You
can also remove the associated physical file.
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Command Description

removeall Removes all references to session recording files
from the Session Recording Database and
returns the database to its original state. The
actual physical files are not deleted; however,
you cannot search for these files in the Session
Recording Player. Use this command (with
caution) to clean up the database. Deleted
references can be reversed only by restoring
from your backup.

version Displays the Session Recording Database
schema version.

/1 Logs the results and errors to the Windows event
log.

/f Forces the command to run without prompts.

/s Suppresses the copyright message.

/? Displays help for the commands.

Archive session recording files

To maintain an adequate level of spare disk capacity in the recording storage locations, archive session
recording files regularly. Depending on the amount of disk space available and the typical size of
session recording files, archiving intervals differ. Session recording files must be older than two days
from the start date before a session recording file can be archived. This rule is to prevent any live
recordings from being archived before they become complete.

Two methods are available when you archive session recordings. The database record for a session
recording file can be updated to have a status of archived while the session recording file remains
in the recording storage location. This method can be used to reduce the search results in the Player.
The other method is to update the database record for a session recording file to the status of archived
and also move the session recording file from the recording storage location to another location for
backup to alternative media. When the ICLDB utility moves session recordingfiles, the files are moved
to the specified directory where the original file folder structure of year/month/day no longer exists.

The session recording record in the Session Recording Database contains two fields associated with
archiving: the archive time representing the current date and time a session recording was archived;
the archive note, an optional text note that might be added by the administrator during archiving. The
two fields indicate a session recording has been archived and the time of archiving.
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In the Session Recording Player, any archived session recordings show a status of Archived and the
date and time of archiving. Session recordings that have been archived might still be played if the files
have not been moved. If a session recording file was moved during archiving, a file not found error is
displayed. The session recording file must be restored before the session can be played. To restore a
session recording, provide the administrator with the File ID and Archive Time of the session recording
from the recording Properties dialog box in the Session Recording Player. Restoring archived files is
discussed further in the following Restore session recording files section.

The archive command of the ICLDB utility has several parameters that are described as follows:

+ [RETENTION:<days> - The retention period in days for session recordings. Recordings older
than the number of days specified are marked as archived in the Session Recording Database.
The retention period must be an integer number greater than or equal to 2 days.

+ [LISTFILES —Lists the full path and file name of session recordingfiles as they are being archived.
This parameter is optional.

+ [MOVETO:<directory>- The directory to which you physically move archived session recording
files. The specified directory must exist. This parameter is optional. If no directory is specified,
files remain in their original storage location.

+ [NOTE:<note> - A text note that is added to the database record for each session recording
archived. Ensure that the note is enclosed with double quotes. This parameter is optional.

+ [L-Logs theresults and errors to the Windows event log of the number of session recording files
archived. This parameter is optional.

« |F —Forces the archive command to run without prompts. This parameter is optional.

To archive session recordings in the Session Recording Database and physically move session
recording files

=

. Log on to the server where the Session Recording Server is installed as a local administrator.
2. Starta command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording Server
installation path (<Session Recording Server Installation Path>/Server/
Bin).

4. RuntheICLDB ARCHIVE /RETENTION:<days> /LISTFILES /MOVETO:<directory
> /NOTE:<note> /L command where days is the retention period for session recording
files, directory is the directory where archived session recording files are moved to, and note is
the text note that is added to the database record for each session recording file being archived.
Enter Y to confirm the archive.
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To only archive session recordings in the Session Recording Database

=

. Logon to the server where the Session Recording Server is installed as a local administrator.
2. Starta command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording Server
installation path (<Session Recording Server Installation Path>/Server/Bin).

4. Run the ICLDB ARCHIVE /RETENTION:<days> /LISTFILES /NOTE:<note> /L
command where days is the retention period for session recordings and note is the text note
that is added to the database record for each session recording being archived. Enter Y to
confirm the archive.

Restore session recording files

Restoration of session recording files is required when you want to view a session recording that was
archived in the Session Recording Database and the file has been moved from the recording storage
location. Archived session recordings that were not moved from the recording storage location during
archiving are still accessible in the Session Recording Player.

Two methods are available for restoring session recording files that have been moved. Copy the re-
quired session recording file to the restore directory for archived files, or import the required session
recording file back to the Session Recording Database by using the ICLDB utility. Citrix recommends
the first method for restoring archived session recording files. Remove archived files copied to the
restore directory for archived files when you no longer need them.

The Session Recording Broker utilizes the Restore directory for archived files when a session record-
ing fileis not found in its original storage location. This case occurs when the Session Recording Player
requests a session recording file for playback. The Session Recording Broker first attempts to find the
session recordingfile in the original storage location. If the file is not found in the original storage loca-
tion, the Session Recording Broker then checks the Restore directory for archived files. If the file is
present in the restore directory, the Session Recording Broker sends the file to the Session Recording
Player for playback. Otherwise, if the file is not found, the Session Recording Broker sends a file not
found error to the Session Recording Player.

Importing archived session recording files by using the ICLDB utility updates the Session Recording
Database with session recording information from the session recording file, including a new storage
path for the session recording file. Using the ICLDB utility to import an archived session recording file
does not move the file back to the original storage location when the session was recorded.

Note: An imported session recording file has the archive time and archive note cleared in the Session
Recording Database. Therefore, the next time the ICLDB archive command is run, the imported
session recording file might become archived again.
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The ICLDB import command is useful to import a large number of archived session recording files,
repair, or update incorrect and missing session recording data in the Session Recording Database, or
move session recording files from one storage location to another storage location on the Session
Recording Server. The ICLDB import command can also be used to repopulate the Session Recording
Database with session recordings after running the ICLDB removeall command.

The import command of the ICLDB utility has several parameters that are described as follows:

+ [LISTFILES —Lists the full path and file name of session recording files while they are being im-
ported. This parameter is optional.

+ /[RECURSIVE —Searches all subdirectories for session recording files. This parameter is optional.

+ [L—Logs the results and errors to the Windows event log the number of session recording files
imported. This parameter is optional.

 [F —Forces the import command to run without prompts. This parameter is optional.

To restore session recording files by using the restore directory for archived files

1. Logon to the server where the Session Recording Server is installed as a local administrator.

2. In Session Recording Player Properties, determine the File ID and Archive Time of the archived
session recording file.

3. Locatethe session recordingfile in your backups using the File ID specified in Session Recording
Player Properties. Each session recording has a file name of i _<FileID>.1icl, where FilelD
is the ID of the session recording file.

4. Copy the session recording file from your backup to the restore directory for archived files. To
determine the restore directory for archived files:

a) From the Start menu, choose Start > All Programs > Citrix > Session Recording Server
Properties.

b) In Session Recording Server Properties, select the Storage tab. The current restore direc-
tory appears in the Restore directory for archived files field.

To restore session recording files by using the ICLDB import command

1. Logon to the server where the Session Recording Server is installed as a local administrator.
2. Starta command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording Server
installation path (<Session Recording Server Installation Path>/Server/
Bin).
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4, Either:

« Run the ICLDB IMPORT /LISTFILES /RECURSIVE /L <directory> com-
mand where directory is the name of one or more directories, separated by a space
containing session recording files. Enter Y to confirm the import.

« Runthe ICLDB IMPORT /LISTFILES /L <file>commandwherefileisthename
of one or more session recording files, separated by a space. Wildcards might be used to
specify session recording files. Enter Y to confirm the import.

Best practices

June 10, 2021

You can consult the following best practices documentation for deploying Session Recording and con-
figuring load balancing:

+ Configure load balancing in an existing deployment
+ Deploy and load-balance Session Recording in Azure

Configure load balancing in an existing deployment

June 10, 2021

This article guides you through the process of adding load balancing nodes using Citrix ADC in an
existing Session Recording deployment. The following servers are used as an example throughout
the process. You can also deploy and load-balance Session Recording in Azure.

+ Session Recording

Host Name Server Role 0s IP Address

SRServerl Session Recording Windows Server 10.63.32.55
Server

LBDC Domain controller Windows Server 10.63.32.82

TSVDA Session Recording Windows Server 10.63.32.215
Agent
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Host Name Server Role oS IP Address
SRSQL Session Recording Windows Server 10.63.32.91
Database and the file
server

All Session Recording components and the domain controller share adomain, forexample, 1b.
com. The domain administrator account, for example, Ib\administrator, is used for server logon.

« Citrix ADC
Management IP Subnet IP Address
Host Name Server Role Address (NSIP) (SNIP)
Netscaler Citrix ADCVPX instance 10.63.32.40 10.63.32.109

For more information, see Deploy a Citrix ADC VPX instance.

Step 1: Create shared folders on the file server

1. Log on to the file server by using a domain administrator account, for example, 1b\
administrator.

2. Create a folder to store recordings and name the folder SessionRecording, forexample, C
:\SessionRecording. Sharethe Read/Write permission of the folder with a Session Record-
ing Server. Using SRServerl as an example, type LB\SRSERVER1S. The dollar sign $ is re-

quired.

RN ~ | Windows (C:) - [m] X
Home Share View o
« “ 4 i > ThisPC » Windows (C) » v & Search Windows (C:) F=

Name Date modified Type Size
3t Quick access
46c2a726daB69f96b3bAC5f458:202 10/29/2 AM  File folder
[ Desktop
PerflLogs 10 M File folder
I Downloads

Program Files 1 M File folder

5 Documents

Program Files (x36) 11/23/2 M File folder

& Pictures SessionRecording File folder

(o]

= SOLServer2017Me Lt 0 Filefolder

This PC Open in new window
Users I File folder
& Network Windows A I File folder
= ip Give access to Remove access @
Restore previous versions 31 Specific people...
Include in library pd
Pin to Start
Send to >
Cut
Copy
Create shortcut
Delete
Rename
Properties
9items  1item selected =
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Wl M-
Home Share View 9
« v 4 Ea > ThisPC > Windows (C) v Search Windows (C:) P
Name Date modified Type Size
# Quick access
46c2a726daB60f96b3bBc5f458e202 10 File folder
[ Desktop
PerfLogs 10, File folder
; Dawnloads Program Files 1 File folder
= Documents Program Files (x86) 1 File folder
=] Pictures | SessionRecording | 11 File folder
T imer SeccionRECO-imamDrrsmend 1 il £l - - 5
SQLServer20
o Network Users @ Network access
Windows
Elip .
Choose people on your network to share with
Type a name and then click Add, or click the arrow to find someone.
~ Add
Name Permission Level
2 Administrator Read/Write
S Administratars OQwner
[E":?."'La'i'sﬁ'séﬁ\fﬁms Read/Write ¥ |
|
10items 1 item selected I'm having trouble sharing B

_ — conee

3. Create a subfolder within the SessionRecordingfolder and name the subfolder share, for
example, C:\SessionRecording\share.

[9] [ = | SessionRecording - [u] X
Home Share View (7]
&« 4 s> ThisPC » Windows(C) » SessionRecording » ~ & | Search SessionRecording F-)

Name - Date modified Type Size
# Quick access
B Desktop share 11425/ 24AM  File folder
3 Downloads

[£ Documents

&= Pictures
& This PC

£ Network

Yitem  State: 3R Shared |_| =

4. Createanotherfolderto restore archived recordings and namethe folder SessionRecordingsRestorec
, for example, C:\ SessionRecordingsRestored. Share the Read/Write permission
of the folder with a Session Recording Server. Using SRServerl as an example, type
LB\SRSERVER1S. The dollar sign $ is required.

5. Create a subfolder within the SessionRecordingsRestored folder and name the
subfolder share, for example, C:\ SessionRecordingsRestored\share.
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Step 2: Configure an existing Session Recording Server to support load balancing

This step describes how to configure an existing Session Recording Server to support load balancing.

Step 7 details the procedure of adding more Session Recording Servers to your existing deployment.

1. Logon to a Session Recording Server by using a domain administrator account.

2. Open Session Recording Server Properties.

Windows Server
Citrix
Session Recording Administrator L... F-
=]
Session Recording Authorization C...

Server Manager

Session Recording Policy Console

am

Windows.
Administrativ...

Session Recording Server Properties

Firefox

2

Google Chrome

Microsoft SOL Server 2019
Search

Server Manager

Settings

Windnwe Arreccnnac

A

2

Windows
PowerShell

™

Task Manager

g

Event Viewer

b3
Windows.
PowerShell ISE

Control Panel

File BExplorer

3. Add the Universal Naming Convention (UNC) paths created in Step 1 to store and restore
recording files, in this example, \\SRSQL\SessionRecording\share and \\SRSQL\
SessionRecordingRestored\share. SRSQL is the host name of the file server.
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Note:

The Session Recording Player cannot play files under a path that contains a drive letter ora
dollar sign ($) unless you install the player and the Session Recording Server on the same
machine.

% Session Recording Server Properties - >

Storage  Signing Rollover Playback Motfications CEIP  Logging RE* | *

Recorded session files are stored in the directones specified. To store files
in & load-balanced manner, specify multiple directories across different
volumes.

File storage directories:

W3 RS0 WSession Recording 'share Add.

Specify a folder to temporarily store archived session recordings and make
them available for playback.

Restore directory for archived files:
I WWSRSGLSessionRecordings Restored share I Browse...

Corca | [IIESR%

4. Add a value to the Session Recording Server registry key at HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server.

Value name: EnablelLB
Value data: 1 (D_WORD, meaning enable)
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B Registry Editor
File Edit View Favorites Help

ComputetHKEY_LOCAL_MACHINE\SOFTWARE Citrix\ SmartAuditor\Server

"D Computer Mame Type Data
:EE:—E b‘iiﬁfﬁg 5] (Default REG_SZ (value not st
HKEY_LOCAL M}\CHINE ‘.’.'A%]_Installed REG_DWORD 0x00000001 (1)
w
- BCDONIN00 %4 AllowLivePlayback REG_DWORD 0x00000001 (1)
5 . .
HARDWARE at ]AzureSQLServ!ceAdm!nPasswo‘.. REG_SZ
SAM '_"]AzureSQLSeNl(eAdmmUserna.” REG_SZ
SECURITY 3_"] DatabaseFailoverPartner REG_SZ
o SOFTWARE {h] DatabaseMame REG_SZ CitrixSessionRecerding
w7 Citrix 344 DeferredHashCalcFileSizeThres... REG_DWORD 0x00200000 (2097152)
Citrix Desktop Delivery Controller || %] DormantTimelnHours REG_DWORD 0xDD00O03D (43)
Citrix Session Recording '-'-'5] EnableAnalytics REG_DWORD 0x00000001 (1)
InstallAgent '-'-%] EnableAzureSOLService REG_DWORD 000000000 (0)
Metalnstall e EnableLB REG_DWORD 0x00000001 (1) |
SmartAuditor ?AﬁEnabIeRecordmgActanLoggmg REG_DWORD 0x00000007 (1)
Server ) Enable5RStoragel ogging REG_DWORD Ox0000000T (1)
HenTools '.'.%] EnableWebBasedSrPlayer REG_DWORD 0x00000001 (1)
KenToolslnstaller ab] FileStorageDirectories REG_MULTI_SZ WWSRSOL'SessionRecording'share
KenToolsNetSettings ab] LinkEmail REG 57
Classes a5] LinkExpire REG SZ 1728000000000
E'e':"t‘s N ab] LinkHost REG_SZ
. ault serEnvironment 5] LinkSalt REG_SZ Ii2oda74
m:;g © 14 LoggingBlockState REG_DWORD (x00000001 (1)
Microsoft ab] LeggingDatabaseFailoverPartner REG_SZ
Moszilla ab) LeggingDatabaseName REG_SZ CitrixSessionRecerdinglogging
mozilla.org '-’-%] LoggingLoggingState REG_DWORD 0x00000001 (1)
ODBC 4 MaxOpenFiles REG_DWORD 0x00002710 (10000)
OpensSH {"] NotifyMessageByCulture REG_MULTI_SZ
Partner '_"] MotifyMessageDefault REG_SZ Your activity with the desktop or programis) you r..
Policies %4 PlaybackProtection REG_DWORD 0x00000001 (1)
Cualys ‘-’-%] PlayerUserRBACEnabledKey REG_DWQORD 000000000 (0)
RegisteredApplications ab) PolicyFilePath REG_SZ ChProgram Files\Citrix\SessionRecording\Server\...
Setup ‘.’-%] PolicyFileRefreshPeriodInSeco.. REG_DWORD 0x0000012¢ (300)
WOWE432Mode ‘.’.%] RoleBasedSecurityEnabled REG_DWORD 000000001 (1)
SYSTEM '.'.'5] RolloverFileSizelnMB REG_DWORD 000000032 (50)
HKEY_USERS #| RolloverTimelnHours REG_DWORD 0x0000000c (12)
HKEY_CURRENT_CONFIG 4 SkipReceiverVersionCheck REG_DWORD 0x00000001 (1)

5. Restart the Citrix Session Recording Storage Manager service.

Step 3: Configure load balancing in Citrix ADC

There are two ways to configure load balancing in Citrix ADC - TCP passthrough and SSL offloading.

Configure load balancing through TCP passthrough

The following topologies show how to configure load balancing through TCP passthrough.

+ If you are using the Python-based WebSocket server (Version 1.0):
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(- ""‘fgg? ADC Load Balancing

-

l = HTTPS TP ‘ 1301‘ 443 ‘ 80 ‘ ‘1 ———————— >‘ 1301‘ 443 ‘ 80 ‘ ‘
e=——3N 443 T T T

HTTP
o

HTTP 80 E
HTTPS 443 SAN Certificate
MSMQ 1801

Session Recording Server

] E
e SAN Cerificate

Session Recording Server

TTPS |HTTP
443 | 30

o O

Client

+ If you are using the WebSocket server hosted in IIS (Version 2.0):

i- ysua ADC Load Balancing 5
: T Sockel 80
L TS Tcp ‘ 1301‘ Y ‘ 80 ‘4 """"" >‘ 1301‘ 413 ‘ 30 ‘ : HTTPS 443
JLI. "TE § ’ ; SAN Cerlificate

MSMQ 1801

Session Recording Server

( 0 ¢ 0
(s
e =)
l‘g-g SAN Cerificate
1 Session Recording Server
N
HTTPS | HTTPAVebSOCKe
443 80

® 0

Client

To configure load balancing through TCP passthrough, complete the followings steps:

1. Logon to your Citrix ADC VPX instance.

2. Navigate to Configuration > System > Settings > Configure Basic Features.
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cifrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads
Q Search in Menu System / Settings
Settings
Licenses
Settings Modes and Features
Diagnostics Configure Modes
I Configure Basic Features I
High Availability > Configure Advanced Features
NTP Servers Configure Extra Management CPU
Reports
Profiles
Partition Administration >
User Administration b
Authentication >
Auditing >
SNMP > ADM
AppFlow @ > Configure ADM Parameters

3. Select Load Balancing and click OK.

Cifrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

@ Configure Basic Features

SSL Offloading HTTP Compression
Load Balancing Content Switching

Content Filter Integrated Caching

Rewrite Citrix Gateway

Authentication, Authorization and Auditing

o IR

4. Add load balancing servers.

Navigate to Traffic Management > Load Balancing > Servers and click Add.
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cifrix_ ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

Traffic Management / Load Balancing / Servers

Q Searchin Menu
Syst
e > Servers @

AppExpert >

I Traffic Management I g | Add ‘ Select Action ~
Load Balancing i ~ i
Q Click here to search or you can enter Key : Value format

Virtual Servers
NAME STATE

Services
. No items
Service Groups
Meniters
Metric Tables

Servers

Persistency Groups

Radius Nodes

Priority Load Balancing [ S
Content Switching >

IPADDRESS / DOMAIN

Type the name and IP address of a Session Recording Server and then click Create. For example:

Cifrix ADC VPX (1000)

Dashboard Configuration Reporting

Documentation

Downloads

® Create Server

Name*
srv-1 @
o) IP Address Domain Mame
IPAddress®
10.63.3255 {D

Traffic Domain

| Enable after Creating

Comments

Click the save icon in the upper right corner to save your changes.
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Traffic Management / Load Balancing / Servers

Servers @
Q Click here to sea ou can enter Key - Value format o

NAME STATE IPADDRESS / DOMAIN TRAFFIC DOMAIN

| ¥ sivl @ENABLED 10633255 0

Total 1 25PerPage v Page 1 ofl

5. For WebSocket server Version 1.0, add load balancing services of ports 80, 1801, 22334, and
443 for each Session Recording Server. For WebSocket server Version 2.0, add load balancing
services of ports 80, 1801, and 443 for each Session Recording Server.

Navigate to Traffic Management > Load Balancing > Services and click Add.

Cifrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads
Q Search in Menu Traffic Management / Load Balancing / Services /[ Services
System > .
Services
AppExpert >
ﬂ]’rafﬁc Management b Services o Auto Detected Services 0 Internal Services = 6

Load Balancing )
I o8¢ Baancing | e Add ‘ Statistics | | No action

Virtual Servers

. Click here to search or vou can enter Key - Value format
Services Q ere 1o search or you can enter Rey - Value 1o

Service Groups NAME SERVER STATE

Moenitors No items
Metric Tables

Servers

Persistency Groups

Radius Nodes

Priority Load Balancing |

S N

Content Switching

Type a name for each load balancing service you add. Choose Existing Server, select the IP
address of your target Session Recording Server, select TCP as the server protocol, and type a
port number. Click OK.
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Cifrix ADC VPX (1000)

DEHLIE]L

Configuration

Reporting Documentation Downloads

® Load Balancing Service
Basic Settings

Service Mame*

srv-1-80

©)

New Server o) Existing Server
Server”®

srv-1(10.63.32.55) %
Protocol*

TCP 0]
Port*

80 @
» More

o [

Bind the TCP protocol monitor to each load balancing service.
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Service Load Balancing Monitor Binding / Load Balancing Menitor Binding
Load Balancing Monitor Binding

Select Monitor*
H tp >]| Add || Edit ‘@

 Binding Details

Weight
1

| State

ﬁ Clcse

Click the save icon in the upper right corner to save your changes.

Traffic Management / Load Balancing / Services / services

Services
Services |4 | Auto Detected Services | 0 | Internal Services | 6
‘ Add ‘ ‘ Edit ‘ ‘ Delete ‘ ‘ Statistics ‘ ‘Attmn -
] Name State
] sIv-1-1801 our
] sn-1-22334 oup
(] sIv-1-443 our
(%) s1v-1-80 ouP

.
Tip:
.

IP Address/Domain Name

10633255

10633255

10633255
10623255

Q
Search
Port Protocol Max Clients Max Requests. Cache Type Traffic Domain
801 TCP 0 0 SERVER 0
22334 TCP 0 0 SERVER 0
43 TCP o 0 SERVER 0
80 TP [ 0 SERVER 0

The load balancing service of port 22334 is required only for WebSocket server Version 1.0.

6. Add load balancing virtual servers.

For WebSocket server Version 1.0, complete the following steps to add load balancing virtual
servers of ports 80, 443, 1801, and 22334. For WebSocket server Version 2.0, add load balancing
virtual servers of ports 80, 443, and 1801. For example:
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Traffic Management / Load Balancing / Virtual Servers

Virtual Servers ) ®|:|
Add Edit Delete Enable Disable Statistics Action - Search ~
[m] Name State Effective State IP Address Port Protocol Method Persistence % Health Traffic Domain
a vsrv-80 o ouP 10.633260 80 TCP LEASTBANDWIDTH SOURCEIP 100.00% 1 UP/O DOWN [
[} oUP @UP 10633260 1801 Tcp LEASTBANDWIDTH SOURCEIP 100.00% 1 UP/0 DOWN o
[m] oupP ouP 10633260 443 TP LEASTBANDWIDTH SOURCEIP % 1UP/0 DOWN o
[m] Vsiv-22334 ouP ®UuP 10.63.3260 22334 TcP LEASTBANDWIDTH SOURCEIP 100.00% 1 UP/Q DOWN o

Navigate to Traffic Management > Load Balancing > Virtual Servers and click Add.

Reporting Documentation Downloads

Menu Traffic Management / Load Balancing / Virtual Servers

Q Searchi

System .
Virtual Servers @
AppExpert
iTrafﬁc Management | e | Add ‘ ‘ Statistics ‘ | Select Action v

LOa(IBBIanCin“ e Click hero tn caarch or yntl can ante (ny - ~ farmat
NAME STATE EFFECTIVE STATE IP ADDRESS

Services

. No items
Service Groups

Menitors ToEl@
Metric Tables
Servers
Persistency Groups

Radius Nodes

Priority Load Balancing [

W

Content Switching

Add each virtual server with the Citrix ADC VIP address based on the TCP protocol.
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citrix_ ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

® Load Balancing Virtual Server

Basic Settings

Create a virtual server by specifying a name, an IP address, a port. and a protocol type. If an application is accessible from the Internet, the virtual server IP (VIP) address is a publi
network {(WAN), the VIP is usually a private (ICANN non-routable) IP address.
You can configure multiple virtual servers to receive client requests, thereby increasing the availability of resources to process client requests

Name*

vsrv-80 @
Protocol*

cP v @
IP Address Type*

IP Address e
IP Address®

10 . 63 . 32 . 60 (@)

Port

80 (0]

Bind each virtual server to the load balancing service of the same port. For example:

cifrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

@ Load Balancing Virtual Server

Load Balancing Virtual Server | Exportasa Template

Basic Settings

Name vsrv-80 Listen Priority -

Protocol TCP Listen Policy Expression NONE

State ®DOWN Redirection Mode P

IP Address 10.63.32.60 Range 1

Port 80 IPset -

Traffic Domain 0 RHI State PASSIV
AppFlow Logging ENABLI

Retain Connections on Cluster  NO
TCP Probe Port -

Services and Service Groups

A service s a logical representation of an application running on a server.
A service group enables you to manage a group of services as though it were a single service. After creating a service group. you can bind it to a virtual server, and you can add service:
Note: Bind at least one service or service group to the virtual server.

Click Continue to display the advanced settings and select the method, persistence type, and any other configuration detail that you might need

No Load Balancing Virtual Server Service Binding

No Load Balancing Virtual Server ServiceGroup Binding
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Service Binding / Service

Service @3

Q Click here to search or you can enter Key : Value format

NAME
srv-1-80
srv-1-443
srv-1-1801

srv-1-22334

Total 4

Choose a load balancing method.
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Method

Method is a load balancing algorithm that the Citrix ADC usesto s

Load Balancing Method®

LEASTEANDWIDTH e @

Mew Service Startup Reguest Rate

0

Backup LB Method*
ROUNDROBIN e

Mew Service Reguest unit”

PER_SECOND v

Increment Interval

Configure persistence on each virtual server. We recommend you select SOURCEIP as the per-
sistence type. For more information, see Persistence settings.
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Persistence

Configure persistence to route all connections from the same use
persistence type fails.

Select Persistence Type*

E]SDUHCEIP

Time-out {mins)*

2

IPv4 Metmask

265 . 25h

RULE

Ma
£
o

IPvE Mask Length

128

OTHERS

]
(%]
o

@

. Create a host record for the Citrix ADC VIP address on the domain controller.

,gl_., DNS Manager X
Eile Action View Help
= sE XE Hm 8
r% I?NS Name Type Data Timestamp
v i LEDC ﬂ_msdc;
w || Forward Lookup Zones j sites
» 2] _msdcslb.com j_tcp
> = Ib.com jiudp
» [ Reverse Lockup Zones = X
o 0 Trust Paints jDomamDnsZones
» [| Conditional Forwarders jForestDn;Zones
E (same as parent folder) Start of Authority (SOA) [47], Ibdc.lb.com., hostma... static
E (same as parent folder) MName Server (MNS) Ibde.lb.com. static
E(same as parent folder) Haost (A) 10,63.32.82 11/19/2020 2:00:00 AM
Elibde Host (A} 10.63.32.82 static
Eleooc Host (A) 10.63.32.1 11/19/2020 11:00:00 PM
Host (A) 10 60
Elsrserven Host (A} 10.63.32.55 11/18/2020 2:00:00 AM
ElsRserver2 Host (A} 10.63.32.68 11/19/2020 11:00:00 PM
ElsrsaL Host (A) 10.63.32.91 11/23/2020 3:00:00 AM
Eltsvoa Host (A) 10.63.32.215 11/23/2020 2:00:00 AM
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8. To access the web player over HTTPS, ensure that a SAN certificate is available both on Citrix
ADC and on each Session Recording Server. A SAN certificate contains the FQDNs of the Citrix
ADC and of each Session Recording Server.

n  Certificate >

General Cetals  Certification Path

Show: | <all= e
Field Yalue 6
5] Autharity Key Identifier KeyID=693d13b5780dch45ab. ..

CF‘.L Distribution Paints [1]CRL Distribution Point: Distr. ..
@.ﬁ.uthnrity Information Access  [1]Authority Info Access: Acc...
a Certificate Template Name WehbServer

Subject Alternative Mame DS Mame=netscaler.lb.com, ...
[=Key Jsage
DThumbprint

ceaabtf2c434becie 338000904, .

DMS Mame=netscaler.|b.com
DMS Mame=10.563.32.60

IP Address=10.63.32.60

DMS Mame=localhost

DMS Mame=5RServer 1.lb.caom
DMS Mame=10.63.32.55

IP Address=10.53.32.55

DMS Mame=localhost

Edit Properties... Copy to File...

Configure load balancing through SSL offloading

The following topologies show how to configure load balancing through SSL offloading.

« If you are using the Python-based WebSocket server (Version 1.0):
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== MSMQ
- 1801
VDA
l =T HTTPS|
443
VDA

& [F

SAN Certificate

ADC Load Balancing

=

Certificate

HTTPS 443

« If you are using the WebSocket server hosted in IIS (Version 2.0):

MSMQ
1801
VDA

- HTTPS]|
= 443

VDA

MSMQ_ 1801
Session Recording Server

Certificate

HTTPS
443

® 0

Client

& F

SAN Certificale
ADC Load Balancing

ECS e O I

TCP |

443 ‘ 1801 } """""" } wsm| 443 ‘

Session Recording Server

HTTPS/WebSocket(WSS) 443
Certificate

MSMQ_1801
Session Recording Server

HTTPS/WebSocket(WSS)
443

® 0

Client

1. Log on to your Citrix ADC VPX instance.

Certificate

Session Recording Server
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2. Navigate to Configuration > System > Settings > Configure Basic Features.

Cifrix ADC VPX (1000)

ET G LGE Configuration Reporting Documentation Downloads
Q) Search in Menu System / Settings
Settings
Licenses
Settings Modes and Features
Diagnostics Configure Modes
| Configure Basic Features |
High Availability > Configure Advanced Features
NTP Servers Configure Extra Management CPU
Reports
Profiles
Partition Administration >
User Administration 5
Authentication >
Auditing >
SNMP > ADM
AppFlow |E| N Configure ADM Parameters

3. Select SSL Offloading and Load Balancing and click OK.

Cifrix ADC VPX (1000)

EE [ E Configuration Reporting Documentation Downloads

® Configure Basic Features

S5L Offloading HTTP Compression

.~ Load Balancing Content Switching
Content Filter Integrated Caching
Rewrite Citrix Gateway

Authentication, Authorization and Auditing

o [

4. Add load balancing servers.

Navigate to Traffic Management > Load Balancing > Servers and click Add.
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cifrix_ ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

Traffic Management / Load Balancing / Servers

Q Searchin Menu
Syst
e > Servers @

AppExpert >

I Traffic Management I g | Add ‘ Select Action ~
Load Balancing i ~ i
Q Click here to search or you can enter Key : Value format

Virtual Servers
NAME STATE

Services
. No items
Service Groups
Meniters
Metric Tables

Servers

Persistency Groups

Radius Nodes

Priority Load Balancing [ S
Content Switching >

IPADDRESS / DOMAIN

Type the name and IP address of a Session Recording Server and then click Create. For example:

Cifrix ADC VPX (1000)

Dashboard Configuration Reporting

Documentation

Downloads

® Create Server

Name*
srv-1 @
o) IP Address Domain Mame
IPAddress®
10.63.3255 {D

Traffic Domain

| Enable after Creating

Comments

Click the save icon in the upper right corner to save your changes.
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Traffic Management / Load Balancing / Servers

Servers @
Q Click here to sea ou can enter Key  Value format
NAME STATE IPADDRESS / DOMAIN
| v srv-1 @ENABLED 10633255

Total 1

TRAFFIC DOMAIN

25PerPage v Page 1 ofl

Add the following load balancing services for each Session Recording Server:

Add load balancing services for each Session Recording Server you added in the previous step.

+ (Required only when you are using the WebSocket server Version 1.0) SSL load balancing

service of port 22334 that binds to the TCP monitor
+ SSL load balancing service of port 443 that binds to the HTTPS monitor
« TCP load balancing service of port 1801 that binds to the TCP monitor

For example:

Traffic Management / Load Balancing / Services / Services

Services

Services 3 AuloD

Configuration

IP Address/Domain Name Port Protocol

SSL

2334 ssL

Reporting

Max Clients

Documentation

Sear

Max Requests Cache Type
SERVER
SERVER

SERVER

Downloads

Traffic Management / Load Balancing / Services [/ Services

Q Search in Menu
e > Services
AppExpert 3
ﬂ Traffic Management v Services i)  Auto Detected Services
I Load Balancing | v ‘ﬂ/
Virtual Servers
Q Click here to se you can enter Ke
Service Groups NAME
Menitors No items
Metric Tables
Servers
Persistency Groups
Radius Nodes @)
Priority Load Balancing |E| >
Content Switching @ >

0 Internal Services &

‘ Statistics | | No action

SERVER STATE

e

Traffic Domain
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(Required only when you are using the WebSocket server Version 1.0) Add an SSL load
balancing service of port 22334 for each Session Recording Server. Type a name for the
load balancing service, choose Existing Server, select the IP address of a Session Recording
Server, select SSL as the server protocol, type port number 22334, and click OK.

For example, see the following screen capture.

Cifrix ADC VPX (1000)

Dashboard Configuration Reporting

® Load Balancing Service

Basic Settings

Service Name®
srv-1-22334 @
Mew Server e Existing Server

Server®

srv-1(10.63.32.55) o

Protocol*

SSL v (D
Port*
22334 @D

» More

o =

Bind the TCP monitor to the SSL load balancing service you just added.
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Service Load Balancing Monitor Binding / Load Balancing Monitor Binding

Load Balancing Monitor Binding

Binding Details

ad || Edt | ©

Weight
1 ®

| State

. |

Add an SSL load balancing service of port 443 for each Session Recording Server. Type a
name for the load balancing service, choose Existing Server, select the IP address of a Session
Recording Server, select SSL as the server protocol, type port number 443, and click OK.
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Cifrix ADC VPX (1000)

Dashboard Configuration Reporting

® Load Balancing Service

Basic Settings

Service Mame*

srv-1-443 @

Mew Server e Existing Server
Server*

srv-1(10.63.32.55) W
Protocol*

S5L e

&

Port

| 443 | @

» Maore

o [

Bind the HTTPS monitor to the SSL load balancing service you just added.
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Service Load Balancing Monitor Binding / Load Balancing Menitor Binding

Load Balancing Monitor Binding

Select Monitor*

https E‘ Add it | @

Binding Details

Weight
1

 State

m Close

Add a TCP load balancing service of port 1801 for each Session Recording Server. Type a
name for the load balancing service, choose Existing Server, select the IP address of a Session
Recording Server, select TCP as the server protocol, type port number 1801, and click OK.
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Cifrix ADC VPX (1000)

Dashboard Configuration Reporting Documentat

® Load Balancing Service

Basic Settings

Service Name*
srv-1-1801 @
Mew Server e Existing Server

Server*
srv-1(10.63.3255) W

Protocol®

TCP e {D

i

Port

1801 @

b More
o I

Bind the TCP monitor to the TCP load balancing service you just added.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 211



Session Recording 2104

Service Load Balancing Monitor Binding / Load Balancing Menitor Binding

Load Balancing Monitor Binding

Select Monitor*

fcp > | | Add Edit |®

Binding Details

Weight
1

| State

- .

6. (Required only when you are using the WebSocket server Version 1.0) Add an HTTP profile for
each SSL load balancing service of port 22334,

Navigate to System > Profiles > HTTP Profiles and click Add.
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cCitrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads
Q Search in Menu System / Profiles / HTTP Profiles
System e '
I Profiles
Licenses
P TCP Profiles = 13 HTTP Profiles Database Profiles = 0 SSL Profil
Settings
Diagnostics Add
High Availability b
NTP Servers Q Click here to search or you can enter Key : Value format
Reports NAME DROP INVALID INVALIDATE HTTI
Profiles nshttp_default_profile » b'e
Partition Administration S nshttp_default_strict_validation v v
User Administration > nshttp_default_internal_apps v '
Authentication >
Total 3
Auditing >
SNMP b

Select the Enable WebSocket connections check box and accept the other default settings.
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HTTP/2 Initial Window Size
65535

HTTP/2 Maximum Concurrent Streams
100

HTTP/2 Maximum Frame Size
16384

HTTP/2 Minimum Server Connections

20

HTTP/2 Maximum Header List Size

24576

HTTP/2 Maximum Ping Frames Per Minute

HTTP/2 Maximum Reset Frames Per Minute

HTTP/2 Maximum Empty Frames Per Minute

HTTP/2 Maximum Settings Frames Per Minute

0]
Alternative Service | Connection Multiplexing Drop invalid HTTP requests
Mark HTTP/0.9 requests as invalid Mark CONNECT Requests as Invalid Mark TRACE Reguests as Invz
Mark RFC7230 Non-Compliant Transaction as Invalid Mark HTTP Header with Extra White Space as Invalid Compression on PUSH packet
| Drop extra CRLF | Enable WebSocket connections (D | Enable RTSP Tunnel
Drop extra data from server | HTTPWeblogging Persistent ETag

Adaptive Timeout

Type a name for the HTTP profile, for example, websocket_SSL.

Go back to each SSL load balancing service of port 22334, for example, srv-1-22334. Click +
Profiles.
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cifrix ADC VPX (1000)

Dashboard Canfiguration

G Load Balancing Service

Basic Settings

srv-1-22334

Reporting Documentation

HA Status

@ Not configured

Downloads

Partition ..
default

nsroot v

o]

/ Help

Service Name Traffic Domain 0
Server Name srv-1 Number of Active Connections - Advanced Settings
IP Address 10.63.32.55 Hash ID
Server State @®DOWN Server ID None =+ Thresholds & Timeouts
Protocol SSL Clear Text Port -
Port 22334 Cache Type SERVER + Profiles
Comments Cacheable NO
Health Monitoring YES o
AppFlow Logging ENABLED +  Policies

Monitering Connection Close Bit NONE

Service Settings

Sure Connect
Surge Protection  OFF
Use Proxy Port YES

Use Source P Address  NO
Client Keep-Alive NO
TCP Buffering NO

4+ SSL Profile

4+ SSL Policies

+ Certificate

Select the HTTP profile, for example, websocket_SSL, and click OK and then Done.

Profiles
Met Profile

+
TCP Profile

+
HTTP Profile

websocket 550 +

DM5 Profile Mame

Done

7. (Required only when you are using the WebSocket server Version 2.0) Add an HTTP profile for

each SSL load balancing service of port 443.

8. Create a host record for the Citrix ADC VIP address on the domain controller.
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E:, DMS Manager

File  Action View Help

e« | HEXE= Hml 8 86

2 DNS
~ 5 LBDC

~ | Forward Lookup Zones
=) _msdeslb.com
=/ lb.com
~| Reverse Lookup Zones
| Trust Points

~ Conditional Forwarders

Narne

_P—_Lmsdcs

j_sites

e

i
jDomamDnsZones
:]FnrestDnsZnnes
E—|(same as parent folder)
E—l(same as parent folder)
E—l(same as parent folder)

ElTsvoa

Type

Start of Authority (SOA)
Mame Server (MN5)

Host (A)

Host (A)

Host (A)

Host (A)
Host (&)
Host (A}
Host (A)

Data

[47], Ibdc.lb.com., hostma...
Ibdc.lb.com,

10.63.32.82

10.63.32.82

10.63.32.1

10.63.32.60

10,63.32.55
10.63.32.68
10.63.32.91
10,63.32.215

Timestamp

static

static

11/19/2020 2:00:00 AM
static

11/19/2020 11:00:00 PM

11/18/2020 2:00:00 AM
11/18/2020 11:00:00 PM
11/23/2020 3:00:00 AM
11/23/2020 2:00:00 AM

Add the following load balancing virtual servers with the Citrix ADC VIP address.

9. Add load balancing virtual servers.

+ (Required only when you are using the WebSocket server Version 1.0) load balancing vir-
tual server of port 22334 based on SSL
+ load balancing virtual server of port 443 based on SSL

+ load balancing virtual server of port 1801 based on TCP

For example, see the following screen capture.

Traffic Management / Load Balancing / Virtual Servers

Virtual Servers

Add

oooD0o

Statistics

State
o
euP
our

Action -
Effective State IP Address

our 10,

ouP

Port Protocol
1801 cp
43 st
334 ssL

Method

Persistence

% Health

Navigate to Traffic Management > Load Balancing > Virtual Servers and click Add.
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ciftrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads
Q Search in Menu Traffic Management / Load Balancing / Virtual Servers
System > .
Virtual Servers @
AppExpert
iTrafﬁc Management | e | Add ‘ ‘ Statistics ‘ | Select Action v
I Load Balancing I b N o
Q) Click here to search or you can enter Key : Value format
= NAME STATE EFFECTIVE STATE IP ADDRESS
Services
. No items
Service Groups
Total 0

Menitors

Metric Tables
Servers
Persistency Groups

Radius Nodes

Priority Load Balancing [

W

Content Switching

Add each virtual server with the Citrix ADC VIP address. Type a server name, select TCP or SSL,
and select the relevant port number as described earlier.

Cilrix_ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

® Load Balancing Virtual Server

Basic Settings

Create a virtual server by specifying a name, an IP address, a port. and a protocol type. If an application is accessible from the Internet, the virtual server IP (VIP) address is a publi
network {(WAN), the VIP is usually a private (ICANN non-routable) IP address.
You can configure multiple virtual servers to receive client requests, thereby increasing the availability of resources to process client requests

Name*

vsrv-80 @
Protocol*

CP v @
IP Address Type*

IP Address e
IP Address®

10 . 63 . 32 . 60 (@)
Port*

80 (@)
» More

Bind each virtual server to the load balancing service of the same port. For example:
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Tip:

Service Binding / Service

Service &

Edit

Q Click here to search or you can ente

NAME

srv-1-22334

] svi-443

srv-1-1801

Total 3

The load balancing service of port 22334 is required only when you are using the Web-

Socket server Version 1.0.

Choose a load balancing method.
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Method

Method is a load balancing algorithm that the Citrix ADC usesto s

Load Balancing Method®

LEASTEANDWIDTH e @

Mew Service Startup Reguest Rate

0

Backup LB Method*
ROUNDROBIN e

Mew Service Reguest unit”

PER_SECOND v

Increment Interval

Configure persistence on each virtual server. We recommend you select SOURCEIP as the per-
sistence type. For more information, see Persistence settings.
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Persistence

Configure persistence to route all connections from the same use
persistence type fails.
Select Persistence Type*

E]SDUHCEIP RULE OTHERS (1)

W
N

Time-out (mins)*
2

IPv4 Metmask

255

(]
Ma
£
]
%)
[
(]

25
IPvE Mask Length
128

(Required only when you are using the WebSocket server Version 1.0) Add an HTTP profile for
the load balancing virtual server of port 22334,

Profiles X
A profile is a collection of settings that can be applied to a NetScaler entity, such as a virtual server or service. You can apply the same profile to multiple entities of the same type
Net Profile HTTP Profile
‘ ~ ” + | | [wel:sockethL *'I| + || /|
TCP Profile DB Profile
| ~[+]l4] d E3|14
LB Profile DNS Profile Mame
v|+]l~] “|.+)l4]

10. Install a Subject Alternative Name (SAN) certificate in Citrix ADC.

Obtain a SAN certificate in PEM format from a trusted Certificate Authority (CA). Extract and up-
load the certificate and private key files in Citrix ADC by navigating to Traffic Management >
SSL > Server Certificate Wizard.

For more information, see SSL certificates.
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4 Install Certificate

Certificate-Key Pair Name®

||bcarc|

Certificate File Name*

Choose File w ‘Ihcard.cer |

Key File Name™

| Choose File w ‘Ihcarr:l.kegrr |

Password™

[# Motify When Expires

No SMMP Trap destination found. Notification will not be sent until 2 trap destination is configured.

Naotification Period

|3Cl

11. Bind a SAN certificate to each SSL load balancing virtual server.

Navigate to Traffic Management > Load Balancing > Virtual Servers, select an SSL load bal-
ancing virtual server, and click Server Certificate.
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Cilrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

® Load Balancing Virtual Server

Load Balancing Virtual Server | Export as a Template

Basic Settings

Mame vsrv-443
Protocol SSL

State ®DOWN

IP Address 10.63.32.60
Port 443

Traffic Domain 0

Services and Service Groups

1 Load Balancing Virtual Server Service Binding

Mo Load Balancing Virtual Server ServiceGroup Binding

Certificate

Mo Server Certificate

MNo CA Certificate

Add the previously mentioned SAN certificate and click Bind.

Step 4: Configure an existing Session Recording Agent to support load balancing

1. Log on to the Session Recording Agent by using a domain administrator account.
2. Open Session Recording Agent Properties.

3. Complete this step if you use Microsoft Message Queuing (MSMQ) over TCP.
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Type the FQDN of your Citrix ADC VIP address in the Session Recording Server box.

LE} Session Recording Agent Properties —

Recording Connections

>

Session Recording Server: MNetScaler Ib.com

Session Recording Storage Manager message queue

Protocol: TCP L
HTTR/HTTFS port: Default
Fort Number:

Message life specifies the period during which data remains in the

message quels.

Meszage life (seconds):

Session Recording Broker
Protocaol: HTTFS e
HTTR/HTTPS part: Custom b

Carcs

On each Session Recording Server, add and set the IgnoreOSNameValidation
DWORD value to 1 under HKEY_LOCAL_MACHINE\ SOFTWARE\Microsoft\MSMQ\
Parameters. For more information, see Knowledge Center article CTX248554.

4. Complete this step if you use MSMQ over HTTP or HTTPS.

(Skip if this step is done) Create a host record for the Citrix ADC VIP address on the domain con-

troller.
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@

7, DNS Manager *
File  Action View Help
= D XE = Bm § 8
2 [ENS Name Type Data Timestamp
v & Lsnc ——_Lmsdcs
~ || Forward Lockup Zones j sites
-| _msdes.lb.com j_t(p
- | Ib.com -
| Reverse Lookup Zones j’Udp
Trust Points jDomamDnsZones
| Conditional Forwarders jFD'EStD”SZDHES
E—|(same as parent folder) Start of Authority (SOA) [47], Ibdc.lb.com., hostma...  static
E—l(sameas parent folder) Mame Server (MN5) lbdc.lb.com. static
[—l (same as parent folder) Host (4) 10.63.32.62 11/19/2020 2:00:00 AM
i Host (A) 10.63.32.82 static
Host (A) 10.63.32.1 11/19/2020 11:00:00 PM
10.63.32.60
Host (A) 10.63.32.55 11/19/2020 2:00:00 AM
Host (A) 10.63.32.68 11/19/2020 11:00:00 PM
Host (A} 10.63.32.91 11/23/2020 3:00:00 AM
Elrsvoa Host (A} 10.63.32.215 11/23/2020 2:00:00 AM

Oneach Session Recording Server,runthepowershell.exe -file SrServerConfigurationSyn

.psl -Action AddRedirection - ADCHost <ADCHost> command to add redirec-
tions from Citrix ADC to the local host. <ADCHost> isthe FQDN of the Citrix ADC VIP address. A
redirection file, for example, sr_1b_map.xmlis generated under C: \Windows\System32

\msmg\Mapping.

E¥ Administrator: PowerShell

1b_map.xml

er.lb.com

Note: Change to the folder where SrServerConfigurationSync.ps1 resides when you

run PowerShell.exe.

Type the FQDN of your Citrix ADC VIP address in the Session Recording Server box. For exam-
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ple:
.E,'-J Session Recording Agent Properties — »

Recording Connections

Session Recording Server: NetScalerb.com

Session Recording Storage Manager message queue

Pratocaol: HTTP ~
HTTR/HTTPS port: Default w
Port Number:

Message life specifies the peried during which data remains in the
MESSage queLe.

Message life (seconds):

Session Recording Broker

Protocol: HTTPS v
HTTR/HTTPS port: Custom w
Port Mumber:

Conoe | [ opy

Step 5: Configure an existing Session Recording Player to support load balancing

On each machine where you installed the Session Recording Player component, add the Citrix ADC
VIP address or its FQDN as the connected Session Recording Server.

Step 6: Check whether load balancing works for the configured, existing Session
Recording Server

1. Launch a Citrix virtual session.
2. Check whether the session can be recorded.

3. Check whether the web player and the Session Recording Player can play back the recording
file.

Step 7: Add more Session Recording Servers

1. Prepare a machine in the same domain and install only the Session Recording Server and Ses-
sion Recording Administrator Logging modules on the machine.
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Citrix Virtual Apps and Desktops 7

¥ Licensing Agreement
v Core Components
Features
Database and Server
Administrator Logging
Summary
Install

Finish

Features

4

Feature (Select all)

Session Recording Palicy Cansale
Citrix Session Recording Policy Console

Session Recording Server
Citrix Session Recording Broker and Storage Management

Session Recording Administrator Logging
Administrator L
itie

ng captures Session R
to the Session Re

recording ac

Session Recording Database
Citrix Session Recording Database

Back I

Mext

|  Cancel

Server configuration changes and

2. Use the same database names as the existing Session Recording Server. For example:
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Citrix Virtual Apps and Desktops 7
Administrator Logging Configuration

¥ Licensing Agreement Specify Session Recording logging configuration
" Core C onents
e Configuration

+ Features
The Administrator Logging database is installed on the SQL Server instance:

+ Database and Server

SRS0L
Administrator Logging
Summa
i Administrator Logging database name:
Install
| CitrixSessionRecerdinglogging
Finish

Test connection...

Enable Administrator Logging

<

This option enables the Session Recording Administrator Logging service,

Enable mandatary blacking
This option blocks pelicy and server property changes if logging fails.

Back | " Next | Cancel

3. Disable the network firewall on the machine.

4. On the SQL Server where you installed the Session Recording Database, add all the Session
Recording Server machine accounts to the shared Session Recording Database and assign them

with the db_owner permission. For example:
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Lt); Microsoft SOL Server Management Studio (Administrator)

File Edit View Debug Tools Window Help
= | " - - o | a2 New Cuery P I o | - - | b | Generic Debugger -
gl v X @ Database User - LB\SRSERVER2S - o x
Connect~ ¥ *¥ (VIS P T sert = © Hob
= i@ SRSOL (SOL Server 14.0.900.75 - LB\ = »
=] Databases & Owned Schemas
Systern Databases & Membership User type:
Database Snapshots F Securables Windows user
= i@ CitrixSessionRecording # Edended Propet
Database Diagrams User name:
Tables LB\SRSERVER2S | |
Views Login name:
External Resources WVEHZ‘ ‘
Synonyms -
Programmability
Service Broker
Storage Default schema:
=] Security I |db° I
= Users
&3 dbo
&7 guest ‘Connechon
&2 INFORMATION_S Server:
ﬁ LBASRSERVER1S SRSAL
&3 LB\SRSERVER2S Connection:
&9 LB\SRSERVER3S LB'administrator
& oy ¥ View connection properties
Roles
Schemas
Asymmetric Keys
Certificates Progress
Symmetric Keys Ready
Always Encrypted Ke
Database Audit Speci
Security Policies
W CitrixSessionRecordingLoggi
Security - e
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W Database User - LB\SRSERVER2S — O x

Selecta page IT Script ~ @) Help
& General

& Owned Schemas
y 2 Database role membership:
& Securables Role Members

& Edended Properties

db_accessadmin

- db_backupoperator
db_datareader
db_datawriter
db_ddladmin
db_denydatareader
db_denydatawriter
db_owner I
db_zecurtyadmin

Odupooooon

Connection

Server:
SRSGL

Connection:
LB administrator

ﬁ View connection properties

Progress
Ready

Cancel

5. Share the Read/Write permission of the recording storage and restore folders, for example,
SessionRecording and SessionRecordingsRestored, with the machine account
of the new Session Recording Server, for example, LB\SRServer2$. The dollar sign $ is
required.

6. Repeat Step 3 to add load balancing services for the new Session Recording Server and edit
existing virtual servers to add bindings to the load balancing services. There is no need to add
more virtual servers. For example:
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Cifrix. ADC VPX (1000)

DEELEL Configuration Reporting Documentation Downloads
Q Search in Menu Traffic Management / Load Balancing / Servers
System
Servers @
AppExpert
I Traffic Management W Select Action w
Load Balancing w

re to search or you can ent:

Virtual Servers

. NAME STATE IPADDRESS / DOMAIN
Services

srv-1 @®ENABLED 1063.3255
Service Groups @ @ ! -

. @ENABLED 10633274
Monitors

Metric Tables o=l
Servers

Persistency Groups

Radius Nodes (

cifrix ADbcvex (1

Dashboard Configuration Reporting Documentation Downloads

Q Traffic Management / Load Balancing / Services / Services
System .
Services
AppExpert
ITmmc Management ~ Services )  Auto Detected Services 0 Internal Services | 6
Load Balancing o

Virtual Servers

Service Chaining

User

Services
Service Groups NAME SERVER STATE IP ADDRESS/DOMAIN NAME PORT PROTOCOL
Menitors srv-1-80 eupP 10633255 80 TcP
Metric Tables srv-1-443 eurP 1063.3255 443 TCP
Servers srv-1-1801 eUuP 10633255 1801 TCP
Persistency Groups eup 10.63.32.65 22334 TCP
Radius Nedes @ euP 1063.32.74 443 TCP
Priority Load Balancing \I\ > oupP 1063.32.74 80 CcP
Content Switching \1\ > eouP 10633274 1801 CcP
Cache Redirection @ > srv-2-22334 ®UuP 10633274 22334 TCP
DNS > Total 8
GsLe @ >
ssL 3
Subscriber >
>
>
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cifrix ADC VPX (1000)

Dashboard Configuration Reporting Documentation Downloads

Q1 Search in Menu Traffic Management / Load Balancing / Virtual Servers

System

Virtual Servers

AppExpert >

<

ITraﬁicManagemenl | Add | | Edit | ‘ Delete | ‘ Disable | | Rename | ‘ Statistics | | Select Action ~

Load Balancing i

Q Click here to search or you can er

NAME STATE EFFECTIVE STATE IP ADDRESS

:Value format

Services

vsrv-80 L JUY euP 10.63.32.60
Service Groups

. vsrv-1801 eup eUP 10.63.3260
Monitors

vsrv-443 L JUS euP 10.63.3260
Metric Tables

Servers vsrv-22334 euP euP 10.63.32.60

Persistency Groups Total 4

Radius Nodes

Priority Load Balancing

Content Switching

Cache Redirection

DNS

GSLB

SSL
Subscriber

Service Chaining

=)
R N N VIV VR

User

Optimization >

Qarnritu ~
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Load Balancing Virtual Server Service Binding

SERVICE NAME IP ADDRESS PORT PROTOCOL
srv-1-22334 10.63.32.55 22334 TCP
srv-2-22334 1063.3274 22334 TcP

7. Copythe Session RecordingAuthorization Console configurationfile, SessionRecordingAzManStore
. xm<l, from the existing Session Recording Server to the new Session Recording Server. The
filelivesin <Session Recording Server installation path>\App_Data.

8. Touse MSMQ over HTTP or HTTPS for the new Session Recording Server, complete the following
steps to import registry settings of the currently functioning Session Recording Server.

On the existing Session Recording Server, for example, SRServerl, run the powershell
.exe —file SrServerConfigurationSync.psl -Action Export — ADCHost

<ADCHost > command, where <ADCHost> is the FQDN of the Citrix ADC VIP address. An
exported registry file, SrServerConfig. reg, is generated.

Copy the SrServerConfig.reg file to the new Session Recording Server and run the
powershell.exe -file SrServerConfigurationSync.psl -Action Import
,AddRedirection — ADCHost <ADCHost> command. The EnableLB value is added
to the registry key of the new Session Recording Server at HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server and a sr_1lb_map.xml file is added
under C: \Windows\System32\msmg\Mapping.

9. Repeat the procedure to add another Session Recording Server.
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Troubleshoot
+ Sessions are not recording when you use a CNAME record or an ALIAS record for a Session
Recording Server. For more information, see Knowledge Center article CTX248554.

+ Recording files can be stored locally but cannot be stored in a Universal Naming Convention
(UNC) path. To address thisissue, change the start mode of the Citrix Session Recording Storage
Manager service to Automatic (Delayed Start).

Deploy and load-balance Session Recording in Azure

June 10, 2021

Prerequisites

« You already have Citrix Virtual Apps and Desktops installed in Azure.
+ You have an Azure account.

Step 1: Upload the Citrix Virtual Apps and Desktops installer to Azure
Note:

Skip Step 1 if you use your Citrix account credentials to access the Citrix Virtual Apps and Desk-
tops download page and download the product ISO file to a VM in Azure.
1. Inthe Azure portal, create a general-purpose v2 storage account and accept the default perfor-

mance tier, Standard.

All access to Azure Storage goes through a storage account.
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A\ Create storage account - Micros: X +

&« (&} & portal.azure.com/#create/Microsoft.StorageAccount

Microsoft Azure R Search resources, services, and docs (G+/)

Home > Storage accounts >

Create storage account

AR LA U L YA L LA U VA [ YA 1 IS S I 0§ IR R LA Ry Al L A LAy S URA ARy S i

redundant. Azure Storage includes Azure Blobs (objects), Azure Data Lake Storage Gen2, Azure Files, Azure Queues, and Azure
Tables. The cost of your storage account depends on the usage and the options you choose below.
Learn more about Azure storage accounts '

Project details

Select the subscription to manage deployed resources and costs. Use resource groups like folders to organize and manage all
yaur resources.

Subscription * ‘ cse-dev-03-ca ~ |

Resource group * ‘ ~ |

Create new

Instance details

The default deployment model is Resource Manager, which supports the latest Azure features. You may choose to deploy
using the classic deployment model instead. Choose classic deployment model

Storage account name * (1) ‘ |

Location * | (s) East us v |
performance (D @ Standard O Premium

Account kind O ‘ StorageV2 (general purpose v2) v |
Replication ® { Read-access geo-redundant storage (RA-GRS) % I

< Previous Next : Networking >

https://portal azure.com/#

2. Navigate to your new storage account and select Containers in the Blob service section to cre-
ate a container.
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= Microsoft Azure P Search resources, services, and docs (G+/)

D& ®z 2 0

ome > (D
= I | Containers  # -

Storage account
| « + Container

Search containers by prefix

O Search (Ctrl+/) v O Refresh

‘Access keys
® Geo-replication
@ CORs

Name Last modified

& Configuration You don't have any containers yet. Click '+ Container' to get started.
A Encryption

@ Shared access signature

“§ Networking

O security

@ Static website

1! Properties

A Locks

Blob service
B Custom domain
@ Data protection
& Object replication
& Azure CON

3  Add Azure Search

3. Upload the Citrix Virtual Apps and Desktops installer to the container.

(J Show deleted containers

Public access level Lease state

= Microsoft Azure P Search resources, services, and docs (G+/) e [‘9 b ? ©
Home > yuchunjstg1 > Upload blob x
fa— yuchunblob/
Container Files O
\p Search (Ctrl+/) \ « T Upload (& Change accesslevel () Refresh Ti] Delete 2 Change't & Acquir o \"Citﬂ'x,V‘ﬂuaLApPs,aﬂd,DesktOPs,.» \E
1 Overview Authentication method: Access key (Switch to Azure AD User Account) (] overwite i files already exist
Location: yuchunblob
A2 Access Control (IAM)
4 v Advanced
Search blobs by prefix (case-sensitive) J (
Settings
@ Shared access signature Name Modified Access tier Blob type Size m
pload
Access policy No results
1l Properties
O Metadata

Step 2: Create a SQL managed instance in the Azure portal

For more information, see Create an Azure SQL Managed Instance.

Step 3: Create Azure virtual machines (VMs)

Choose Windows Server 2019 Datacenter —Gen1 for the image and Standard_D4as_v4 -4 vcpus,
16GiB memory for the size. For more information, see Create a Windows virtual machine in the Azure

portal.
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c

@ portal.azure.com/#create/Microsoft.VirtualMachine

Microsoft Azure

R Search resources, services, and docs (G+/)

All services > Virtual machines >

Create a virtual machine

Select the subscription to manage deployed resources and costs. Use resource groups like folders to organize and manage all

Your resources.

Subscription * ([ | cse-dev-03-ca v ‘
Resource group * @ | (New) Resource group N ‘

Create new

Instance details

Virtual machine name * (O | ‘

Region * @ | ws)eastus v |

Availability options () | No infrastructure redundancy required ~ ‘

Image * (@ l [ windows Server 2018 Datacenter - Gen' ~ ]
See all images

Azure Spot instance (O D

Size * (1) | Standard_D4s_v3 - 4 vcpus, 16 GiB memory ($83.22/month) .
See all sizes

Administrator account

Username * (1) I

Review + create < Previous ‘ Next : Disks >
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Step 4: Remote desktop and download the Citrix Virtual Apps and Desktops installer to
the Azure VMs

= iosorsare [T DG ®a 2 ©

— X

T Upload (3 Change accesslevel () Refresh [i] Delete 2 Change tier & Acquire lease

A Access Control (IAM)
O Show deleted blobs

Settings
Name Modified Access tier Blob type size Lease state

Y Citrix_Virtual_Apps_and_Desktops_7_2012iiso 3/4/2021, 6:37:47 PM Hot (Inferred) Block blob 48

£ Create snapshot

2 Change tier

& Acquire lease

[ii] Delete

Step 5: Run the installer to install Session Recording components on the Azure VMs

For more information, see Install the Session Recording Administration components.

Step 6: Configure an Azure file share to store recordings

To create an Azure file share to store recordings, complete the following steps:

1. Inthe Azure portal, create a storage account and then create an Azure file share.

For a quick start guide, see Create and manage Azure file shares with the Azure portal. The
following table recommends configurations for your consideration.

Number of Session
Recorded Recording Session
Recording File  Sessions Per File Share File Share Server Recording
Size MB/hour  Day Type Quota (TB) Quantity Server Size
<6.37 <1,000 HDD Standard 2 1 Standard
(StorageV2) D4as_v4
<6.37 1,000-2,000 SSD Premium 3 1 Standard

D4as_v4
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Number of Session
Recorded Recording Session
Recording File  Sessions Per File Share File Share Server Recording
Size MB/hour  Day Type Quota (TB) Quantity Server Size
<6.37 2,000-3,000 SSD Premium 5 1 Standard
D4as_v4
<6.37 3,000-4,000 SSD Premium 6 1 Standard
D4as_v4
Approx.10 <1,000 HDD Standard 3 1 Standard
(StorageV2) D4as_v4
Approx.10 1,000-2,500 SSD Premium 6 1 Standard
D4as_v4
Approx.10 2,500-4,000 SSD Premium 10 2 Standard
D4as_v4

The file share quota is calculated based on eight hours per day, 23 working days per month, and

a one-month retention period for each recording file.

2. Add the Azure file share credentials to the host where you installed the Session Recording

Server.

a) Start a command prompt as an administrator and change the drive to the <Session
Recording Server installation path>\Bin folder.

By default, the Session Recording Serverisinstalledin C: \Program Files\Citrix\
SessionRecording\Server.

b) Run the SsRecUtils.exe -AddAzureFiles <storageAccountName> <fileShareName>
<accesskey> command.

Where,

+ <storageaccountname> is the name of your storage account in Azure.

« <filessharename> is the name of the file share contained within your storage
account.

+ <accesskey> is your storage account key that can be used to access the file share.

There are two ways to obtain your storage account key:

+ You can obtain your storage account key from the connection string that appears
when you click the Connect icon in your file share page.
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1docs (G+/)

& sessionrecordings
SMB File share

& Overview

82 Access Control (IAM)
Settings

i Properties
Operations

4 snapshots

& Backup
Monitoring

Al Metrics

T upload -+ Add directory

Connect X

sessionrecordings

A\ Secure transfer required is enabled on the storage account. SMB clients connecting to this
share must support SMB protocol version 3 or higher in order to handle the encryption
Click here to learn more.

[ search files by prefix

Name

No files found.

Windows  Linux  macOS

To connect to this Azure file share from Windows, choose from the following
authentication methods and run the PowerShell commands from a normal (not elevated)
PowerShell terminal:

Drive letter
[z v

Authentication method
QO Active Directory

@ Storage account key
@ Connecting to 2 share using the storage account key is only appropriate for admin access.

Utilizing Active Directory allows to differentiate file and folder access, per AD account,
within a share. Learn more

$connectTestResult = Test-NetConnection -ComputerName
sremdstg.file.core.windows.net -Port 445
if (SconnectTestResult.TepTestSucceeded) {

# Save the password so the drive will persist on reboot

s
I/pass: Dsjcr\mmkﬂgGZU 18W0e + id6p7xX11eq|

7 D

This script will check to see if this storage account is accessible via TCP port 445, which is
the port SMB uses. If port 445 is available, your Azure file share will be persistently
mounted. Your organization or internet service provider (ISP) may block port 445, however
you may use Azure Point-to-Site (P2S) VPN, Azure Site-to-Site (S25) VPN, or ExpressRoute
to tunnel SMB traffic to your Azure file share over a different port.

Learn how to circumvent the port 445 problem (VPN)

+ You can also obtain your storage account key by clicking Access keys in the left navi-

gation of your storage account page.
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Home > sremd > -
DT Access keys

Storage account

L Search (Ctrl+/) | « Use access keys to authenticate your applications when making requests to this Azure storage account. Store your access b
keys so that you can maintain connections using one key while regenerating the other.

= Overview

When you regenerate your access keys, you must update any Azure resources and applications that access this storage acc
Activity log
Storage account name

L Tags
| sremstg
£ Diagnose and solve problems
PR Access Control (IAM)
W Data migration keyl (D
Key

== Storage Explorer (preview)

| Dsjen/SOpzwPxhck TgGZUZtolhBA3PAOHE WO +19kuid6p7xX11egNMUOXkx7R352f2GHRFUZPIIFI 1 TvbE/A==

Settings

Connection string
| DefaultEndpointsProtocol=https;AccountNa me:_;Accou ntkey=Dsjcn/SOpzwPxhckjTgGZUZtolh8A3PADHSWDe+.

CORS
keyz ()

@

Confi ti
onfiguration Koy

=
& Encryption | O97VNcAmy +WpgFYYO6r30fMyaD20sSGGpJuBgfkDYv3Z27) 19TYOMbWFaz1N6nO81c2qF5IZ00VxqydmysO2A==

&

Shared access signature Connection string

%@ Networking | Deiau\lEndpDintsProtocol:https;AccountName:-,‘AccountKey:GQTVNcAmv—ngFYYOﬁrSOfMyaDZDsSGGpJuB;

@ Security
:|' Properties

E| Locks

File service

& File shares

Monitoring
@ insights
E plerts
¢) Mount the Azure file share to the host where you installed the Session Recording Server.
i. Open Session Recording Server Properties.
ii. Click Add on the Storage tab.
iii. Enterthe UNC pathinthe format of \\<storageaccountname>.file.core.windows.net\<filesshar:

Specify a subfolder under the file share to store your recording files. The Session
Recording Server then automatically creates the subfolder for you.
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!
)

Storage  Signing FRollover Playback MNotfications CEIP  Logging RE |+

Fecorded session files are stored in the directories specified. To store files
in & load-bzalanced manner, specify multiple directories across different
volumes.

File storage directories:

File Storage Directory

Enter a directory for storing recorded session files:

|er.file.co,le.windows.net'-sessionrecording'recon:lings | Browse. ..

Cancel

Specify a folder to temporarily store archived session recordings and make
them awvailable for playback.

Restore directory for archived files:

C:\SessionRecordings Restored Browse...

oK Cancel

iv. Click OKin the File Storage Directory dialog box.
v. Click Apply in the Session Recording Server Properties window.
vi. Click OK after Apply becomes grayed out.

vii. Click Yes when you are prompted to restart the Session Recording Storage Manager
service.

Session Recording Server Properties

The "Citrix Session Recording Storage Manager” service needs
to be restarted for changes to come into effect,

Do you wish to restart the service now?

Step 7: Add a load balancer

If there is more than one Session Recording Server, we recommend you add a load balancer in front
of them. Azure offers many options to load-balance traffic requests. This section walks you through
the process of creating Citrix ADC, Azure Load Balancer, and Azure Application Gateway in Azure.
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Option 1: Create a Citrix ADC VPX instance in Azure

1. Inthe Azure portal, type Citrix ADC in the search box.

2o i A0

Services Marketplace See all

Rece o \ivenrena Broadcast 9 Citrix ADC

B4 Citrix ADC 13.0 - Azure Stack
B Citrix ADC 121
B4 Citrix ADC VPX FIPS

Name Resources

it Viewed

No results were found.

]
<
z

2w seconds ago

) yu sw seconds ago
Documentation Seeall

= minutes ago

Tutorial: Azure Active Directory single sign-on ...

@ = minutes ago
Tutorial: Azure Active Directory integration with Citrix ..

& S8 Azure AD secure hybrid access | Microsoft Docs Rl2ge

&> SR Linux virtual desktops with Citrix - Azure Example . ay ago

() snt Resource Groups ay ago

<} 18 No results were found. reeks ago

= eeks ago

25 Didn find what you were looking for? i 9

() st @ 11y searching in Activity Log |

4> VN & Try searching in Azure Active Directory 10nth ago

(%) tin searching all subscriptions. Change fonth ago

Navigate

Subscriptions (%] Resource groups All resources Dashboard

2. Choose the Citrix ADC VPX Bring Your Own License plan and then click Create.

Home >

Citrix ADC »

Citrix

Citrix ADC < add to ravorites
CitrxX. oo

Azure benefit eligible o'

Selecta plan | Citrix ADC VPX Bring Your Own License

Overview  Plans  Usage Information + Support ~ Reviews

Citrix ADC is an enterprise-grade application delivery controller that delivers your applications quickly, reliably, and securely, with the deployment and pricing flexibility to
meet your business’ unique needs. Designed to provide operational consistency and a smooth user experience, Citrix ADC eases your transition to the hybrid cloud.

Why Citrix?

Citrix ADC offers high performance with fast application delivery, a ¢ system, and or and automation for
applications across cloud or hybrid environments for greater agilty. Citrix's all-in-one solution brings point solutions under one roof, ensuring simplicity and security every
step of the way.

Key Benefits:

* Flexible & Consistent: Citrix ADC is the most comprehensive, feature-rich ADC available across a wide variety of deployment options with the most flexible pooled
capacity licensing option in the industry.

o Best User Experience: Citrix is the only vendor to offer an intelligent, global load-balancing service that uses real-time Internet traffic and data center health to route
users to the best source for their applications and content.

* Integrated App Security: A single code base across physical, virtual, bare-metal, and containers enables consistency across your applications and workflow.
Comprehensive application security with Layer 3 to Layer 7 protection and built-in API protection ensures you don't have to worry about vulnerable assets.

- A e A

3. Select or create a resource group and set the other settings on the Basics tab.

4. Set VM configurations.
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A Crestz Citrix ADC - Microsoft Az X 4=

« (&) 8 portal.azure.com/#create/citrix.netscalervpx-Tvm-3nicnetscalervpx-1vm-3nic-byol

= Microsoft Azure L Search resources, services, and docs (G+/)

Home > Citrix ADC >

Create Citrix ADC

A Changes on this step may reset later selections you have made. Review all options prior to deployment.

L]
Basics VM Configurations  Network and Additional Settings Review + create

Virtual Machine Configurations

Virtual machine size * (O 1x Standard DS3 v2
4 vcpus, 14 GB memory
Change size

05 disk type (D ‘0‘ Premium_LRS

Assign Public IP (Management) © (®) Yes

Assign Public IP (Client traffic) O (®) Yes
Unique public IP domain name suffix * (O | d28e81a280 v
Azure Monitoring Metrics (0 O Enabled
(®) Disabled
Backend Autoscale (0 O Enabled
(®) Disabled

| < Previous | | Next : Network and Additional Settings >

5. Check and modify network settings if necessary. Choose ssh (22), http (80), https (443) for
public inbound ports.

Avirtual network is automatically created. If you already have a Session Recording environment
installed, you can use its virtual network and server subnet settings.
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Microsoft Azure £ search resources, services, and docs (G+/)

Home > Citrix ADC >

Create Citrix ADC

Configure virtual networks

Virtual network * (O | (new) citrix-adc-vpx-virtual-network ~ ‘
Create new

Management Subnet * (O | (new) 01-management-subnet (10.1.25.0/24) ~ ‘

Cliert Subnet * () [ new) 11-client-subnet (10.1.29.0/24) v

Server Subnet * (@ | (new) 12-server-subnet {10.1.30.0/24) ~ ‘

Public IP (Management)

Management Public IP (NSIP) * (D) | (new) citrix-adc-vpx-nsip ~ ‘
Create new
Manzgement Domain Name (O | citrix-adc-vpx-nsip-23f12ee6b2 \/‘

.eastus.cloudapp.azure.com

Public IP (Clientside)

Clientside Public IP (VIP) * (&) | (new) citrix-adc-vpx-vip s ‘
Create new
Clientside Domain Name (& | citrix-adc-vpx-vip-23f12eesb2 \/‘

.eastus.cloudapp.azure.com

Public Inbound Ports (Management only)

Ports open for Management public IP () O None

O ssh2)

(®) ssh (22), http (20), htps (443)

Review + create | < Previous | | Next : Review + create >
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= Microsoft Azure 2 Search resources, services, and docs |

Hoeme > Citrix ADC >

Create Citrix ADC

Basics VM Configurations MNetwork and Additional Settings Review + create

Boot diagnostics

Diagnostic storage account * (D (new) citrixadcvpred2bdbe259 v

Create New

Network Settings

Configure virtual networks

Virtual network * (& | (new) citrix-adc-vpx-virtual-network ~ |
Create new

Management Subnet * @O | (new) 01-management-subnet (10.1.32.0/24) ~ |

Client Subnet * (@ | (new) 11-client-subnet (10.1.33.0/24) v |

Server Subnet * (@ | (new) 12-server-subnet {10.1.34.0/24) ~ |

Accelerated Networking

Accelerated Metworking (Management @ On
Interface) @ O o

Accelerated Metworking (Client Interface) @ on

@ O of
Accelerated Networking (Server @ on
Interface) @ O off
Public IP (Management)
Management Public IP (NSIP) * (@ | (new) citrix-adc-vpx-nsip ~
Cronto moaa

Review + create | < Previous | | Next : Review + create > |

6. Click Next: Review + create to create the Citrix ADC VPX instance and wait for the deployment
to complete.
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= Microsoft Azure £ Search resources, services, ai

Home > Citrix ADC >

Create Citrix ADC

G Walidation Passed

Basics VM Configurations Metwork and Additional Settings Review + create

PRODUCT DETAILS

Citrix ADC
by Citrix
Terms of use | Privacy policy

TERMS

By clicking "Create", | (3) agree to the legal terms and privacy statement(s) associated with the Marketplace offering(s)
listed abave; (b) authorize Microsoft to bill my current payment method for the fees associated with the offering(s),
with the same billing frequency as my Azure subscription; and (<} agree that Microsoft may share my contact, usage
and transactional information with the provider(s) of the offering(s) for support, billing and other transactional
activities. Micrasoft does not provide rights for third-party offerings. See the Azure Marketplace Terms for additional

details.

Basics

Subscription cze-dev-03-ca
Resource group srcmdtest

Region East US

Citrix ADC Release Version 13.0

License Subscription Bring Your Own License
Virtual Machine name citrix-adc-vpx
Username nsraot

Password P

VM Canfinuratinns

Create < Previous MNext Download a template for automation

7. Setthe subnet IP (SNIP) address and the Citrix ADC VIP address to be on the same subnet.

The SNIP address and the VIP address must be on the same subnet. In this example, we set the
VIP address to be on the subnet of the SNIP address.

a) Stop the citrix-adc-vpx virtual machine.

b) Change the subnet of the VIP address.
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Microsoft Azure

citrix-adc-vpx-nic11

citrix-adc-vpx-nic11 | IP configurations

Network interface

Home > srib )|

[0 search (ctri+n | « 4 ad & X
@ Overview IP forwarding settings
@ Activity log 1P forwarding
"R Access control (IAM) Virtual network
@ Tags

IP configurations
Settings

B2 DNS servers

@ Network security group

£ adc

O Refresh

Enabled)

srazureautovnet

@ The associated virtual machine ‘citrix-adc-vpx' must be either stopped or deallocated in order to be able to edit the subnet.

" .
i1l Properties -
‘ P search IP configurations
B Locks .
Name IP Version Type
Automation vip 1Pv4 Primary

.f. Tasks (preview)

5 Export template

Support + troubleshooting
= Effective security rules
© Effective routes

R New support request

Private IP address Public IP address

192.168.2.4 (Dynamic) Unassigned (citrix-adc-vpx-vip)  ***

Home > srlb > citrix-adc-vpx-nicl1

citrix-adc-vpx-nic11 | IP configurations

Network interface

2 search (Ctrl+) « -+ Add

@ overview

X Discard O Refresh

@ Activity log

A Access control (IAM)

@ Tags 1P forwarding settings
IP forwarding

Settings

s Virtual network
& IP configurations

=

&= DNS servers IP configurations

A\ The virtual machine associated with this network interface will be restarted to utilize the new subnet.

Enabled :'

srazureautovnet

@ Network security group Subnet * srazureautosubnet (192.168.1.0/24)
il Properties
2 search IP configurations
B Locks K i i
Name IP Version Type Private IP address Public IP address
Automation vip IPv4 Primary 192.168.2.4 (Dynamic) Unassigned (citrix-adc-vpx-vip)

2 Tasks (preview)

5 Export template
Support + troubleshooting
= Effective security rules

< Effective routes

8 New support request

c) Start the citrix-adc-vpx virtual machine

Option 2: Create an Azure load balancer

Azure Load Balancer is a TCP passthrough service. The following diagram shows load balancing

through TCP passthrough.
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sricpruled43

4 ,

LoadBalancerFront...

\ — L

, /

\“\grtcpru le SQ]’"

1. Create an Azure load balancer.

SRBackendPool

SR-Server

- srtcprule22334

bt

SR-5erver?2

a) Search in the Azure portal and select Load Balancers from the Marketplace.

= Microsoft Azure £ load balancer

Bl & Q

Services

Azure servic
&» Load balancers
+ [ Load balancing - help me choose (Preview)
Creat & Application gateways
resource @ Front Doors

(@ Web Application Firewall policies (WAF)

# CloudAMQP
Recent resot
# CloudMonix

Name & Workload Insights

@ srappGvi | = CloudSimple Nodes

&S CloudSimple Services
() yuchunjiang

& SRLoadBalan ReseUrees

No results were found,
4> SRVnet

() srtest Didn't find what you were looking for?
& LB-hubtest-T B Try searching in Activity Log

— B Try searching in Azure Active Directo
= asfazuretests 9 Y

() srazureauto | Searching all subscriptions. Change

4-> VNet-hubtest

Seeall Marketplace

B3 KocSistem Azure Load Balancer Management
9 Load Balancer / ADC
Y aiScaler Load Balancer & Site Acceleration

£ Ishlangu Load Balancer ADC IS-5000 (5Gbps)
Documentation

Load Balancer | Microsoft Docs
What is Azure Load Balancer? - Azure Load Balancer

Azure Load Balancer concepts | Microsoft Docs

Quickstart: Create a public load balancer - Azure portal .

Resource Groups

No results were found

Virtual network

YuchunJiang@citrix.com 7 |
amrix

& 2?2 O

See all

%

More services

Seeall

amonth ago

On the Basics tab of the Create load balancer page, configure settings as described in the

following table:

Setting

Value

Subscription
Resource group
Name

Region

Type

SKU

Select your subscription.

For example, select sribtest created earlier.

Enter SRLoadBalance.
Select (US) East US.
Select Internal.

Select Standard
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Setting

Value

Virtual network

Subnet

IP address assignment

Availability zone

For example, select srazureautovnet created
earlier.

For example, select srazureautosubnet created
earlier.

Select Dynamic.

Select Zone-redundant.

e e e e

Home >

Create load balancer

1S accessible via public IV addresses, or Internal wnere It 1s only accessible from a virtual network. Azure 10ad balancers alse
support Network Address Translation (MAT) to route traffic between public and private IP addresses. Learn more.

Project details

Subscription *

L

Resource group *

Instance details

Mame *
Region *
Type* ©

SKU* @

Configure virtual network.

Virtual network * (@

Subnet *

IP address assignment *

Availability zone * @

Review + create < Previous

| cse-dev-03-ca ~ |
| sribtest ~ |
Create new

| SRLoadBalance \/|
[ Ws) gastus v |

o Standard Load Balancer is secure by default. This means Network Security
Groups (N5Gs) are used to explicitly permit and whitelist allowed traffic. If you
do not have an NSG on a subnet or NIC of your virtual machine resource,
traffic is not allowed to reach this resource. Please configure an NSG to ensure
communication if needed. For outbound communication, an explicit
outbound rule is needed. Learn more about outbound connectivity cf

| srazureautovnet e |

| srazureautosubnet (192.168.1.0/24) o |
Manage subnet configuration

O Static @ Dynamic

| Zone-redundant ~

Next : Tags > Download a template for automation

b) Add load balancerresources, including a back-end pool, health probes, and load balancing

rules.

« Add a back-end pool.
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Select the load balancer you created from the resources list and click Backend pools

in the left navigation. Click Add to add a back-end pool.

2 BTN (]

SRLoadBalance | Backend pools

Load balancer

2 search (Ctrl+/) «

€ Overview

Backend pool Virtual machine Virtual machine status

Activity log

A Access control (IAM) No results
€ Tags

£? Diagnose and solve prablems
settings

Frontend IP configuration

T Health probes

= Load balancing rules

B inbound NAT rules

il Properties

6 Locks

Monitoring

B Alerts

fifi Metrics

@ Insights

Automation

i3 Tasks (preview)

E Export template

Enter a name for the new back-end pool and then click Add.

Network interfact

Home > SRLoadBalance >

Add backend pool

SRLoadBalance

|

Name * | | SRBackendPoal I o
|

Virtual network (® srazureautovnet (sribtest)

1P version @ IPvad.

O v

Virtual machines

You can only attach virtual machines in eastus that have a standard SKU public P configuration or no public 1P configuration.
All 1P configurations must be on the same virtual network.

Virtual machine Ty IP Configuration Ty Availability set Ty

No virtual machines selected

Virtual machine scale sets

Virtual Machine Scale Sets must be in same location as Load Balancer. Only IP configurations that have the same SKU
(Basic/standard) as the Load Balancer can be selected, All of the IP configurations have to be in the same Virtual Network,

@ No virtusl machine scale set is found in eastus that matches the above criteria
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+ Add health probes.

Select the load balancer you created from the resources list and then click Health

probes in the left navigation.

p il e I e

Home > SRLoadBalance

® SRLoadBalance | Health probes

Load balancer

P Search (Ctrl+/) « t add

& overview |;) Search probes

Activity log Name Ty Protocol Ty Port
Ao, Access control (1AM) No results,

€ Tags

. Diagnose and solve problems
Settings

& Frontend IP configuration

% Backend pools

Y= Load balancing rules

B inbound NAT rules

il Properties

E| Locks

Monitoring
BN Alerts
fil Metrics
P Insights

Automation

% Tasks (preview)

F Export template

Support + troubleshooting

Click Add to add health probes on ports 80, 22334, 1801, and 443.

= Microsoft Azure P Search resources, services, and docs (G+/)

Home > SRLoadBalance

® SRLoadBalance | Health probes

Load balancer

[ search (cui+n | « 4 add O refresh
Settings =
o .2 Fiter by name.

B Frontend IP configuration Name protocol
%/ Backend pools

SRHealthProbe1801 Tcp
! Hesliprebes SRHealthProbe22334 Tcp
%= Load balancing rules

SRHealthProbed43 e
B inbound NAT rules

SRHealthProbeg0 Tcp

I} properties

B Locks
Monitoring

@ Diagnostic settings
# Logs

B alerts

i Metrics

@ Insights
Automation

s Tasks (preview)

) Exoort temolate

Used By

SRICPRule1801

SRICPRule22334

SRICPRule443

SRICPRule80

For example, use the following settings to create a health probe on port 80.

Value

Setting

Name

Enter SRHealthProbe80.
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Setting Value

Protocol Select TCP.

Port Enter 80.

Interval 5

Unhealthy threshold Select 2 for the number of unhealthy threshold

or consecutive probe failures that must occur
before a VM is considered unhealthy.

e e e

Home > SRlLoadBalance >

SRHealthProbe

SRLoadBalance

Save >< Discard f Delete

Name *
|l sreeatherobesd | /]

Protocol (i)
Tcp v

Port * n;w
|l 20
|
Interval * (@

[s |

seconds

Unhealthy threshold * @
[2 |

consecutive failures
Used by @
MNot used

+ Add a load balancing rule.

Select the load balancer you created from the resources list and then click Load bal-
ancing rules in the left navigation. Click Add to add a load balancing rule.
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e e e

Home > SRLoadBalance

v— SRLoadBalance | Load balancing rules
Y™ Load balancer

[ 2 search ctrl+) | « Add

& Overview |P Search load balancing rules

Activity log Name +4  Load balancing rule
Ao Access control (1AM} No results.

€ Tags

pa Diagnose and solve problems

Settings
B Frontend IP configuration
% Backend pools

T Health probes

Load balancing rules

Bl inbound NAT rules
Il Properties

E| Locks
Moenitoring

R plerts

fd Metrics

@ Insights
Automation

il. Tasks (preview)

5! Export template

Support + troubleshooting

Click Add to add load balancing rules for ports 80, 22334, 1801, and 443.

Home > SRLoadBalance

v= SRLoadBalance | Load balancing rules - X
™ Load balancer

O Search (Ctrl+/) « + Add

Settings " [P Search losd balancing rules

B Frontend IP configuration Name T4 Load balancing rule 14 Backend pool T4 Health probe N
® Backend pools SRTCPRule1801 SRTCPRule1801 (TCP/1801) ‘SRBackendPool SRHealthProbe1801

% Health probes SRTCPRule22334 SRTCPRule22334 (TCP/22334) SRBackendPool SRHealthProbe22334

&= ioed balending ruies SRTCPRule443 SRTCPRule443 (TCP/443) SRBackendPool SRHealthProbe443

B Inbound NAT rules SRTCPRule80 SRTCPRule80 (TCP/80) SRBackendPool SRHealthProbes0

11} Properties

B Locks

Monitoring

& Diagnostic settings
® Logs

W Alerts

fidl Metrics

@ Insights
Automation

S Tasks (preview)

) Export template

For example, use the following settings to create a load balancing rule for port 80.
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Setting

Name

IP Version

Frontend IP address
Protocol

Port

Backend port
Backend pool
Health probe
Session persistence
Idle timeout (minutes)
TCP reset

Outbound source network address translation
(SNAT)

Value

Enter a name, for example, SRTCPRule80.

Select IPv4.

Select LoadBalancerFrontEnd.
Select TCP.

Enter 80.

Enter 80.

Select SRBackendPool.

Select SRHealthProbe80.
Select Client IP.

Accept the default setting.
Select Enabled.

Select (Recommended) Use outbound rules to

provide backend pool members access to the

internet.

© 1999-2024 Cloud Software Group, Inc. All rights reserved.

254



Session Recording 2104

= Microsoft Azure P Search resources, services, and docs (G+/)

Home > SRLoadBalance >

Add load balancing rule

SRloadBalance

Name *

| srrceruleso |
| —
IP Version *

® pva (O 1pve

Frontend IP address * (0

| 182.168.1.22 (LozdBalancerFrontEnd) ~

[ Harorts @

Protocol
@ O uoe
Bart *
30 | |

Backend port * (D
[ | ]
Backend pool @

| SRBackendPool ~ |

Health probe @
| sRresithprobeso (e | v
1

Session persistence (@
| cientie | M
—_——

Idle timeout (minutes) &
o [+]

TCP reset

Floating IP @

z

+ Add the Azure VMs where the Session Recording Server is installed to the back-end

S

pool.
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e e e

Home > SRLeoadBalance

i SRLoadBalance | Backend pools

Load balancer

2 Search (Ctrl+/) | “ + add () Refresh

& overview
B Backend pool Virtual machine Virtual machine status
Activity log

SRBackendPool
Ao Access control (IAM)

¢ Tags

&2 Diagnose and solve problems
Settings

E Frontend IP configuration

1" Health probes

Y= Load balancing rules

B inbound NAT rules

ill eroperties

2 Locks

Monitoring

BB Alerts

Home > SRLoadBalance > Add virtual machines to backend pool
SRBackendPool

@ You can only attach virtual machines that are in the same location and on the same virtual network as the loadbalancer.
virt P

O 1p Adaress tandard SKU publc 1P or no publc P

IP Version P E—— Virtual network == SRVnet Resource group == all Availabity set == all
® 1pw
O [0 virtual machine 7, Resourcegroup T4 IP Configuration 14 Avallabllityset *  Tags Notes

O 1

O srsenverz

Virtual machines

You can only attach virtual machines in eastus that have a standard SKU public IP configuration or no put
AllIP configurations must be on the same virtual network

Virtual machine T4 1P Configuration 4 Avallability set T,

No virtual machines selected

Virtual machine scale sets

ation as Load Balances
e selected. All of the IP confi

@ o virtual machine scale setis found in eastus that matches the above criteria

Virtual machine scale set 1P address

‘ = e

c) Test the Azure load balancer.
If you cannot add a server to the back-end pool and the following error message appears
NetworkinterfaceAndLoadBalancerArelnDifferentAvailabilitySets, disassociate the
public IP address of the server network interface.
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— Microsoft Azure

Home » srlbtest » SR-Serverl-ip » sr-server172 >

ipconfigl

sr-server1 T2

Public IP address settings
Public IP address

i/ - - - -\.
(_ Disassociate .I

Public IP address *

SR-Serverl-ip (20.62.236.36) A
Craate new

Private IF address settings

Virtual network/subnet
srazureautowvnet/srazureautosubnet

Assignment

@D o)

F address

|

=2 ¥

[

Option 3: Create an Azure application gateway
Tip:
Application Gateway V2 does not support routing requests through an NTLM-enabled proxy.
1. Create an Azure application gateway.
Configure the following settings when you create an application gateway.

« Onthe Basics tab, set Tier to Standard.
« On the Frontends tab, set Frontend IP address type to Private. The new application
gateway is used as an internal load balancer.

2. Add a back-end pool.
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Home > SRAppGWV1 >

Edit backend pool

A backend pool is 2 collection of resources to which your application gateway can send traffic. A
backend pool can contain virtual machines, virtual machines scale sets, IP addresses, domain names, or
an App Service.

AGbackendpoo

A enapoo
Add backend pool without targets
N - )

Backend targets

2 items
Target type Target
IP address or FQDM 192.168.1.12 [ ==~
| IP address or FODN 182.168.1.18 I i .
| IP address or FOQDN v | | |

Associated rule

SRHttpRules0
SRHttpRuled43

3. Create HTTP settings.

Azure Application Gateway supports both HTTP and HTTPS for routing requests to back-end
servers. Create HTTP settings for ports 80, 443, and 22334.

« HTTP over port 80
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Home > SRApPGV1

v— SRAppGV1 | HTTP settings

Application gateway

Add HTTP setting p

HTTP settings name

ttpSetting80

2 Search (Ctrl+/) « + Add
K ACESs Conuon ) =

P Search HTTP settings
® Tags &

£ Diagnose and solve problems

Settings

& Configuration

Name Port

| SRHttpSetting80 80
SRHttpSetting443 443
SRHttpSetting22334 22334

@ Web application firewall
% Backend pools

Y= HTTP settings

B Frontend IP configurations
33 Listeners

= Rules

¥ Health probes

1l Properties

B Locks

Monitoring

KB Alerts

fill Metrics

B Diagnostic settings

« HTTP over port 443

Backend protocol
® wrre O wrres

8ackend port ¥
80

Additional settings
Cookie-based affinity ©
O Enable (®) Disable

Connection draining @

O tnable (@ pisable

Request time-out (seconds) * @
20 ‘

Override backend path ©

Host name

8y default, Application Gateway does not change the incoming HTTP host header from the client and sends the header
unaltered to the backend. Multi-tenant services like App service or APl management rely on a specific host header or SNI
extension to resolve to the correct endpoint. Change these settings to overwrite the incoming HTTP host header.

An authentication certificate is required to allow back-end servers in Application Gateway

V1. The authentication certificate is the public key of back-end server certificates in Base-

64 encoded X.509(.CER) format. Forinformation on how to export the public key from your
TLS/SSL certificate, see Export authentication certificate (for vl SKU).

Home > SRAppGV1

v= SRAppGV1 | HTTP settings

™ Application gateway

[2 seerch (ctrl+n « + Add
R A Conmon )

AP Search HTTP settings
@ Togs &

& Diagnose and solve problems

Settings

& Configuration

Name port
SRHttpSetting80 80
SRHttpSettingd43 443
SRHttpSetting22334 22334

@ Web application firewall
B/ Backend pools

7= HTTP settings

B Frontend IP configurations
22 Listeners

“ Rules

T Health probes

111 Properties

8 Locks

Monitoring

0 Alerts

fidl Metrics

& Diagnostic settings

Add HTTP setting

HTTP settings name

Backend prot
O wrP (@) HTTPS

Backend port *
443

Backend authentication certificate

For end-to-end SSL encryption, the backend must be whitelisted with the application gateway. Upload the public certificate of
the backend servers to this HTTP setting

Use for App service

O Yes ® No
Certificate
stlo

Additional settings
Cookie-based affinity ©
® enable O Disable
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S wvem i g G

Home > SRAppGV1

v— SRAppGV1 | HTTP settings

- Application gateway
[0 search (cu+ «  + add

R ALLess Lonuor gamy R

[P search HTTP settings

@ Tags

&2 Diagnose and solve problems

Add HTTP setting

Connection draining ©

(O Enable (®) Disable

Request time-out (seconds) * ©

Settings

& Configuration

[20
Name Port
Override backend path ©
SRHttpSetting80 80 ‘
[ SRHtpSetting443 443 J
Host name
SRHttpSetting22334 22334

@ Web application firewall
% Backend pools

= HTTP settings

& Frontend IP configurations
33 Listeners

L Rules

1 Health probes

1l Properties

B Locks

Monitoring

E Alerts

Metrics

B Diagnostic settings

« HTTP or HTTPS over port 22334

By default, Application Gateway does not change the incoming HTTP host header from the client and sends the header
unaltered to the backend. Multi-tenant services like App service or APl management rely on a specific host header or SNI
extension to resolve to the correct endpoint. Change these settings to overwrite the incoming HTTP host header.

rich

with new host name

Host name override
(®) Pick host name from backend target

(O Override with specific domain name

&.g. contoso.com

Use custom probe @
Yes (® No

e

If WebSocket uses HTTP, use the same setting as port 80.

If WebSocket uses HTTPS, use the same setting as port 443.

4, Add afront-end IP address.

DAStarh o v i o0 1)

Home > SRAppGV1

&5 SRAppGV1 | Frontend IP configurations

Application gateway

O Search (Ctrl+/) | « (L2 search frontend IP configurations
A ACLESS COnuo! Ay
Type Status
@ Tags
Public Not configured
2 Diagnose and solve problems
Private Configured

Settings
& Configuration

@ Web application firewall
% Backend pools

I= HTTP settings

B Frontend IP configurations
23 Listeners

L Rules

? Health probes

11l Properties

B Locks

Monitoring

R Alerts

Metrics

B Diagnostic settings

5. Add listeners.

appGwPrivateFrontendip 10.7.06

IP address Associated listeners

SRListener80, 2 more

Add listeners on ports 80, 443, and 22334, for example:
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rosoft Azure P Search resources, services, and docs (G+/)

Home > SRAPpGV1

53 SRAppGV1 | Listeners %

Application gateway

£ Search (Ctrl+/) « + Add listener () Refresh

2 ACtess Conon Ay
Application Gateway provides native support for WebSocket across all gateway sizes. There is no additional configuration required to enable or disable WebSocket support. If a WebSocket traffic is received on the

@ Tags Application Gateway, it is automatically directed to the WebSocket enabled backend server using the appropriate backend pool as specified in application gateway rules.

Learn more about listeners and WebSocket support.

[P Search listeners

£ Diagnose and solve problems

Settings Name Protocol Port Associated rule Host name
& Configuration SRListener80 HTTP 80 SRHttpRule80

@ Web application firewall SRListener443 HTTPS 443 SRHttpRule443

% Backend pools SRListener22334 HTTPS 22334 SRHttpRuIe22334

7= HTTP settings SSL Policy

& Frontend IP configurations The SSL policy defines the SSL protocol version and available ciphers. Choose from one of the predefined policies or create a custom security policy to match your organizational security requirements.

Learn more about SSL policy.
Selected SSL Policy
L Rules Default (change)

25 Listeners

¥ Health probes Min protocol version

" TLSvi0
11! Properties

Cipher suites

B Locks

TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
Monitoring TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256
W Alerts TLS_ECDHE RSA_WITH_AES_256_CBC_SHA384

TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256

Metrics
TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA

B Diagnostic settings - TLS ECDHE RSA WITH AES 128 CBC SHA

« Listener on port 80

Microsoft Azure 2 Search resources, services, and docs (G+/)

Home > SRAppGV1 >

SRListener80

SRAppGV1

SRListeners0

Frontend IP* (i)

| Private ~ |

Port* (&)

Associated rule
SRHttpRules0

Additional settings

TTerener ijpe @

@ Basig O Multi site

Error page url

O Yes @ No

« Listener on port 443

Create a self-signed certificate and upload the certificate to the Azure portal when you cre-
ate the HTTPS listener. For more information, see Certificates supported for TLS termina-
tion and Create a self-signed certificate.
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Home > SRAppGV1 >

SRListener443

SRAPPGVT

Frontend IP* (@)

Private = |
Port * (&)
443 /|

Protocol @

Choose a certificate
O Create new @ Select existing

Certificate ®

| Ibde v

\:' Renew or edit selected certificate

Associated rule
SRHitpRule443

Additional settings

TISTEmeT Tfpe (0

@ Basi O Multi site

Error page url

O Yes @ Mo

« Listener on port 22334

If WebSocket uses HTTP, use the same setting as port 80. If WebSocket uses HTTPS, use the
same setting as port 443. The following example shows the setting of an HTTPS listener
on port 22334.
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= Microsoft Azure ' Search resource

Home > SRAppGWV1 >

SRListener22334

SRAppGY1

SRListener22334

Frontend IP* (i)

| Private s |
Port* (@
| 22334 v|
Protocol @

HTTP HTTPS

Cheoose a certificate
O Create new @ Select existing

Certificate *
| Ibdc v

D Renew or edit selected certificate

Associated rule
SRHttpRule22334

Additional settings

Listener type (0

@ Basic O Multi site

Error page url

O Yes @ Mo

6. Create request routing rules.

Create rules for ports 80, 443, and 22334, for example:
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P Search rsoutces,sevioes and docs (G+1)

Home > SRARRGV1
53 SRAppGV1|Rules - X

Application gateway

[0 search (ctrt+n « =+ Request routing rule
A AGKESs CONUO! AN
[ 2 search rules

@ Tags
Name Type Listener
£ Diagnose and solve problems
SRHItpRuIe8O Basic SRListener80
Settings B
SRHttpRuledd3 Basic SRListenerd43
-
& Configuration SRHttpRule22334 Basic SRListener22334

@ Web application firewall
® Backend pools

Y= HTTP settings

B Frontend IP configurations
23 Listeners

£ Rules
1 Health probes
11} Properties
A Locks
Monitoring

B Alerts

fil Metrics

B Diagnostic settings

+ Routing rule for port 80
SRHttpRule80

SRAppGV1

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

SRHttpRules0

jes]
=
w
&

]
m

" Listener | *Backend targets

A listener “listens” on a specified port and IP address for traffic that uses a specified protocol. If the listener criteria are met,
the application gateway will apply this routing rule,

SRListeners0 ~

Listener *

SRHttpRule80

SRAppGV1

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

SRHttpRulesD

=
&
o
&
3
o

*Listener |*Backend targets

Choose a backend pool to which this routing rule will send traffic. You will also need to specify a set of HTTP settings that
define the behavior of the routing rule.

Target type @ Backend pool O Redirection
AGbackendpoal >
Backend target* @ | ackendpoo |
SRHitpsetting20 -
HTTP settings * (0 | 2 g |
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+ Routing rule for port 443
SRHttpRule443

SRAppGWV1

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

Rule name SRHttpRuled43

*Listener | *Backend targets

A listener “listens” on a specified port and IP address for traffic that uses a specified protocaol. If the listener critena are met,
the application gateway will apply this routing rule.

. i i
Listenar * SRListenerd43

SRHttpRule443

SRAppGV

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

n
[
=1
i
[
[

*Listener |*Backend targets

Choose a backend pool to which this routing rule will send traffic. You will also need to specify a set of HTTP settings that
define the behavior of the routing rule.

Target type @ Backend poal O Redirection

| AGbackendpool ~ |

Backend target * (O

. SRHttpSetting443 v
HTTP settings * @ | P J |

+ Routing rule for port 22334

SRHttpRule22334

SRAppGV1

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

Rule name SRHttpRule2

*Listener *Backend targets

A listener “listens” on a specified port and IP address for traffic that uses a specified protocal. If the listener criteria are met,
the application gateway will apply this routing rule,

- ~
Listener * SRListener22334

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 265



SRHttpRule22334

SRAPPGV1

Configure a routing rule to send traffic from a given frontend IP address to one or more backend targets. A routing rule must
contain a listener and at least one backend target.

e name SRHttpRule22334
*Listener *Backend targets

Choose a backend pool to which this routing rule will send traffic, You will also need to specify a set of HTTP settings that
define the behavior of the routing rule.

Target type @ Backend poal O Redirection
- AGbackendpool s
Backend target * @ | ackendpoo |
| SRHttpSetting22334 ~ |

HTTP settings * (D

7. Add the Azure VMs where the Session Recording Server is installed to the back-end pool.

8. Configure Session Recording Servers according to Knowledge Center article CTX230015.


https://support.citrix.com/article/CTX230015
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